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Introduction to Computing and ICT 
Information and Communication Technology (ICT) 
Information and Communication Technology (ICT) is defined as a comprehensive set of computing 
tools that collectively allow people and organizations to interact in the digital world. It is an umbrella 
term encompassing communication devices (television, cell phones), computer and network hardware, 
satellite systems, and various associated services and applications such as video conferencing, distance 
learning, and e-commerce. ICT also represents the technological convergence of telephone networks 
with computer networks via a single link system, enabling integrated data, voice, and video 
communication. 

What is a System? 
A system is a collection of interconnected components working together cohesively to achieve specific 
goals or objectives by processing inputs to produce desired outputs. Systems exist in both natural and 
artificial domains. Understanding a system's structure allows for better design, management, and 
optimization across fields like engineering, biology, and computing. 
A system is described by four fundamental concepts: 

1. Objective/Purpose: The primary goal the system is designed to achieve. 
2. Components: The essential building blocks or parts that constitute the system. 
3. Environment: Everything external to the system that interacts with or influences it. 
4. Communication/Interaction: The mechanisms through which components and the system itself 

exchange information and coordinate their functions. 

Types of Systems 
Systems are broadly categorized into two main types: 
1.3.1 Natural Systems 
These occur organically in nature without human intervention. They are characterized by self-
regulation, adaptability, stability, and are governed by natural laws (physics, chemistry, biology). 
They are highly intricate and interdependent. 

• Examples: Ecosystems (forests, oceans), weather patterns, the solar system, the human body 
(circulatory, nervous systems), DNA, psychological systems (thoughts, emotions). 
1.3.2 Artificial Systems 
These are intentionally designed and built by humans to fulfill specific needs or solve problems. They 
are structured, require maintenance, and operate under predefined human-set rules and protocols. 

• Examples: 
o Knowledge Systems: Mathematics, logic, databases, information management systems. 
o Engineering Systems: Civil (bridges, roads), mechanical (robotic arms), chemical (water treatment 

plants), electrical (home automation), software (library management systems). 
o Social Systems: Academic institutions, governments, corporations. 
o Computer Systems: The primary focus of this chapter. 

Key Differences: 

Feature Natural Systems Artificial Systems 

Origin Occur naturally. Designed and built by humans. 

Chapter 1 
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Complexity Highly intricate and 
interdependent. 

Structured and relatively simpler. 

Energy Source Natural (sunlight, water flow). Artificial (electricity, fuel). 

Adaptation Evolve autonomously over time. Require human updates/redesign. 

Governance Natural laws. Human-defined rules and 
protocols. 

Systems and Science 
The study of systems aligns with different scientific approaches: 

• Natural Science: Focuses on understanding and describing existing natural systems (e.g., studying a 
forest ecosystem). 

• Design Science: Focuses on creating new artificial systems to solve problems (e.g., developing 
conservation software). 

• Computer Science: Utilizes methods from both. It studies the natural laws of computation (e.g., 
algorithm efficiency) and engages in the design science of creating new software and hardware 
systems. 

The Computer as a System 
Definition of a Computer 
A computer is a programmable electronic device that accepts raw data as input, processes it according 
to a set of stored instructions (a program), produces useful output, and stores (storage) the results for 
future use. It performs arithmetic and logical operations automatically and without human intervention 
during processing. 

Objectives of a Computer System 
The main objectives are to perform computations, process data, and execute tasks efficiently to provide 
useful information to the user. This includes running software applications, managing files, facilitating 
communication, and automating complex processes. 

Core Components of a Computer System (Hardware) 
Computer hardware consists of physical, tangible components. 
Input Devices 
Tools that allow users to enter data and instructions into the computer. 

• Keyboard: For entering text, numbers, and commands. The standard layout is QWERTY. 
• Mouse/Pointing Device: Controls the cursor on the screen for selection and navigation. Includes 

touchpads on laptops. 
• Scanner: Converts physical documents and images into a digital format. 
• Microphone: Inputs audio data. 
• Webcam: Captures live video and images. 
• Barcode Reader: Scans barcodes to input product information quickly. 
• Touch Screen: Serves as both an input (touch) and output (display) device. 
• Joystick/Gamepad: Used for gaming and simulations. 
• Light Pen: A historical pointing device for drawing directly on CRT screens. 

The System Unit 
The central case that houses the primary electronic components. 
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• Motherboard: The main circuit board that connects and allows communication between all 
components (CPU, RAM, storage, ports). 

• Central Processing Unit (CPU)/Microprocessor: The "brain" of the computer. It fetches, decodes, 
and executes instructions from memory. 

o Control Unit (CU): Directs and coordinates operations within the processor and manages the flow of 
data. 

o Arithmetic Logic Unit (ALU): Performs all mathematical calculations (addition, subtraction, etc.) 
and logical comparisons (AND, OR, NOT). 

o Registers: High-speed temporary storage locations within the CPU for holding data, instructions, and 
addresses currently being processed (e.g., Memory Address Register - MAR, Memory Data Register - 
MDR, Accumulator - AC, Program Counter - PC, Current Instruction Register - CIR). 

• Memory (Primary Storage): 
o Random Access Memory (RAM): Volatile, read/write memory. It temporarily holds the operating 

system, application programs, and data currently in use. It is much faster than secondary storage but 
loses its contents when power is off. 

o Read-Only Memory (ROM): Non-volatile memory that stores permanent, essential instructions like 
the BIOS (Basic Input/Output System) for booting the computer. Its contents are typically not 
modifiable by the user. 

o Cache Memory: Extremely fast, small memory located inside (L1) or close to (L2, L3) the CPU. It 
stores frequently used data and instructions to speed up processing by reducing the time the CPU 
waits for data from RAM. 
Storage Devices (Secondary/Backing Storage) 
Non-volatile media for the long-term retention of data, programs, and information. 

• Hard Disk Drive (HDD): Magnetic storage using spinning platters. Offers large capacity at a lower 
cost but is slower and more fragile than SSDs. 

• Solid State Drive (SSD): Chip-based storage using flash memory. Much faster, more durable, silent, 
and energy-efficient than HDDs, but typically more expensive per gigabyte. 

• Optical Discs: CDs, DVDs, and Blu-ray discs that use lasers to read and write data. 
• USB Flash Drive: Portable, rewritable chip-based storage. 
• Memory Cards (SD Cards): Portable storage used in cameras, phones, and other devices. 

Output Devices 
Hardware used to present processed data (information) to the user. 

• Monitor/Visual Display Unit (VDU): Displays text, graphics, and video (soft copy). Types: CRT 
(older, bulky), LCD, LED (modern, flat-panel). 

• Printer: Produces physical hard copies. Types: Impact (e.g., dot-matrix) and Non-Impact (e.g., 
inkjet, laser). 

• Plotter: Used for printing large-scale graphics like engineering drawings and architectural blueprints. 
• Speakers/Headphones: Output audio. 
• Multimedia Projector: Projects the computer's display onto a larger surface like a wall or screen. 

Ports, Expansion Slots, and Cards 
• Ports: Interfaces on the system unit for connecting peripheral devices (e.g., USB, HDMI, Ethernet, 

audio jacks, VGA). 
• Expansion Slots: Sockets on the motherboard (e.g., PCI, PCI Express) where expansion cards can be 

inserted to add new capabilities. 
• Expansion Cards: Circuit boards that add new functions (e.g., graphics card for enhanced video, 

sound card for improved audio, network interface card for networking). 

Interaction among Components & the Environment 
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• Biometric Systems: Use unique biological traits for identification and authentication (e.g., 
fingerprint scanners, facial recognition, iris scanners). 

Data Representation and Number Systems 
Machine-Level Representation 
At the machine level, all data is represented using binary digits (bits), which can be either 0 or 1. 
This binary system aligns with the two-state nature of electronic switches in computer hardware 
(ON/HIGH/1 and OFF/LOW/0). 

• A single binary digit is called a bit. 
• Groups of bits form codes that represent all types of data: numbers, text, images, sound. 
• Example: The decimal number 5 is 101 in binary. The ASCII character 'A' is 01000001. 

Number Systems 
A number system defines a set of values and rules used to represent quantity. The four primary 
systems in computing are: 

System Base Digits/Symbols Primary Use 

Decimal 10 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 
Human-centric counting and 
math. 

Binary 2 0, 1 
Fundamental representation 
inside all computers. 

Octal 8 0, 1, 2, 3, 4, 5, 6, 7 
Compact representation of 
binary (historically significant). 

Hexadecimal 16 
0-9, A(10), B(11), 
C(12), D(13), E(14), 
F(15) 

Compact representation of 
binary; used for memory 
addresses, color codes. 

All are positional-value systems: the value of a digit depends on its position. 
• Most Significant Digit (MSD): Leftmost digit (carries the most weight). 
• Least Significant Digit (LSD): Rightmost digit (carries the least weight). 

Number System Conversions 
A. Conversion to Decimal (from any base): Multiply each digit by the base raised to its positional 
power (starting at 0 for the LSD) and sum the results. 

• Binary to Decimal: (1011.101)₂ = 1×2³ + 0×2² + 1×2¹ + 1×2⁰ + 1×2⁻¹ + 0×2⁻² + 1×2⁻³ = (11.625)₁₀ 
• Hexadecimal to Decimal: (3AF)₁₆ = 3×16² + 10×16¹ + 15×16⁰ = (943)₁₀ 

B. Conversion from Decimal (to any base): 
• For the integer part: Repeatedly divide by the target base and record remainders in reverse order. 
• For the fractional part: Repeatedly multiply by the target base and record the integer parts 

in forward order. 
C. Direct Conversions Between Binary, Octal, and Hexadecimal: (Efficient because bases are 
powers of 2). 

• Binary ↔ Octal: Group binary digits into sets of 3 (from the binary point outward), pad if necessary, 
then convert each group to its octal digit (0-7). 
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Examples Human voice, analog radio, vinyl 
records. 

MP3 files, digital TV, data in 
computer memory. 

11.2 Logic Gates 
Fundamental building blocks of digital circuits. They perform basic logical functions on one or more 
binary inputs to produce a single binary output. 

Gate 
Boolean Expression 

(2-input) 
Truth Table 

(A B | F) 
Function 

AND F = A · B 0 0 | 0 
0 1 | 0 
1 0 | 0 
1 1 | 1 

Output is 1 only if ALL inputs 
are 1. 

OR F = A + B 0 0 | 0 
0 1 | 1 
1 0 | 1 
1 1 | 1 

Output is 1 if AT LEAST ONE 
input is 1. 

NOT F = Ā (or A') 0 | 1 
1 | 0 

Output is the inverse 
(complement) of the input. 

NAND F = A⋅B‾A⋅B 0 0 | 1 
0 1 | 1 
1 0 | 1 
1 1 | 0 

Output is 0 only if ALL inputs 
are 1 (AND + NOT). 

NOR F = A+B‾A+B 0 0 | 1 
0 1 | 0 
1 0 | 0 
1 1 | 0 

Output is 1 only if ALL inputs 
are 0 (OR + NOT). 

XOR F = A ⊕ B 0 0 | 0 
0 1 | 1 
1 0 | 1 
1 1 | 0 

Output is 1 only if inputs are 
DIFFERENT. 

Boolean Algebra and Simplification 
• Boolean Algebra: A mathematical system for logic operations using variables that can be true (1) or 

false (0) and operators (AND, OR, NOT). 
• Truth Table: Lists all possible input combinations and their corresponding output for a Boolean 

function or logic circuit. 
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One Liners: Introduction to Computing and ICT 
1. ICT is an umbrella term for computing tools enabling interaction in the digital world, representing 

the convergence of telephone and computer networks. 
2. A system is a collection of interconnected components working cohesively to achieve a specific 

objective by processing inputs into outputs. 
3. The four fundamental concepts describing any system are its Objective, Components, 

Environment, and Communication/Interaction. 
4. Natural systems occur organically, are self-regulated, adaptable, and governed by natural laws, 

such as ecosystems and the human body. 
5. Artificial systems are human-designed, structured, require maintenance, and operate under 

predefined rules, like engineering, social, and computer systems. 
6. Natural systems are governed by natural laws, while artificial systems operate under human-

defined rules and protocols. 
7. Design Science focuses on creating new artificial systems, like conservation software, to solve 

problems. 
8. A computer is a programmable electronic device that accepts input, processes it according to 

stored instructions, produces output, and stores results. 
9. The primary objectives of a computer system are to perform computations, process data, and 

execute tasks efficiently to provide useful information. 
10. An input device allows users to enter data and instructions into a computer, such as a keyboard, 

mouse, or scanner. 
11. The standard keyboard layout is QWERTY. 
12. A touch screen serves as both an input (touch) and output (display) device. 
13. The system unit houses the primary electronic components of a computer, including the 

motherboard and CPU. 
14. The motherboard is the main circuit board connecting all components like the CPU, RAM, 

storage, and ports. 
15. The CPU, or microprocessor, is the computer's "brain," responsible for fetching, decoding, and 

executing instructions. 
16. The Control Unit (CU) directs and coordinates operations within the processor and manages data 

flow. 
17. The Arithmetic Logic Unit (ALU) performs all mathematical calculations and logical 

comparisons. 
18. Registers are high-speed temporary storage locations within the CPU for data and addresses being 

processed. 
19. The Memory Address Register (MAR) holds the memory location of data to be fetched or stored. 
20. The Memory Data Register (MDR) holds the data fetched from or to be written to memory. 
21. The Program Counter (PC) holds the address of the next instruction to be executed. 
22. The Current Instruction Register (CIR) holds the instruction currently being decoded and 

executed. 
23. Random Access Memory (RAM) is volatile, read/write memory that temporarily holds the OS, 

applications, and data in use. 
24. Read-Only Memory (ROM) is non-volatile memory storing permanent, essential instructions like 

the BIOS. 
25. Cache memory is extremely fast memory located close to the CPU to store frequently used data 

and speed up processing. 
26. Secondary storage devices provide non-volatile, long-term retention of data, programs, and 

information. 
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27. Hard Disk Drives (HDD) use magnetic storage on spinning platters, offering large capacity at 
lower cost but are slower than SSDs. 

28. Solid State Drives (SSD) use chip-based flash memory, offering faster speeds, durability, and 
energy efficiency than HDDs. 

29. Output devices present processed data to the user, such as monitors (soft copy) and printers (hard 
copy). 

30. A plotter is an output device used for printing large-scale graphics like engineering drawings. 
31. Ports are interfaces on the system unit for connecting peripheral devices (e.g., USB, HDMI). 
32. Expansion slots on the motherboard allow the insertion of expansion cards to add new capabilities 

like enhanced graphics or audio. 
33. The computer's environment includes external factors like the power supply, network connections, 

peripherals, and the user. 
34. The fundamental operations of a computer are Input, Processing, Storage, and Output, known as 

the IPO cycle. 
35. The Von Neumann architecture's revolutionary principle is the stored-program concept, where 

both instructions and data reside in the same memory. 
36. In the Von Neumann model, the CPU contains the ALU, CU, and Registers. 
37. The three types of system buses are the Data Bus, Address Bus, and Control Bus. 
38. The Data Bus carries the actual data being processed between components. 
39. The Address Bus carries memory location (address) information. 
40. The Control Bus carries control and timing signals, such as read and write commands. 
41. The instruction cycle consists of four stages: Fetch, Decode, Execute, and Store (Write Back). 
42. During the Fetch stage, the CU retrieves an instruction from memory into the CIR and increments 

the Program Counter. 
43. The Von Neumann Bottleneck is the limitation in processing speed caused by the shared bus 

system transferring both instructions and data. 
44. A security risk in the Von Neumann architecture is that instructions and data share the same 

memory, allowing a program to accidentally or maliciously modify other instructions. 
45. Software is a set of instructions, data, or programs that tell computer hardware how to function and 

perform tasks. 
46. System software manages and controls hardware, providing a stable platform for application 

software. 
47. The Operating System (OS) manages hardware resources, provides user interfaces, runs 

applications, and handles file and memory management. 
48. Device drivers are specialized programs enabling the OS to communicate with and control specific 

hardware devices. 
49. Utility programs perform maintenance tasks like antivirus scanning, disk cleanup, and file 

compression. 
50. A compiler translates an entire high-level program into machine code at once, producing an 

independent executable file. 
51. An interpreter translates and executes source code line-by-line, without producing a separate 

executable. 
52. An assembler translates assembly language (low-level symbolic code) into machine code. 
53. Application software helps end-users perform specific tasks, such as using a word processor or 

spreadsheet. 
54. Open Source Software has its source code made freely available for use, study, modification, and 

distribution (e.g., Linux). 
55. Freeware is copyrighted software distributed free of charge, but its source code is typically not 

modifiable (e.g., Adobe Reader). 
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Practice MCQs
1. In the context of systems, which of the 
following is NOT one of the four 
fundamental concepts that describe any 
system? 
a) Objective/Purpose 
b) Components 
c) Efficiency 
d) Environment 
Answer: c) Efficiency 
2. What is the key, revolutionary principle 
proposed by John von Neumann that 
underlies almost all modern computer 
architectures? 
a) The use of vacuum tubes 
b) The stored-program concept 
c) The Harvard architecture separation 
d) Binary arithmetic logic 
Answer: b) The stored-program concept 
3. During the Fetch stage of the instruction 
cycle, what happens to the Program Counter 
(PC) after an instruction is retrieved? 
a) It is decremented 
b) It is loaded with the address of the 
fetched instruction 
c) It is incremented 
d) It is compared with the CIR 
Answer: c) It is incremented 
4. Which component of the CPU is 
specifically responsible for performing all 
mathematical calculations and logical 
comparisons? 
a) Control Unit (CU) 
b) Memory Data Register (MDR) 
c) Arithmetic Logic Unit (ALU) 
d) Cache Memory 
Answer: c) Arithmetic Logic Unit (ALU) 
5. What is the primary vulnerability 
associated with the Von Neumann 
architecture that can be exploited in attacks 
like buffer overflows? 
a) Slow processing speed due to the 
bottleneck 
b) Instructions and data residing in separate 
memory units 
c) Instructions and data residing in the same 
memory space 
d) The use of a single system bus 

Answer: c) Instructions and data residing 
in the same memory space 
6. Which of the following best distinguishes 
a compiler from an interpreter? 
a) A compiler is used for system software, 
an interpreter for application software. 
b) A compiler translates code line-by-line, 
while an interpreter translates the entire 
program at once. 
c) A compiler translates the entire source 
code into machine code at once, producing 
an executable. 
d) An interpreter produces an object file, 
while a compiler does not. 
Answer: c) A compiler translates the 
entire source code into machine code at 
once, producing an executable. 
7. A software that is copyrighted and 
distributed free of charge, but whose source 
code is typically not modifiable by the user, 
is classified as: 
a) Open Source Software 
b) Shareware 
c) Freeware 
d) Firmware 
Answer: c) Freeware 
8. The technological shift from vacuum 
tubes to transistors primarily characterized 
which generation of computers? 
a) First to Second 
b) Second to Third 
c) Third to Fourth 
d) Fourth to Fifth 
Answer: a) First to Second 
9. Which type of computer is specifically 
designed to process continuous physical data 
like voltage or pressure and is considered 
faster for simulations but less accurate? 
a) Digital Computer 
b) Hybrid Computer 
c) Analog Computer 
d) Quantum Computer 
Answer: c) Analog Computer 
10. In a hybrid computer system, what is the 
typical role of the analog component? 
a) Long-term data storage 
b) Complex logical decision-making 
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c) Fast input measurement and initial 
processing 
d) User interface management 
Answer: c) Fast input measurement and 
initial processing 
11. What is the correct decimal range for an 
8-bit unsigned binary number? 
a) -128 to +127 
b) 0 to 255 
c) -256 to +255 
d) 0 to 511 
Answer: b) 0 to 255 
12. To perform the subtraction 7 - 5 using 
the 2's complement method in an 8-bit 
system, what operation would the ALU 
actually carry out? 
a) 7 + (1's complement of 5) 
b) 7 + (2's complement of 5) 
c) 5 + (2's complement of 7) 
d) Direct binary subtraction of 0101 from 
0111 
Answer: b) 7 + (2's complement of 5) 
13. In the ASCII-7 character encoding 
standard, what is the decimal value assigned 
to the uppercase letter 'A'? 
a) 48 
b) 65 
c) 97 
d) 32 
Answer: b) 65 
14. Which Unicode encoding form is 
variable-length (1-4 bytes), backward 
compatible with ASCII, and the most 
common on the web? 
a) UTF-16 
b) UTF-32 
c) UTF-8 
d) ASCII-8 
Answer: c) UTF-8 
15. In process management, what is a 
'thread'? 
a) A complete, independent program in 
execution 
b) A high-priority system process 
c) A lightweight unit of execution within a 
process that shares resources 
d) The state of a process when it is waiting 
for an I/O operation 

Answer: c) A lightweight unit of execution 
within a process that shares resources 
16. Which type of operating system is 
designed for time-critical applications where 
missing a deadline could have catastrophic 
consequences? 
a) Batch Processing OS 
b) Time-Sharing OS 
c) Soft Real-Time OS 
d) Hard Real-Time OS 
Answer: d) Hard Real-Time OS 
17. In the context of file systems, which 
allocation method stores file blocks 
scattered across the disk, linked together by 
pointers, making it efficient for space but 
slow for random access? 
a) Contiguous Allocation 
b) Indexed Allocation 
c) Linked Allocation 
d) Sequential Allocation 
Answer: c) Linked Allocation 
18. In data communication, which mode 
allows for two-way communication but only 
in one direction at a time, similar to a 
walkie-talkie? 
a) Simplex 
b) Half-Duplex 
c) Full-Duplex 
d) Multiplex 
Answer: b) Half-Duplex 
19. What is the key functional difference 
between a network hub and a network 
switch? 
a) A hub operates at the network layer, 
while a switch operates at the data link 
layer. 
b) A hub broadcasts data to all connected 
devices, while a switch directs data only to 
the specific destination device. 
c) A switch connects different networks, 
while a hub connects devices within the 
same network. 
d) A hub has more ports than a switch. 
Answer: b) A hub broadcasts data to all 
connected devices, while a switch directs 
data only to the specific destination 
device. 
20. Which network topology connects every 
device to every other device, providing 
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History of Computers 
Introduction to Computers: 
The word 'computer' originally referred to people who performed mathematical calculations. Before 
modern computers existed, these human 'computers' were employed to carry out complex arithmetic 
operations, often used in fields like astronomy, engineering, and navigation. This practice dates back to at 
least the 17th century. 
The first recorded use of the word 'computer' in English was in 1613, describing a person who computes. 
Over the centuries, as technology progressed, mechanical and electronic devices took over the 
computational role. This evolution marked the transition from manual computing to the automated systems 
we rely on today. 
Understanding the history of computing helps us appreciate the innovations and challenges faced by early 
scientists and inventors who laid the foundation for today’s digital age. 
The Mechanical Era (1600–1900) 
During the Mechanical Era, inventors developed physical devices to assist in computation. These devices 
worked without electricity and were typically operated by hand. 
Tally Sticks 
Tally sticks were simple tools used since ancient times to record numbers, debts, or messages. They were 
not calculators but rather record-keeping aids. A notch on a stick represented a unit of value or count. These 
were used extensively in medieval Europe, especially for tax collection. 
Abacus (c. 2400 BC) 
The abacus is one of the oldest calculating tools known to humanity. First used in Babylon around 2400 
BC and later perfected in China around 500 BC, the abacus consists of beads that can be moved along rods 
to perform arithmetic operations. It was especially useful in trading and finance and is still used today in 
parts of Asia. 
Napier’s Bones (1614) 
Invented by Scottish mathematician John Napier, this device used rods inscribed with numbers to perform 
multiplication and division. It simplified large calculations and was a precursor to the logarithmic slide rule. 
Slide Rule (1622) 
Developed by William Oughtred, the slide rule expanded on Napier's work by using logarithmic scales. It 
was used primarily for complex calculations like roots, trigonometry, and logarithms, especially by 
engineers until the 1970s. 
Pascaline (1642) 
Created by French philosopher Blaise Pascal to help his father with tax collection, the Pascaline was a 
mechanical calculator that could add and subtract. It used a series of rotating wheels and was limited in 
functionality, but it marked a major step in the automation of arithmetic. 

Chapter 2 
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One Liners: History of Computer 
1. The word 'computer' originally referred to a person who performed mathematical calculations. 
2. The first recorded use of the word 'computer' in English was in 1613. 
3. The Mechanical Era of computing (1600-1900) involved physical devices operated without 

electricity. 
4. Tally sticks were ancient record-keeping aids, not calculators, often used in medieval Europe for 

tax collection. 
5. The abacus, dating to 2400 BC in Babylon, is one of the oldest calculating tools, using beads on 

rods. 
6. Napier's Bones (1614), invented by John Napier, used inscribed rods to simplify multiplication and 

division. 
7. The slide rule (1622), developed by William Oughtred, used logarithmic scales for complex 

calculations. 
8. The Pascaline (1642) was a mechanical calculator created by Blaise Pascal to perform addition and 

subtraction. 
9. Gottfried Wilhelm Leibniz designed the Stepped Reckoner (1672), capable of all four basic 

arithmetic operations. 
10. The Arithmometer (1820) by Charles Xavier Thomas de Colmar was the first commercially 

successful mechanical calculator. 
11. Charles Babbage, the Father of the Computer, proposed the Difference Engine and Analytical 

Engine. 
12. The Difference Engine was designed to compute polynomial functions and print results 

automatically. 
13. The Analytical Engine is considered the first design for a general-purpose mechanical computer. 
14. Ada Lovelace wrote the first algorithm intended for the Analytical Engine, making her the first 

programmer. 
15. Ada Lovelace suggested using binary and conceptualized machine-generated music. 
16. The Scheutzian Engine (1843) was the first mechanical calculator to automatically print its results. 
17. The Jacquard Loom (1881) used punch cards to control weaving patterns, inspiring future 

computer data input. 
18. Herman Hollerith's Tabulating Machine (1890) used punched cards for data processing, starting 

with the U.S. Census. 
19. The Tabulating Machine's innovation led to the founding of IBM. 
20. The Electronic Era brought faster, smaller, more reliable machines using electricity and introduced 

programmability. 
21. Konrad Zuse's Z1 (1936-1938) is considered the first freely programmable mechanical computer. 
22. The Z1 used binary floating-point arithmetic and input via punched tape. 
23. The Atanasoff-Berry Computer (ABC) (1939-1942) was the first electronic digital computer. 
24. The ABC used binary representation and vacuum tubes to solve systems of linear equations. 
25. The Harvard Mark I (1943), or IBM ASCC, was an electromechanical computer over 51 feet long. 
26. The Harvard Mark I was used by the U.S. Navy for ballistics calculations during WWII. 
27. ENIAC (1946) was the first general-purpose electronic digital computer, containing over 17,000 

vacuum tubes. 
28. Programming ENIAC required manual reconfiguration using wires and switches. 
29. EDVAC (1952), proposed by John von Neumann, introduced the stored-program architecture. 
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Practice MCQs
1. What was the original meaning of the word 

"computer"? 
a) An electronic calculating device 
b) A person who performs mathematical 
calculations 
c) A mechanical automation tool 
d) A data storage unit 
Answer: b) A person who performs 
mathematical calculations 

2. The Pascaline, invented by Blaise Pascal, was 
primarily designed to: 
a) Perform multiplication and division 
b) Weave complex fabric patterns 
c) Assist with tax collection through addition 
and subtraction 
d) Solve polynomial equations 
Answer: c) Assist with tax collection through 
addition and subtraction 

3. Which device is considered the first design for a 
general-purpose mechanical computer? 
a) Difference Engine 
b) Analytical Engine 
c) Stepped Reckoner 
d) Arithmometer 
Answer: b) Analytical Engine 

4. Ada Lovelace is historically significant for: 
a) Inventing the first mechanical calculator 
b) Writing the first algorithm intended for 
machine processing 
c) Developing the stored-program concept 
d) Building the first electronic computer 
Answer: b) Writing the first algorithm 
intended for machine processing 

5. The Tabulating Machine, which used punched 
cards for data processing, directly led to the 
founding of which company? 
a) Microsoft 
b) IBM 
c) Intel 
d) Apple 
Answer: b) IBM 

6. Konrad Zuse's Z1 is notable for being the: 
a) First electronic digital computer 
b) First computer to use vacuum tubes 
c) First freely programmable mechanical 

computer 
d) First commercial computer 
Answer: c) First freely programmable 
mechanical computer 

7. The Atanasoff-Berry Computer (ABC) 
introduced which of the following concepts? 
a) Stored-program architecture 
b) Use of transistors 
c) Binary representation and electronic 
calculation using vacuum tubes 
d) Integrated circuits 
Answer: c) Binary representation and 
electronic calculation using vacuum tubes 

8. What was the primary use of the Harvard Mark I 
during World War II? 
a) Code-breaking 
b) Ballistics calculations for the U.S. Navy 
c) Predicting election results 
d) Running business payroll 
Answer: b) Ballistics calculations for the U.S. 
Navy 

9. ENIAC differed from earlier computers 
primarily because it was: 
a) The first mechanical computer 
b) The first general-purpose electronic digital 
computer 
c) The first to use punch cards 
d) The first portable computer 
Answer: b) The first general-purpose 
electronic digital computer 

10. The key architectural concept proposed by John 
von Neumann and implemented in EDVAC was: 
a) The use of vacuum tubes 
b) Parallel processing 
c) The stored-program architecture 
d) Binary logic gates 
Answer: c) The stored-program architecture 

11. UNIVAC I holds the distinction of being the: 
a) First computer to use a graphical user 
interface 
b) First commercially sold computer 
c) First computer to connect to the internet 
d) First portable computer 
Answer: b) First commercially sold computer 
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Computer System: Architecture and Components 
Introduction To Computer And Its Basic Operations 
In today's information age, computers are used in every walk of life. They are found in devices ranging 
from MP3 players and toys to industrial robots, fighter aircraft, and beyond, making life easier and 
more comfortable. 

Definition of a Computer 
A computer is an electronic device that accepts input data and instructions via input devices, stores 
them until needed, processes the data, and produces output through output devices. 

Basic Operations of a Computer 
All computers perform four fundamental operations to carry out any task: Input, Processing, Output, 
and Storage.  

• Input Operation: The process of capturing or accepting data or information using input devices (e.g., 
keyboard, mouse). 

• Processing Operation: The transformation of input into output. The Central Processing Unit 
(CPU) performs this task under the direction of a program. 

• Output Operation: The result or outcome of the processing, delivered via output devices (e.g., 
monitor, printer, speakers). 

• Storage Operation: The process of retaining data, information, or instructions so the user can retrieve 
them when required. Storage can be temporary (e.g., RAM) or permanent (e.g., Hard Disk). 

Evolution of Computing Devices 
The term "computing device" refers to any machine that can perform calculations, from simple 
addition to managing complex systems. 

• Early Computing Devices: 
o Abacus (c. 3000 BC): Considered the first computer, using a system of sliding beads for calculations. 
o Leibniz's Calculating Machine (1694): A mechanical device that could add, subtract, and multiply 

using gears and dials. 
o Difference Engine (1822): Proposed by Charles Babbage to solve differential equations. 
o Analytical Engine: Babbage's later concept for a general-purpose computer. 
o Tabulating Machine (1889): Developed by Herman Hollerith for the U.S. census, using punched 

cards. 
o Z3 (1941): Developed by Konrad Zuse, used for designing airplanes and missiles. 
o Harvard Mark I (1944): An electromechanical relay computer. 
o ENIAC (1946): The first general-purpose electronic computer, significantly faster than its 

predecessors. 
o EDVAC (1945): Designed by John von Neumann, it introduced the stored-program concept. 
o UNIVAC-I (1951): One of the first commercially available computers. 
• Modern Computing Devices: Include personal computers, laptops, tablets, smartphones, and 

embedded systems in various appliances and vehicles. 
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CLASSIFICATION OF COMPUTERS 
Computers are classified based on size, performance, and application areas. 

Type Description Key Characteristics & Uses 

Microcomputers 
(Personal 
Computers) 

The smallest and least expensive 
class, originally for individual 
users. Now powerful enough for 
business networks. 

Types: Desktop, Notebook, 
Laptop, Handheld (Palmtop, 
PDA, Smartphone). Used at 
work, home, school. Portable, 
lightweight, often battery-
powered. 

Mainframe 
Computers 

Second most powerful and 
expensive. Used by large 
organizations for critical, bulk-
data processing. 

High-speed processing 
(Billions of Instructions Per 
Second - BIPS). Supports 
many terminals 
simultaneously. Used for 
census, ERP, financial 
transactions, airline 
reservations, ATMs. 

Supercomputers 

The most powerful and 
expensive. Designed for intense 
scientific, engineering, and 
business applications. 

Extremely high speed 
(trillions of instructions per 
second), massive storage. 
Used for weather forecasting, 
weapon research, space 
exploration (NASA), 
complex simulations. 

Mobile Computers 
Devices enabling mobile 
computing—processing and 
transmitting data wirelessly. 

Includes laptops, 
smartphones, tablets, PDAs. 
Feature wireless connectivity 
(full-duplex), portability, and 
mobile-specific software. 

Computer Hardware And Software 
Hardware 
Computer hardware refers to the physical, tangible components of a computer system. 
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One Liners: Computer Systems, Architecture and components 
1. A computer is an electronic device that accepts input data and instructions, stores them, processes the 

data, and produces output. 
2. The four fundamental operations of a computer are Input, Processing, Output, and Storage. 
3. Input operation involves capturing or accepting data using input devices like a keyboard or mouse. 
4. The Central Processing Unit (CPU) performs the transformation of input into output, which is the 

processing operation. 
5. Output operation delivers the result or outcome of processing via devices like a monitor, printer, or 

speakers. 
6. Storage operation retains data, instructions, or information for future retrieval, and can be temporary 

(RAM) or permanent (Hard Disk). 
7. The Abacus (c. 3000 BC) is considered the first computing device, using sliding beads for 

calculations. 
8. Charles Babbage proposed the Difference Engine (1822) to solve differential equations. 
9. The Analytical Engine was Charles Babbage's later concept for a general-purpose computer. 
10. Herman Hollerith's Tabulating Machine (1889) used punched cards and was developed for the U.S. 

census. 
11. The Z3 (1941), developed by Konrad Zuse, was used for designing airplanes and missiles. 
12. The Harvard Mark I (1944) was an electromechanical relay computer. 
13. ENIAC (1946) was the first general-purpose electronic computer. 
14. EDVAC (1945), designed by John von Neumann, introduced the stored-program concept. 
15. UNIVAC-I (1951) was one of the first commercially available computers. 
16. Microcomputers (Personal Computers) are the smallest and least expensive class, originally for 

individual users. 
17. Types of microcomputers include Desktop, Notebook, Laptop, and Handheld devices (Palmtop, PDA, 

Smartphone). 
18. Mainframe computers are the second most powerful and expensive, used by large organizations for 

critical, bulk-data processing. 
19. Mainframes support many terminals simultaneously and are used for census, ERP, financial 

transactions, and airline reservations. 
20. Supercomputers are the most powerful and expensive, designed for intense scientific, engineering, 

and business applications. 
21. Supercomputers are used for weather forecasting, weapon research, space exploration, and complex 

simulations. 
22. Mobile Computers are devices enabling mobile computing—processing and transmitting data 

wirelessly. 
23. Mobile computers include laptops, smartphones, tablets, and PDAs, featuring wireless connectivity 

and portability. 
24. Computer hardware refers to the physical, tangible components of a computer system (e.g., monitor, 

keyboard, mouse, CPU). 
25. The primary function of hardware is to store and execute software. 
26. Computer software is a set of instructions that directs the computer on what to do and how to do it. 
27. The primary function of software is to operate the hardware and perform specific tasks. 
28. Hardware is physical and tangible, whereas software is logical and intangible. 
29. Hardware executes software and performs physical work, while software provides instructions to the 

hardware. 
30. Hardware understands only binary (0s and 1s), and software provides instructions in binary form. 
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Practice MCQs
1. Which of the following is NOT one of the 
four fundamental operations performed by all 
computers? 
a) Input 
b) Processing 
c) Communication 
d) Storage 
Answer: c) Communication 
2. Which early computing device, considered 
the first computer, used a system of sliding 
beads for calculations? 
a) Analytical Engine 
b) Difference Engine 
c) Abacus 
d) Pascaline 
Answer: c) Abacus 
3. The concept where both program 
instructions and data are stored in the same 
memory was introduced by which computer? 
a) ENIAC 
b) Harvard Mark I 
c) EDVAC 
d) UNIVAC-I 
Answer: c) EDVAC 
4. Which type of computer is specifically 
designed for intense scientific applications 
and is the most powerful and expensive? 
a) Mainframe Computer 
b) Microcomputer 
c) Minicomputer 
d) Supercomputer 
Answer: d) Supercomputer 
5. What is the primary functional distinction 
between computer hardware and software? 
a) Hardware is logical, software is physical. 
b) Hardware provides instructions, software 
executes them. 
c) Hardware is tangible and performs 
physical work, software is intangible and 
provides instructions. 
d) Hardware is stored permanently, software 
is temporary. 
Answer: c) Hardware is tangible and 
performs physical work, software is 
intangible and provides instructions. 

6. Which type of software acts as an interface 
between the computer hardware and the 
application software? 
a) Utility Software 
b) System Software 
c) Firmware 
d) Customized Software 
Answer: b) System Software 
7. A software translator that converts the 
entire source code into machine code at once, 
producing an object file, is called a(n): 
a) Interpreter 
b) Assembler 
c) Compiler 
d) Linker 
Answer: c) Compiler 
8. Customized banking software developed 
for a specific bank is an example of which 
category of application software? 
a) General-Purpose Software 
b) Productivity Software 
c) Special-Purpose Software 
d) System Software 
Answer: c) Special-Purpose Software 
9. Software that is copyrighted and 
distributed free of charge for use, but whose 
source code is not made available for 
modification, is known as: 
a) Open Source Software 
b) Shareware 
c) Freeware 
d) Firmware 
Answer: c) Freeware 
10. Which component of the CPU is 
specifically responsible for fetching, 
decoding, and executing instructions, and 
directing data flow? 
a) Arithmetic Logic Unit (ALU) 
b) Control Unit (CU) 
c) Accumulator (AX) 
d) Cache Memory 
Answer: b) Control Unit (CU) 
11. Which CPU register holds the memory 
address of the next instruction to be fetched 
from memory? 
a) Instruction Register (IR) 
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Number Systems, Digital Logics and Data 
Basics 

Introduction to Digital Systems and Data 
Modern technology is built upon the principles of digital systems. These systems process information 
using discrete values—primarily the binary digits 0 and 1—as opposed to the continuous signals found 
in the natural world. This chapter provides a comprehensive foundation in the core concepts that bridge 
data representation, logical processing, and structured data management. We will explore how 
computers represent numbers, text, and multimedia, how they perform logical and arithmetic operations 
using Boolean algebra and logic gates, and how complex data is organized and managed in database 
systems. Mastery of these topics is essential for understanding the inner workings of all computational 
devices. 

Data and Number Systems 
Data, Information, and Operations 

• Data is a raw collection of facts, figures, and statistics related to an object. It is an organizational asset 
used to view past activities and make future decisions. 

• Information is data that has been processed, manipulated, and organized into a meaningful and useful 
context (e.g., a student's percentage result). 

• Data Processing Operations involve a series of actions to convert data into information: 
1. Data Capturing: Recording data via source documents or input devices. 
2. Data Manipulation: This includes: 
 Classifying: Organizing data into groups using codes. 
 Calculating: Performing arithmetic operations. 
 Sorting: Arranging data in a logical sequence. 
 Summarizing: Condensing data into a concise form. 
3. Managing Output Results: This involves storing, retrieving, communicating, and reproducing the 

processed information. 

Number Systems 
Number systems define how values are represented using symbols. Computers use different systems 
for internal processing and human-readable formats. 

System Base Digits/Symbols Primary Use 

Decimal 10 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 Human everyday use. 

Binary 2 0, 1 Internal computer processing. 

Octal 8 0, 1, 2, 3, 4, 5, 6, 7 
Historical computing; compact 

binary representation (3 bits/digit). 

Hexadecimal 16 
0-9, A(10), B(11), C(12), 

D(13), E(14), F(15) 

Modern compact binary 
representation (4 bits/digit); 

memory addressing. 

Chapter 4 
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One Liners: Number Systems, Digital Logics and Data Basics 
1. Data is a raw collection of facts, figures, and statistics related to an object, used for viewing past 

activities and making future decisions. 
2. Information is data that has been processed, manipulated, and organized into a meaningful and useful 

context. 
3. The first data processing operation is Data Capturing, which involves recording data via source 

documents or input devices. 
4. Data Manipulation includes the actions of Classifying, Calculating, Sorting, and Summarizing data. 
5. The decimal number system uses a base of 10 and the digits 0-9, and is primarily for human everyday 

use. 
6. The binary number system uses a base of 2 and the digits 0 and 1, and is used for internal computer 

processing. 
7. The octal number system uses a base of 8 and digits 0-7, historically used for compact binary 

representation (3 bits/digit). 
8. The hexadecimal number system uses a base of 16 and digits 0-9 and A-F, used for modern compact 

binary representation (4 bits/digit) and memory addressing. 
9. Binary representation is used because digital circuits are built from transistors with two stable states: 

ON (1) and OFF (0). 
10. To convert a decimal number to another base, repeatedly divide the decimal number by the target base 

and record remainders from bottom to top. 
11. To convert binary to octal, group bits into sets of three from the right, pad with leading zeros if 

needed, and convert each group to its octal digit. 
12. To convert binary to hexadecimal, group bits into sets of four from the right, pad with leading zeros if 

needed, and convert each group to its hex digit. 
13. To convert octal to binary, convert each octal digit to its 3-bit binary equivalent. 
14. To convert hexadecimal to binary, convert each hex digit to its 4-bit binary equivalent. 
15. Whole numbers (unsigned integers) use all bits for magnitude; for n bits, the range is 0 to (2ⁿ – 1). 
16. Signed integers use the Most Significant Bit (MSB) as a sign bit: 0 for positive, 1 for negative. 
17. The Two's Complement method is used to represent negative integers: invert all bits of the positive 

number and add 1 to the result. 
18. For an n-bit signed integer using two's complement, the range is -2ⁿ⁻¹ to (2ⁿ⁻¹ – 1). 
19. Real numbers (with fractions) are represented using floating-point notation: Sign × Mantissa × 

2^Exponent. 
20. Single-precision floating-point format uses 32 bits: 1 sign bit, 8 exponent bits, and 23 mantissa bits. 
21. Double-precision floating-point format uses 64 bits: 1 sign bit, 11 exponent bits, and 52 mantissa bits. 
22. To convert a fractional decimal part to binary, multiply the fraction by 2 repeatedly, recording the 

integer part each time. 
23. Binary addition follows the rules: 0+0=0, 0+1=1, 1+0=1, 1+1=0 with a carry of 1. 
24. Binary subtraction is performed by adding the two's complement of the subtrahend to the minuend. 
25. ASCII (American Standard Code for Information Interchange) uses 7 bits, representing 128 characters. 
26. Extended ASCII uses 8 bits, representing 256 characters. 
27. Unicode is a universal standard designed to represent characters from all world languages. 
28. UTF-8 is a variable-length Unicode encoding (1-4 bytes) that is backward compatible with ASCII. 
29. UTF-16 is a variable-length Unicode encoding using 2 or 4 bytes per character. 
30. UTF-32 is a fixed-length Unicode encoding using 4 bytes per character. 
31. Digital images are composed of pixels, with color often represented by RGB (Red, Green, Blue) 

values ranging from 0-255 each. 
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Practice MCQs
1. What is the key difference between data 
and information? 
a) Data is processed, information is raw. 
b) Data is meaningful, information is a 
collection of facts. 
c) Data is raw, information is processed and 
meaningful. 
d) Data is stored electronically, information 
is printed. 
Answer: c) Data is raw, information is 
processed and meaningful. 
2. Which of the following is NOT a step in 
data manipulation? 
a) Classifying 
b) Capturing 
c) Calculating 
d) Summarizing 
Answer: b) Capturing 
3. Which number system uses a base of 8 and 
is historically significant for representing 3 
binary bits per digit? 
a) Decimal 
b) Hexadecimal 
c) Octal 
d) Binary 
Answer: c) Octal 
4. What is the primary reason computers use 
the binary number system internally? 
a) It is easy for humans to understand. 
b) It allows for complex mathematical 
operations. 
c) It aligns with the two stable states 
(ON/OFF) of transistors in digital circuits. 
d) It provides the most compact 
representation of numbers. 
Answer: c) It aligns with the two stable 
states (ON/OFF) of transistors in digital 
circuits. 
5. To convert the decimal number 29 to 
binary, what is the correct sequence of 
remainders from the repeated division-by-2 
process? 
a) 10111 
b) 11101 
c) 11011 

d) 11110 
Answer: b) 11101 
6. The binary number 11010101 is equivalent 
to which hexadecimal number? 
a) D5 
b) C5 
c) D4 
d) E5 
Answer: a) D5 
7. What is the range of values for an 8-bit 
unsigned integer? 
a) -128 to +127 
b) 0 to 255 
c) -255 to +255 
d) 0 to 511 
Answer: b) 0 to 255 
8. In the two's complement representation, 
how is the negative equivalent of a positive 
binary number formed? 
a) Invert all bits. 
b) Invert all bits and subtract 1. 
c) Invert all bits and add 1. 
d) Add 1 to the number. 
Answer: c) Invert all bits and add 1. 
9. In a 32-bit single-precision floating-point 
format, how many bits are allocated to the 
mantissa (significand)? 
a) 1 bit 
b) 8 bits 
c) 23 bits 
d) 52 bits 
Answer: c) 23 bits 
10. Which Unicode encoding form is 
variable-length and backward compatible 
with ASCII, making it the most common on 
the web? 
a) UTF-16 
b) UTF-32 
c) UTF-8 
d) ASCII-8 
Answer: c) UTF-8 
11. In digital image representation, what does 
the RGB model define? 
a) Red, Gray, Blue color components 
b) Red, Green, Blue color intensities 
c) Resolution, Gamma, Brightness 
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Operating Systems 
What is Software? 
Software represents the logical component of a computer system—the intangible instructions that bring 
hardware to life. Without software, even the most advanced computer hardware remains nothing more 
than an inert collection of electronic circuits and components. 
Formal Definition: Software is a comprehensive collection of computer programs, procedures, and 
associated documentation that instructs a computer on what tasks to perform and how to perform them. 
It serves as the intermediary between human intentions and machine execution. 

Types of Software: A Fundamental Classification 
Software is broadly classified into two main categories, each serving distinct but complementary roles 
in the computing ecosystem: 

System Software 
Definition: System software comprises programs designed to manage and operate computer hardware, 
providing a stable platform upon which application software can run. This software category acts as the 
fundamental bridge between hardware components and user applications. 
Key Characteristics: 

• Acts as an intermediary between hardware and user applications 
• Essential for computer operation (cannot run without it) 
• Typically pre-installed or comes with the system 
• Operates largely in the background 

Major Components: 
1. Operating Systems (OS): The most critical system software that manages all hardware resources and 

provides common services for computer programs. 
o Examples: Windows, macOS, Linux, Android, iOS 
2. Device Drivers: Specialized programs that enable the operating system to communicate with hardware 

devices. 
o Examples: Printer drivers, graphics card drivers, network adapter drivers 
3. Utility Programs: Software tools designed to help manage, maintain, and optimize the computer 

system. 
o Examples: Antivirus software, disk cleanup tools, backup utilities, system monitors 

Primary Purpose: To manage hardware resources efficiently and create a stable, predictable 
environment for other software to execute. 

Application Software 
Definition: Application software consists of programs designed to help users perform specific tasks or 
solve particular problems. Unlike system software, these programs fulfill user needs directly. 
Key Characteristics: 

• Controlled by users to perform specific tasks 
• Optional—installed based on user requirements 
• Focuses on end-user productivity, creativity, or entertainment 
• Requires system software to function 

Major Categories: 
1. Productivity Software: Tools for office work and document creation 
o Examples: Microsoft Word, Google Docs, Microsoft Excel 
2. Communication Software: Applications for information exchange 

Chapter 5 
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One-Liners: Operating Systems 
1. Software is a collection of computer programs, procedures, and documentation that instructs a computer 

on what to do and how to do it. 
2. Without software, computer hardware is a useless collection of electronic components. 
3. System software manages computer hardware and provides a platform for running application software. 
4. System software acts as an intermediary between hardware and user applications. 
5. Operating systems, device drivers, and utility programs are examples of system software. 
6. The purpose of system software is to manage hardware resources and create a stable environment for 

other software. 
7. Application software helps users perform specific tasks or solve particular problems. 
8. Application software fulfills user needs directly through programs like word processors and web 

browsers. 
9. System software controls hardware; application software is controlled by users to perform tasks. 
10. A computer cannot run without system software; application software is optional based on user needs. 
11. System software is usually pre-installed; application software is installed by users. 
12. An operating system is the most critical type of system software, acting as an interface between user 

and hardware. 
13. The OS controls program execution and manages computer resources. 
14. The primary purpose of an OS is to act as a resource manager for hardware and software resources. 
15. An OS provides a user interface offering a stable way for users and applications to interact with 

hardware. 
16. A command line interface (CLI) is text-based, requiring users to type specific commands. 
17. CLI is powerful and flexible but has a steep learning curve requiring command memorization. 
18. DOS was one of the first widely-installed OS for IBM-compatible PCs using commands like DIR and 

COPY. 
19. UNIX is a powerful, multi-user, multitasking OS forming the basis for Linux and macOS. 
20. A menu-driven interface presents users with screens of options, requiring no command memorization. 
21. Menu-driven interfaces are simpler than CLI but less flexible, ideal for systems like ATMs. 
22. A graphical user interface uses graphics and is interacted with via pointing devices like mice. 
23. GUI is user-friendly and easier to learn but may be slower for advanced tasks compared to CLI. 
24. Microsoft Windows evolved from an environment on top of DOS to a full-fledged GUI OS. 
25. macOS is Apple's GUI OS known for user-friendly design. 
26. Linux is a free, open-source OS kernel; distributions like Ubuntu provide complete user-friendly 

systems. 
27. CLI offers more precise control over file systems and OS compared to GUI. 
28. GUI provides excellent multitasking with visual cues for multiple windows. 
29. CLI can be faster for experienced users due to keyboard-only operation. 
30. GUI uses more system resources to render graphics compared to CLI. 
31. CLI is excellent for scripting and automating command sequences. 
32. A single-user OS is designed for one person at a time. 
33. A single-tasking OS runs only one application at a time (e.g., old MS-DOS). 
34. A single-user multitasking OS allows one user to run multiple applications concurrently. 
35. A multi-user OS allows multiple users to access system resources simultaneously. 
36. Time-sharing divides CPU time into slices allocated among multiple users. 
37. Batch processing OS collects jobs in batches and processes them without user interaction. 
38. Batch processing is efficient for CPU utilization in tasks like payroll systems. 
39. A disadvantage of batch processing is lack of interactivity and difficult debugging. 
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Practice MCQs
1. What is the fundamental role of System 

Software? 
a) To help users perform specific tasks like 
word processing. 
b) To manage and operate computer hardware, 
providing a platform for application software. 
c) To provide entertainment and games for 
users. 
d) To connect the computer to the internet. 
Answer: b) To manage and operate 
computer hardware, providing a platform 
for application software. 

2. Which of the following is a key distinction 
between System Software and Application 
Software? 
a) System Software is optional, Application 
Software is essential. 
b) System Software is installed by the user, 
Application Software is pre-installed. 
c) A computer cannot run without System 
Software, but Application Software is 
optional. 
d) Application Software controls the hardware 
directly. 
Answer: c) A computer cannot run without 
System Software, but Application Software 
is optional. 

3. The most critical type of system software 
that acts as an interface between the user 
and the computer hardware is the: 
a) Device Driver 
b) Utility Program 
c) Operating System (OS) 
d) Compiler 
Answer: c) Operating System (OS) 

4. Which type of user interface is 
characterized by a text-based environment 
where users must type specific commands? 
a) Graphical User Interface (GUI) 
b) Menu-Driven Interface (MDI) 
c) Command Line Interface (CLI) 
d) Touch Interface 
Answer: c) Command Line Interface (CLI) 

5. Which early operating system was one of 
the first widely-installed for IBM-
compatible PCs and used commands like 

DIR and COPY? 
a) UNIX 
b) Windows 95 
c) DOS (Disk Operating System) 
d) macOS 
Answer: c) DOS (Disk Operating System) 

6. What is a primary advantage of a 
Graphical User Interface (GUI) over a 
Command Line Interface (CLI)? 
a) It offers more precise control over the file 
system. 
b) It is faster for experienced users to perform 
complex tasks. 
c) It is more user-friendly and easier to learn, 
using visual recognition. 
d) It uses fewer system resources like RAM 
and CPU. 
Answer: c) It is more user-friendly and 
easier to learn, using visual recognition. 

7. An OS that allows only one user to run 
multiple applications concurrently is 
classified as: 
a) Multi-User, Single-Tasking 
b) Single-User, Multitasking 
c) Multi-User, Multitasking 
d) Single-User, Single-Tasking 
Answer: b) Single-User, Multitasking 

8. In a multi-user operating system, the 
technique where CPU time is divided into 
small slices and allocated among multiple 
users is called: 
a) Batch Processing 
b) Multiprogramming 
c) Time-Sharing 
d) Real-Time Processing 
Answer: c) Time-Sharing 

9. Which type of operating system is designed 
to process jobs collected in batches without 
any user interaction, ideal for payroll 
systems? 
a) Real-Time OS 
b) Time-Sharing OS 
c) Batch Processing OS 
d) Distributed OS 
Answer: c) Batch Processing OS 
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Artificial Intelligence (AI) 
What is Artificial Intelligence? 
Definition: Artificial Intelligence (AI) is the branch of computer science that aims to create systems 
capable of performing tasks that normally require human intelligence. These tasks include learning, 
reasoning, problem-solving, perception, language understanding, and decision-making. 
Conceptual Understanding: AI represents the science and engineering of making intelligent machines, 
particularly intelligent computer programs. It is related to the similar task of using computers to 
understand human intelligence, but AI does not have to confine itself to methods that are biologically 
observable. 
Historical Context: The term "Artificial Intelligence" was first coined by John McCarthy in 1956 at 
the Dartmouth Conference. He defined it as "the science and engineering of making intelligent 
machines." 

Fundamental Goals of AI 
The primary objectives of artificial intelligence research can be categorized into four main goals: 

Systems That Think Like Humans 
• Systems that model human cognitive processes 
• Example: Cognitive architectures that simulate human reasoning patterns 
• Approach: Study how humans think through introspection, psychological experiments, and brain 

imaging 

Systems That Think Rationally 
• Systems that follow logical reasoning principles 
• Example: Theorem provers that use formal logic 
• Approach: Use computational models of logical reasoning 

Systems That Act Like Humans 
• Systems that exhibit human-like behavior 
• Example: Chatbots that mimic human conversation 
• Approach: The Turing Test as a behavioral measure 

Systems That Act Rationally 
• Systems that make optimal decisions to achieve goals 
• Example: Autonomous robots that navigate efficiently 
• Approach: Rational agent theory and decision theory 

Real-World Example: Consider a self-driving car. It must: 
• Think like humans: Understand traffic patterns intuitively 
• Think rationally: Calculate optimal routes mathematically 
• Act like humans: Signal before turning like human drivers 
• Act rationally: Make safe decisions to reach the destination 

Approaches to Artificial Intelligence 
AI researchers have developed several distinct approaches to creating intelligent systems: 

Symbolic AI (Good Old-Fashioned AI - GOFAI) 
Concept: Uses symbols to represent problems and logical rules to manipulate them. 
Characteristics: 

Chapter 6 
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• Knowledge representation using symbols 
• Rule-based reasoning systems 
• Explicit programming of knowledge 

Example: Expert systems for medical diagnosis that use if-then rules: 
IF patient has fever AND cough > 3 days 
AND chest pain = True 
THEN probability of pneumonia = 70% 
Limitations: 

• Brittle (fails with incomplete information) 
• Knowledge acquisition bottleneck 
• Poor handling of uncertainty 

Connectionist Approach (Neural Networks) 
Concept: Models intelligence using artificial neural networks inspired by biological brains. 
Characteristics: 

• Distributed representation 
• Learning from examples 
• Parallel processing 

Example: Handwriting recognition systems that learn from thousands of handwriting samples. 
Advantages: 

• Robust to noisy data 
• Can learn complex patterns 
• Generalizes well to new examples 

Evolutionary Approach 
Concept: Uses principles of natural selection and genetic algorithms. 
Characteristics: 

• Population-based search 
• Fitness-based selection 
• Crossover and mutation operations 

Example: Optimizing antenna designs by evolving thousands of virtual antennas and selecting the best 
performers. 

Bayesian Approach 
Concept: Uses probability theory to handle uncertainty. 
Characteristics: 

• Probabilistic reasoning 
• Bayesian networks 
• Statistical learning 

Example: Spam filters that calculate the probability of an email being spam based on word frequencies. 

Types of Artificial Intelligence 
AI systems can be classified based on their capabilities and functionalities: 

Based on Capabilities 
1. Narrow AI (Weak AI) 

• Designed for specific tasks 
• Cannot perform beyond its programmed scope 
• Examples: Chess programs, recommendation systems, voice assistants 
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        for each child in EXPAND(node, problem) do 

            s ← child.STATE 

            if problem.GOAL-TEST(s) then return SOLUTION(child) 

            if s is not in reached then 

                add s to reached 

                add child to frontier 

    return failure 
Properties: 

• Complete: Yes (if branching factor finite) 
• Optimal: Yes (if all actions have same cost) 
• Time: O(b^d) where b = branching factor, d = depth 
• Space: O(b^d) (stores all nodes) 

Example: Finding shortest path in unweighted graph. 
2. Depth-First Search (DFS) 
function DFS(problem) returns solution or failure 

    frontier ← LIFO stack containing Node(problem.INITIAL) 

    reached ← {problem.INITIAL} 

     

    while not IS-EMPTY(frontier) do 

        node ← POP(frontier) 

        if problem.GOAL-TEST(node.STATE) then return SOLUTION(node) 

        for each child in EXPAND(node, problem) do 

            s ← child.STATE 

            if s is not in reached then 

                add s to reached 

                add child to frontier 

    return failure 
Properties: 

• Complete: No (can get stuck in infinite depth) 
• Optimal: No 
• Time: O(b^m) where m = maximum depth 
• Space: O(bm) (linear in depth) 

3. Depth-Limited Search 
• DFS with depth limit l 
• Returns failure if no solution within depth l 

4. Iterative Deepening Search 
function ITERATIVE-DEEPENING-SEARCH(problem) returns solution or failure 

    for depth = 0 to ∞ do 

        result ← DEPTH-LIMITED-SEARCH(problem, depth) 

        if result ≠ cutoff then return result 
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    for each a in ACTIONS(state) do 

        v ← MAX(v, MIN-VALUE(RESULT(state, a))) 

    return v 

 

function MIN-VALUE(state) returns utility value 

    if TERMINAL-TEST(state) then return UTILITY(state) 

    v ← ∞ 

    for each a in ACTIONS(state) do 

        v ← MIN(v, MAX-VALUE(RESULT(state, a))) 

    return v 
Properties: 

• Complete: Yes (if tree finite) 
• Optimal: Yes (against optimal opponent) 
• Time: O(b^m) 
• Space: O(bm) (depth-first) 

Alpha-Beta Pruning 
function ALPHA-BETA-SEARCH(state) returns action 

    v ← MAX-VALUE(state, -∞, ∞) 

    return the action in ACTIONS(state) with value v 

 

function MAX-VALUE(state, α, β) returns utility value 

    if TERMINAL-TEST(state) then return UTILITY(state) 

    v ← -∞ 

    for each a in ACTIONS(state) do 

        v ← MAX(v, MIN-VALUE(RESULT(state, a), α, β)) 

        if v ≥ β then return v 

        α ← MAX(α, v) 

    return v 

 

function MIN-VALUE(state, α, β) returns utility value 

    if TERMINAL-TEST(state) then return UTILITY(state) 

    v ← ∞ 

    for each a in ACTIONS(state) do 

        v ← MIN(v, MAX-VALUE(RESULT(state, a), α, β)) 

        if v ≤ α then return v 

        β ← MIN(β, v) 

    return v 
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 Ethical Frameworks 
• Consequentialism: Judge by outcomes 
• Deontology: Follow rules/duties 
• Virtue Ethics: Focus on character 
• Rights-based: Protect individual rights 

 Bias and Fairness in AI 
 Types of Bias 

• Dataset Bias: Underrepresentation in training data 
• Algorithmic Bias: Unequal treatment by algorithm 
• Measurement Bias: Flawed measurement of target variable 
• Historical Bias: Past discrimination encoded in data 

 Fairness Definitions 
• Demographic Parity: Equal selection rates across groups 
• Equal Opportunity: Equal true positive rates 
• Equalized Odds: Equal true positive and false positive rates 
• Individual Fairness: Similar individuals treated similarly 

 Mitigation Strategies 
• Pre-processing: Adjust training data 
• In-processing: Modify learning algorithm 
• Post-processing: Adjust model outputs 
• Adversarial Debiasing: Use adversarial training 

Transparency and Explainability 
 Explainable AI (XAI) 

• Interpretable Models: Simple, understandable models 
• Model Explanation: Explain complex model decisions 
• Model Inspection: Understand how model works 
• Model Transparency: Clear about capabilities and limitations 

 Explanation Methods 
• LIME: Local Interpretable Model-agnostic Explanations 
• SHAP: Shapley Additive Explanations 
• Counterfactual Explanations: "What if" scenarios 
• Attention Visualization: Show what model focuses on 

 Right to Explanation 
• GDPR Article 22: Right to meaningful information about logic involved 
• Need for human-understandable explanations 
• Balancing transparency with intellectual property 

Privacy and Security 
 Privacy-Preserving AI 

• Differential Privacy: Add noise to protect individuals 
• Federated Learning: Train on decentralized data 
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One-Liners: Artificial Intelligence (AI) 
1. Artificial Intelligence is the science and engineering of making intelligent machines that can perform 

tasks requiring human intelligence. 
2. The Turing Test, proposed by Alan Turing in 1950, evaluates a machine's ability to exhibit intelligent 

behavior indistinguishable from a human. 
3. The Chinese Room Argument by John Searle challenges strong AI by arguing that symbol manipulation 

alone does not create understanding. 
4. An intelligent agent perceives its environment through sensors and acts upon it through actuators to 

achieve goals. 
5. A rational agent selects actions that maximize its expected performance measure given its percept 

sequence and built-in knowledge. 
6. Breadth-First Search is complete and optimal for uniform cost but has exponential space complexity 

O(b^d). 
7. Depth-First Search uses linear space O(bm) but is neither complete nor optimal in infinite spaces. 
8. A* search uses f(n) = g(n) + h(n) and is optimal if h(n) is admissible (never overestimates) and 

complete if branching factor is finite. 
9. An admissible heuristic never overestimates the cost to reach the goal, while a consistent heuristic 

satisfies h(n) ≤ c(n,a,n') + h(n'). 
10. Minimax algorithm evaluates game trees assuming optimal play by both players, with time complexity 

O(b^m) for depth m. 
11. Alpha-beta pruning improves minimax by eliminating branches that cannot affect the final decision, 

reducing time to O(b^(m/2)) in best case. 
12. Propositional logic uses atomic sentences connected by operators (¬, ∧, ∨, ⇒, ⇔) and supports 

inference through resolution. 
13. First-order logic extends propositional logic with quantifiers (∀, ∃), predicates, functions, and variables 

for more expressive knowledge representation. 
14. Modus Ponens (α ⇒ β, α / ∴ β) and Resolution (α ∨ β, ¬β ∨ γ / ∴ α ∨ γ) are fundamental inference rules 

in logic. 
15. Unification finds substitutions that make two logical expressions identical, enabling generalized modus 

ponens in first-order logic. 
16. Machine learning algorithms improve their performance on a task through experience, measured by a 

performance metric. 
17. Supervised learning uses labeled training data {(xᵢ, yᵢ)} to learn mapping f: X → Y for classification or 

regression. 
18. Unsupervised learning discovers patterns in unlabeled data through clustering, dimensionality 

reduction, or association rule learning. 
19. Reinforcement learning agents learn optimal policies through interaction with environment to maximize 

cumulative reward. 
20. Overfitting occurs when a model learns training data noise, while underfitting happens when model is 

too simple to capture patterns. 
21. Bias-variance tradeoff: simple models have high bias (underfit), complex models have high variance 

(overfit). 
22. Cross-validation estimates model performance by partitioning data into training and validation sets 

multiple times. 
23. Linear regression models continuous outputs using y = wᵀx + b, optimized by minimizing mean squared 

error. 
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Practice MCQs
1. Which of the following best defines 

Artificial Intelligence? 
a) Programming computers to perform specific 
tasks efficiently 
b) Creating systems that can perform tasks 
requiring human intelligence 
c) Building expert systems for narrow 
domains only 
d) Simulating human brain neurons in 
software 
Answer: b) Creating systems that can 
perform tasks requiring human intelligence 

2. The Turing Test evaluates a machine's 
ability to: 
a) Solve complex mathematical problems 
b) Exhibit intelligent behavior 
indistinguishable from humans 
c) Learn from experience without human 
intervention 
d) Process natural language with perfect 
accuracy 
Answer: b) Exhibit intelligent behavior 
indistinguishable from humans 

3. John Searle's Chinese Room Argument 
challenges: 
a) The feasibility of machine learning 
algorithms 
b) The possibility of computers achieving true 
understanding 
c) The ethical implications of AI development 
d) The computational efficiency of neural 
networks 
Answer: b) The possibility of computers 
achieving true understanding 

4. A rational agent in AI is defined as one 
that: 
a) Always makes perfect decisions 
b) Has complete knowledge of its environment 
c) Maximizes expected performance given 
available information 
d) Mimics human decision-making processes 
exactly 
Answer: c) Maximizes expected 
performance given available information 

5. Which search algorithm is complete and 
optimal but has exponential space 

complexity? 
a) Depth-First Search 
b) Breadth-First Search 
c) Hill Climbing 
d) Simulated Annealing 
Answer: b) Breadth-First Search 

6. In A search, a heuristic function h(n) is 
admissible if:* 
a) h(n) never underestimates the true cost to 
reach the goal 
b) h(n) is always equal to the true cost to reach 
the goal 
c) h(n) never overestimates the true cost to 
reach the goal 
d) h(n) is calculated using only local 
information 
Answer: c) h(n) never overestimates the 
true cost to reach the goal 

7. Alpha-beta pruning improves minimax 
algorithm by: 
a) Expanding all possible game tree nodes 
b) Eliminating branches that cannot affect 
final decision 
c) Using heuristic evaluation functions at all 
nodes 
d) Searching deeper in promising branches 
only 
Answer: b) Eliminating branches that 
cannot affect final decision 

8. In propositional logic, the resolution rule 
states that from α ∨ β and ¬β ∨ γ, we can 
infer: 
a) α ∧ γ 
b) α ∨ γ 
c) β ⇒ γ 
d) ¬α ⇒ γ 
Answer: b) α ∨ γ 

9. First-order logic extends propositional logic 
by adding: 
a) Probabilistic reasoning capabilities 
b) Quantifiers, predicates, and variables 
c) Temporal operators for time reasoning 
d) Fuzzy logic for handling uncertainty 
Answer: b) Quantifiers, predicates, and 
variables 
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Theory of Automata 
Introduction to Automata Theory 
The Foundation: What is Computation? 
At its heart, computer science seeks to understand what can and cannot be computed, and the resources 
required to do so. Before the advent of physical computers, mathematicians and logicians like Alan 
Turing, Alonzo Church, Emil Post, and others sought to define the very notion of an "effective 
procedure" or "algorithm." Automata theory provides the formal models for these procedures. 
Conceptual Definition: An automaton (plural: automata) is an abstract, mathematical model of a 
machine that follows a predetermined sequence of operations to process information. It is a finite 
representation of a system that receives input, changes its internal state according to a set of rules, and 
may produce output. 
Real-Life Analogy: Consider a simple vending machine. It has a finite number of 
states: Idle, Amount_Entered_Partial, Amount_Entered_Full. It receives input (coins of different 
denominations). Based on the current state and the input coin, it transitions to a new state (e.g., 
from Idle to Amount_Entered_Partial). When the state Amount_Entered_Full is reached, it delivers the 
product (output) and returns to Idle. This is a finite automaton in the physical world. 

Key Objectives and Relevance 
The study of automata theory serves several critical purposes: 

1. To Formalize Computation: It provides precise, mathematical definitions for computing devices, from 
the very simple to the very powerful. 

2. To Classify Problems: It allows us to categorize computational problems based on the type of machine 
(and hence resources like memory) needed to solve them. 

3. To Understand Limitations: It leads to profound, provable statements about the limits of computation 
(e.g., the Halting Problem). 

4. Foundations for Practical Tools: The theories directly underpin the design of compilers (lexical 
analysis, parsing), text processors (regular expression search), hardware design (sequential circuits), 
and protocol analysis. 

The Chomsky Hierarchy: A Roadmap 
The central organizing framework of automata theory is the Chomsky Hierarchy, proposed by linguist 
Noam Chomsky. It establishes a containment hierarchy of formal grammars and their corresponding 
recognizing machines. This hierarchy will be our guide throughout these notes. 

Grammar 
Type 

Language 
Class 

Recognizing 
Automaton 

Production 
Rules (Example) 

Memory 
Constraint 

Type 0 Recursively 
Enumerable 

Turing Machine 
(TM) 

α → β 
(Unrestricted) 

Unlimited 

Type 1 Context-
Sensitive 

Linear-Bounded 
Automaton (LBA) 

αAβ → αγβ Linear in 
input size 

Type 2 Context-Free Pushdown 
Automaton (PDA) 

A → γ Unlimited 
Stack 

Chapter 7 
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Type 3 Regular Finite Automaton 
(FA) 

A → aB, A → a Finite 
Memory 

Table: The Chomsky Hierarchy showing the relationship between grammars, languages, and machines. 
We will study these machines in ascending order of power: Finite Automata, Pushdown Automata, 
and Turing Machines. Context-sensitive languages and LBAs are often covered at a more introductory 
level in FPSC exams due to their complexity. 

Finite Automata (FA) 
Finite Automata model systems with a finite amount of memory. The entire "history" of computation 
that is relevant for future actions is summarized in the current state. They are the simplest model in our 
hierarchy. 

Basic Concepts and Definitions 
Formal Definition (Deterministic Finite Automaton - DFA): A DFA is a 5-tuple, (Q, Σ, δ, q₀, F), 
where: 

1. Q: A finite set of states. 
2. Σ: A finite set of input symbols (the alphabet). 
3. δ: The transition function, δ: Q × Σ → Q. It maps a state and an input symbol to the next state. 
4. q₀: The start state, an element of Q. 
5. F: A set of final (or accepting) states, a subset of Q. 

Key Idea: A DFA is "deterministic" because for every state and every input symbol, there is exactly 
one specified next state. There is no ambiguity. 
Graphical Representation (State Diagram): A directed graph where: 

• Circles represent states. 
• Arrows represent transitions (labeled with an input symbol). 
• An arrow with no source marks the start state. 
• Double circles denote final states. 

Example 2.1: Let's design a DFA that accepts all strings over Σ = {0, 1} that end with '01'. 
• Intuition: The machine must "remember" the last two symbols seen. 
• States: 
o q₀: Start. Remembers nothing relevant or the last symbol was not '0'. 
o q₁: Remembers that the last symbol was a '0'. 
o q₂: Remembers that the last two symbols were '01' (ACCEPTING). 
• Transitions: 
o In q₀, on input '0', go to q₁. On '1', stay in q₀. 
o In q₁, on input '0', stay in q₁. On '1', go to q₂. 
o In q₂, on input '0', go to q₁. On '1', go to q₀. 
• **F = {q₂}`. 

Tabular Representation (Transition Table): Often used for algorithmic processing. 

State Input 0 Input 1 

→ q₀ q₁ q₀ 

q₁ q₁ q₂ 

q₂ q₁ q₀ 
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One-Liners: Theory of Automata 
1. DFA vs NFA: In DFA, δ: Q×Σ→Q; in NFA, δ: Q×Σ→P(Q) with possible ε-transitions. 

2. Subset Construction: Converts NFA to DFA, where each DFA state represents a set of NFA states. 

3. ε-closure: Set of all states reachable from a given state via ε-transitions alone. 

4. Myhill-Nerode Theorem: Language L is regular iff it has finite number of equivalence classes under 

the indistinguishability relation. 

5. Minimization Algorithm: Uses partition refinement to merge indistinguishable states in a DFA. 

6. Arden's Theorem: If equation is X = AX + B, then smallest solution is X = A*B, provided ε∉A. 

7. Left Linear Grammar: Productions of form A→Ba or A→a; Right Linear Grammar: A→aB or A→a. 

8. Pumping Lemma Contrapositive: To prove L not regular, show ∀p ∃s∈L with |s|≥p such that ∀xyz=s 

with |xy|≤p & |y|>0, ∃i≥0 with xyⁱz∉L. 

9. Regular Closure: Closed under all Boolean operations, concatenation, Kleene star, reversal, 

homomorphisms. 

10. CFG Ambiguity: Grammar ambiguous if ∃w∈L with ≥2 leftmost derivations or parse trees. 

11. Inherent Ambiguity: Language where every CFG for it is ambiguous (e.g., {aⁿbⁿcᵐdᵐ} ∪ {aⁿbᵐcᵐdⁿ}). 

12. CNF Conversion: Eliminates ε-productions, unit productions, then converts to A→BC or A→a. 

13. Greibach Normal Form: All productions A→aα where α∈V* and a∈T. 

14. PDA Acceptance Modes: Final state and empty stack are equivalent for nondeterministic PDA. 

15. Deterministic PDA: At most one move for each (state, input, stack-top) combination. 

16. DPDA Languages: DCFL properly contained in CFL; not closed under union, intersection. 

17. CFL Pumping Lemma: For long strings z, can write z=uvwxy with vx non-empty, |vwx|≤p, and 

uvⁱwxⁱy∈L ∀i≥0. 

18. Ogden's Lemma: Strengthened pumping lemma where specific positions can be "marked." 

19. CFL Closure: Closed under union, concatenation, Kleene star, homomorphism, reversal. Not closed 

under intersection, complement. 

20. CFL Intersection with Regular: Always a CFL (useful closure property). 

21. CYK Algorithm: O(n³) dynamic programming algorithm for membership in a CFL given in CNF. 

22. Turing Machine Configuration: Triple (state, tape contents, head position). 

23. Multi-tape TM Simulation: k-tape TM can be simulated by 1-tape TM with O(T²(n)) time. 
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Practice MCQs
1. Which of the following statements about 
finite automata is FALSE? 
a) Every NFA can be converted to an 
equivalent DFA 
b) Every DFA is also an NFA 
c) The language accepted by an NFA with n 
states may require a DFA with 2ⁿ states 
d) An NFA with ε-transitions is more 
powerful than one without 
Answer: d) (Both are equally powerful) 
2. The minimum number of states required 
in a DFA that accepts all strings over {0,1} 
whose 5th symbol from the right end is 1 is: 
a) 32 
b) 16 
c) 8 
d) 6 
Answer: a) (2⁵ = 32 states needed to 
remember last 5 symbols) 
3. According to the Myhill-Nerode theorem, 
a language is regular if and only if: 
a) It satisfies the pumping lemma 
b) It has a finite number of equivalence classes 
under the indistinguishability relation 
c) It can be expressed by a regular expression 
d) It is accepted by some NFA 
Answer: b) 
4. Which of these languages is NOT 
regular? 
a) {w ∈ {0,1}* | w contains an equal number 
of 0s and 1s} 
b) {w ∈ {0,1}* | w ends with 00} 
c) {w ∈ {0,1}* | w contains 010 as substring} 
d) {0ⁿ | n is a prime number} 
Answer: a) and d) are both not regular, but 
if only one answer: a) is the classic example 
**5. The regular expression 
(a+b)a(a+b)a(a+b)* generates:** 
a) Strings with exactly two a's 
b) Strings with at least two a's 
c) Strings with at most two a's 
d) Strings beginning and ending with a 
Answer: b) 
6. Which pumping lemma condition is 
violated for L = {0¹⁰ⁿ | n ≥ 0} to prove it's 
not regular? 

a) |xy| ≤ p 
b) |y| > 0 
c) xyⁱz ∈ L for all i ≥ 0 
d) All conditions hold, so L is regular 
Answer: c) (Pumping y of 0s changes length 
to not be multiple of 10) 
7. A grammar with productions S → aS | bS 
| a | b is: 
a) Type 3 (Regular) 
b) Type 2 (Context-Free) 
c) Type 1 (Context-Sensitive) 
d) Type 0 (Unrestricted) 
Answer: a) (Right-linear grammar) 
8. The language {aⁿbⁿcⁿ | n ≥ 0} is: 
a) Regular 
b) Context-Free 
c) Context-Sensitive but not CF 
d) Recursively Enumerable but not CS 
Answer: c) 
9. Which of the following is TRUE about 
ambiguous CFGs? 
a) Every ambiguous grammar can be 
converted to an unambiguous one 
b) Every language has an unambiguous 
grammar 
c) Some languages are inherently ambiguous 
d) Ambiguity doesn't affect parsing 
Answer: c) 
10. In Chomsky Normal Form, the 
maximum number of steps to derive a 
string of length n is: 
a) n 
b) 2n-1 
c) n² 
d) 2n 
Answer: b) (2n-1 derivation steps) 
11. The language {ww | w ∈ {0,1}*} is: 
a) Regular 
b) Context-Free 
c) Context-Sensitive but not CF 
d) Recursive but not CS 
Answer: c) (Requires comparing arbitrary 
positions, not possible with PDA alone) 
12. A PDA with acceptance by empty stack 
and final state: 
a) Are equivalent for deterministic PDAs 
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Office Automation 
Introduction to Office Automation 
Office Automation refers to the use of computer software and systems to digitally create, collect, store, 
manipulate, and relay office information to accomplish core tasks. The primary applications involved 
are Word Processors, Spreadsheets, Database Management Systems, and Presentation Software. This 
chapter provides a comprehensive guide to Word Processing and Spreadsheet software, their features, 
interfaces, and practical operations. 

Word Processing 
What is a Word Processor? 
A Word Processor is application software used for the composition, editing, formatting, and printing of 
text-based documents. It goes beyond simple typing by allowing the manipulation of text, insertion of 
images, sounds, charts, graphics, and even video clips. Documents can be saved in various formats (.txt, 
.rtf, .html, .doc, .docx) and published on the web with hyperlinks. Its greatest advantage over a typewriter 
is the ability to make changes without retyping the entire document. 
Examples of Word Processing Software: MS Word, WordPerfect, OpenOffice Writer, Google Docs, 
AbiWord, Apple iWork. 

Categories of Word Processors 
Text Editors (Simple Word Processors) 
These support basic features only. Examples include WordPad and Notepad. 
Basic Features: 

• Insert & Delete Text: Add or erase characters, words, lines, or pages. 
• Cut, Copy & Paste: Move or duplicate sections of text. 
• Page Size & Margins: Define page layout; text readjusts automatically. 
• Search & Replace: Find and optionally replace specific words/phrases. 
• Word Wrap: Text automatically moves to the next line. 
• Print: Send document to a printer. 

Full-Featured Word Processors 
These support advanced features for sophisticated document manipulation (e.g., MS Word). 
Advanced Features: 

• File Management: Create, delete, move, and search for files. 
• Font Specifications: Change font type, size, style (bold, italic, underline), and color. 
• Footnotes & Cross-references: Automate numbering and link to document sections. 
• Graphics: Embed illustrations, charts, and Clip Art. 
• Headers, Footers & Page Numbers: Add consistent text at the top/bottom of every page. 
• Layout Control: Set varied margins, indents, and paragraph formatting. 
• Macros: Record a series of keystrokes (text or commands) for automation. 
• Mail Merge: Generate multiple personalized documents (e.g., mailing labels). 
• Spell Checker & Thesaurus: Check spelling and find synonyms. 
• Tables of Contents & Indexes: Generate automatically based on codes. 
• Multiple Document Windows: Edit several documents simultaneously. 
• WYSIWYG (What You See Is What You Get): On-screen display matches printed output. 
 

Chapter 8 
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• The file extension for an Outlook file is “.pst” 
6. MS OneNote 

• It was released on November 19, 2003 
• It is a note-taking application 

Microsoft Office Versions 
• When introduced, it was a part of the Office suite only. Later, the developers made it free, standalone 

and easily available at play store for android devices 
• The notes may include images, text, tables, etc. 
• The extension for OneNote files is “.one” 
• It can be used both online and offline and is a multi-user application 

Apart from the applications mentioned above, various other applications are included in the MS Office 
suite but these are most commonly used ones and questions based on the same may be asked in the 
upcoming exams as well. 
Microsoft Office Versions 
When the Office suite was first released, it was entirely devoted for usage in computer systems but 
later with time the Office suite was modified for use in Laptops, Tablets and Mobile phones. 
Given below are the various versions of Microsoft Office along with the years in which the version 
was released: 

All the above-mentioned dates are for the Office suite released for Windows. Apart from these, the 
versions Online, for Mac and for Mobile Phones were released separately 

Working with Microsoft Word Interface 
The interface is the user's gateway to interact with the software. 
Key Components of the Word Window: 

Version name Release Date/ Year 

Microsoft Office for Windows October 1990 

Microsoft Office 3.0 August 30, 1992 

Microsoft Office 4.x 1994 

Microsoft Office 1995 August 24, 1995 

Microsoft Office 1997 1997 

Microsoft Office 2000 June 7, 1997 

Microsoft Office XP May 31, 2001 

Microsoft Office 2003 October 21, 2003 

Microsoft Office 2007 January 30, 2007 

Microsoft Office 2010 June 15, 2010 

Microsoft Office 2013 January 30, 2012 

Microsoft Office 2016 September 22, 2015 
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One Liners: Office Automation 
1. Office Automation uses computer software to digitally create, collect, store, manipulate, and relay 

office information to accomplish core tasks. 
2. Primary applications of office automation include Word Processors, Spreadsheets, Database 

Management Systems, and Presentation Software. 
3. A Word Processor is application software used for the composition, editing, formatting, and printing of 

text-based documents. 
4. A key advantage of a word processor over a typewriter is the ability to make changes without retyping 

the entire document. 
5. Text Editors (simple word processors) support only basic features like insert, delete, cut, copy, paste, 

and word wrap. 
6. Full-Featured Word Processors support advanced capabilities like mail merge, macros, footnotes, and 

table of contents generation. 
7. The WYSIWYG (What You See Is What You Get) feature ensures the on-screen display matches the 

printed output. 
8. The Title Bar in a word processor window displays the name of the active document and the 

application. 
9. The Ribbon in modern word processors replaced menus and contains tabs grouping related commands. 
10. The Quick Access Toolbar is a customizable bar for frequently used commands like Save, Undo, and 

Redo. 
11. The Ruler shows text positioning, tabs, margins, and indents both horizontally and vertically. 
12. The Document Window is the main area for creating and editing, with a blinking cursor indicating the 

insertion point. 
13. The Status Bar shows document information such as page number, word count, and zoom level. 
14. Ctrl+N is the keyboard shortcut to create a new document in most word processors. 
15. Ctrl+S is the shortcut to save a document, while Ctrl+O is used to open an existing document. 
16. Ctrl+P opens the Print dialog box for printing a document. 
17. In Insert Mode (default), new text pushes existing text forward. 
18. In Overtype Mode, new text overwrites existing text at the cursor position. 
19. Ctrl+A selects the entire document's content. 
20. The Backspace key deletes characters to the left of the cursor, while the Delete key deletes characters 

to the right. 
21. Cut (Ctrl+X), Copy (Ctrl+C), and Paste (Ctrl+V) are used to move or duplicate text via the Clipboard. 
22. The Clipboard is a temporary memory space managed by the operating system for transferring data 

between applications. 
23. Undo (Ctrl+Z) reverses the last action, and Redo (Ctrl+Y) reapplies it. 
24. Font Formatting involves changing the appearance of characters, including type, size, style, and color. 
25. Serif fonts have small decorative strokes at the ends (e.g., Times New Roman) and are good for 

printed body text. 
26. Sans-serif fonts lack decorative strokes (e.g., Arial, Calibri) and are better for on-screen text. 
27. Common font styles include Bold (Ctrl+B), Italic (Ctrl+I), and Underline (Ctrl+U). 
28. Shift+F3 cycles through case options for selected text (Sentence case, lowercase, UPPERCASE). 
29. Paragraph Formatting controls the alignment, indentation, and spacing of entire paragraphs. 
30. Text alignment options include Align Left (Ctrl+L), Center (Ctrl+E), Align Right (Ctrl+R), and Justify 

(Ctrl+J). 
31. Justified alignment makes text align evenly to both the left and right margins. 



 

  MK PREPARATIONS  

 

P a g e  15 | 19 

 

  

8
. O

ffice
 A

u
to

m
a

tio
n

 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Practice MCQs
1. What is the primary purpose of Office 
Automation? 
a) To replace human workers entirely 
b) To use computer software to digitally 
create, store, manipulate, and relay office 
information 
c) To design hardware for office use 
d) To provide entertainment in the workplace 
Answer: b) To use computer software to 
digitally create, store, manipulate, and 
relay office information 
2. Which of the following is NOT a primary 
application of office automation? 
a) Word Processor 
b) Spreadsheet 
c) Operating System 
d) Database Management System 
Answer: c) Operating System 
3. The greatest advantage of a word processor 
over a traditional typewriter is: 
a) It is more expensive 
b) It makes a louder sound 
c) It allows changes without retyping the 
entire document 
d) It uses more paper 
Answer: c) It allows changes without 
retyping the entire document 
4. Which word processing feature ensures 
that the on-screen display exactly matches the 
printed output? 
a) AutoCorrect 
b) WYSIWYG (What You See Is What You 
Get) 
c) Word Wrap 
d) Mail Merge 
Answer: b) WYSIWYG (What You See Is 
What You Get) 
5. In a word processor window, which 
component is a customizable bar for 
frequently used commands like Save and 
Undo? 
a) Title Bar 
b) Ribbon 
c) Quick Access Toolbar 
d) Status Bar 
Answer: c) Quick Access Toolbar 

6. What is the keyboard shortcut to select all 
text in a document? 
a) Ctrl+C 
b) Ctrl+V 
c) Ctrl+A 
d) Ctrl+X 
Answer: c) Ctrl+A 
7. Which typing mode causes new text to 
overwrite existing text at the cursor position? 
a) Insert Mode 
b) Overtype Mode 
c) Replace Mode 
d) Typeover Mode 
Answer: b) Overtype Mode 
8. The temporary memory space used by the 
operating system to hold cut or copied data 
for pasting is called the: 
a) Cache 
b) Clipboard 
c) RAM 
d) Hard Drive 
Answer: b) Clipboard 
9. Which font type has small decorative 
strokes at the ends of characters and is 
generally better for printed body text? 
a) Sans-serif 
b) Script 
c) Serif 
d) Monospace 
Answer: c) Serif 
10. What does the keyboard shortcut 
Shift+F3 do when text is selected? 
a) Makes text bold 
b) Cycles through case options (Sentence 
case, lowercase, UPPERCASE) 
c) Opens the Font dialog box 
d) Increases font size 
Answer: b) Cycles through case options 
(Sentence case, lowercase, UPPERCASE) 
11. Which text alignment makes text align 
evenly to both the left and right margins? 
a) Align Left 
b) Center 
c) Align Right 
d) Justify 
Answer: d) Justify 
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Microsoft Word (MS Word) 
With Word you can: 
 Create a document from scratch or from a template . 
 Add text, images, art, and videos. 
 Research a topic and find credible sources. 
 Access your documents from a computer, tablet, or phone via OneDrive. 
 Share your documents and collaborate with others. 
 Track and review changes. 

Create a new document 
1. On the File tab, select New. 
2. Select Blank document, or double-click a template image or type the kind of document into the Search for 

online templates box and press Enter. 
Tip:  For practice using Word features, try a learning guide like Welcome to Word or Insert your first table 
of contents. 
Add and format text 

1. Click on your new blank page and type some text. 
  
2. Select text to format and choose font options on the Home tab: Bold , Italic , Bullets , Numbering , and 

more. 

Chapter 9 
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2. On Shape Format or Drawing Tools Format, select Text Fill or Text Outline, and pick the color you 
want. 

3. Click or tap outside of your text box to see the effect. 

Choose a text effect 
1. Select the WordArt text to change. 

2. Go to Shape Format or Drawing Tools Format > Text Effects >Transform. 
Pick the effect you want. 

3. Click outside of your text box to see the effect. 
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2. Go to Layout, and open the Page Setup dialog box. 

3. Select Landscape, and in the Apply to box, choose Selected text. 

 
 
Add a border to a page 
1. Go to Design > Page Borders. 

2. Make selections for how you want the border to look. 
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One Liners: MS Word 
1. Microsoft Word allows you to create documents from scratch or from an online template. 
2. You can research topics and find credible sources directly within Microsoft Word. 
3. Documents can be accessed from a computer, tablet, or phone via OneDrive. 
4. Word facilitates document sharing and collaboration with others. 
5. The Track and Review changes feature is available in Microsoft Word. 
6. A new blank document is created from the File tab by selecting New and then Blank document. 
7. To create a document from a template, you can double-click a template image or search in 

the Search for online templates box. 
8. Learning guides like Welcome to Word are available for practice with Word features. 
9. Text is formatted using options on the Home tab such as Bold, Italic, Bullets, and Numbering. 
10. The Insert tab is used to add elements like Tables, Pictures, Shapes, SmartArt, Charts, and 

Screenshots. 
11. A table is inserted by selecting Insert > Table and hovering over a grid to choose the number of 

rows and columns. 
12. For a larger or customized table, use Insert > Table > Insert Table. 
13. Existing text separated by tabs can be converted to a table using Insert > Table > Convert Text to 

Table. 
14. You can draw a custom table using Insert > Table > Draw Table. 
15. To add text, place the cursor at the desired location and start typing. 
16. To replace text, select it and start typing; double-click selects a single word. 
17. Clicking to the left of a line selects the entire line. 
18. Text formatting can be applied from the pop-up toolbar or the Home tab's Font group. 
19. The Format Painter tool copies formatting from one text selection to another. 
20. Double-clicking the Format Painter allows copying formatting to multiple locations. 
21. To save a document to OneDrive, use File > Save As or Save a Copy and select OneDrive. 
22. Save personal files to OneDrive - Personal and work files to your company's OneDrive or 

SharePoint site. 
23. You can also save a document to other locations like the Desktop by selecting Browse. 
24. AutoSave automatically saves changes when a document is stored in OneDrive or SharePoint. 
25. AutoSave can be toggled on or off from the Quick Access Toolbar. 
26. The Quick Access Toolbar can be shown by right-clicking the ribbon and selecting Show Quick 

Access Toolbar. 
27. Pictures can be inserted from your PC (This Device), from Stock Images, or from the web (Online 

Pictures). 
28. In older Word versions, the option for online pictures may be labeled Online Pictures next 

to Pictures. 
29. To resize a picture, select it and drag a corner handle. 
30. Text wrapping options control how text flows around a picture; selecting any option other than In 

Line with Text allows you to move the picture. 
31. In Line with Text layout places a picture within a paragraph, causing it to move as text is added or 

removed. 
32. WordArt is inserted via Insert > WordArt; you can pick a style and type your text. 
33. Existing text can be converted to WordArt by selecting the text first, then going to Insert > 

WordArt. 
34. The color of WordArt text is changed using Text Fill or Text Outline on the Shape 

Format or Drawing Tools Format tab. 
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Practice MCQs
1. In Microsoft Word, where do you go to 
create a brand new document from a blank 
slate? 
a) Home > New 
b) File > New > Blank document 
c) Insert > New Document 
d) View > New Window 
Answer: b) File > New > Blank document 
2. Which feature in Word allows you to 
automatically save changes when your 
document is stored on OneDrive? 
a) AutoRecover 
b) Quick Save 
c) AutoSave 
d) Background Save 
Answer: c) AutoSave 
3. To quickly convert text separated by 
tabs into a structured table, which command 
should you use? 
a) Insert > Table > Draw Table 
b) Insert > Table > Excel Spreadsheet 
c) Insert > Table > Convert Text to Table 
d) Layout > Convert > Text to Table 
Answer: c) Insert > Table > Convert Text to 
Table 
4. What is the primary function of the 
Format Painter tool in Word? 
a) To change the page color 
b) To copy formatting from one text selection 
to another 
c) To insert painterly art effects 
d) To adjust paragraph spacing 
Answer: b) To copy formatting from one text 
selection to another 
5. How do you ensure that the header on 
the first page of your document is different 
from the rest (e.g., blank)? 
a) Delete the header on the first page manually. 
b) Insert a section break after the first page. 
c) Check the Different First Page box in the 
Header & Footer Tools. 
d) Use File > Options to disable the first page 
header. 
Answer: c) Check the Different First 
Page box in the Header & Footer Tools. 
6. When inserting a picture, which text 
wrapping option places the picture within the 

text paragraph, causing it to move as text is 
edited? 
a) Square 
b) Tight 
c) Behind Text 
d) In Line with Text 
Answer: d) In Line with Text 
7. You want to start page numbering from 
"1" on the second page of your document. What 
should you set the "Start at" value to in the 
Page Number Format dialog? 
a) 1 
b) 0 
c) 2 
d) -1 
Answer: b) 0 
8. To create a custom watermark using 
your company logo, which sequence of 
commands do you follow? 
a) Design > Watermark > Custom Watermark > 
Picture watermark 
b) Insert > Picture > Set as Watermark 
c) Page Layout > Background > Custom 
Watermark 
d) View > Watermark > Insert Picture 
Answer: a) Design > Watermark > Custom 
Watermark > Picture watermark 
9. Which key must you hold down while 
dragging a shape's rotation handle to constrain 
the rotation to 15-degree increments? 
a) Ctrl 
b) Alt 
c) Shift 
d) Tab 
Answer: c) Shift 
10. If the Quick Access Toolbar is not 
visible, how can you display it? 
a) Go to File > Options > Quick Access 
Toolbar. 
b) Right-click the ribbon and select Show 
Quick Access Toolbar. 
c) It is always visible and cannot be hidden. 
d) Go to View > Toolbars > Quick Access. 
Answer: b) Right-click the ribbon and 
select Show Quick Access Toolbar. 
11. To change only a specific section of 
your document to landscape orientation while 
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Microsoft Excel (MS Excel) 
What is Excel? 
Excel makes it easy to crunch numbers. With Excel, you can streamline data entry with AutoFill. Then, 
get chart recommendations based on your data, and create them with one click. Or easily spot trends and 
patterns with data bars, color coding, and icons. 
Create a workbook 
1. Open Excel. 
2. Select Blank workbook. Or press Ctrl+N. 

Enter data 
To manually enter data: 
1. Select an empty cell, such as A1, and then type text or a number. 
2. Press Enter or Tab to move to the next cell. 

To fill data in a series: 
1. Enter the beginning of the series in two cells: such as Jan and Feb; or 2014 and 2015. 
2. Select the two cells containing the series, and then drag the fill handle  across or 

down the cells. 

Chapter 10 



 

  MK PREPARATIONS  

 

P a g e  3 | 39 

 

  

9
. M

S E
x

ce
l 

 
 M 

K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

there is only one number reference in this formula. The Intellisense tag will appear for any 
function. 
AutoSum horizontally 

Avoid rewriting the same formula 
After you create a formula, you can copy it to other cells — no need to rewrite the same formula. 
You can either copy the formula, or use the fill handle  to copy the formula to adjacent cells. 
For example, when you copy the formula in cell B6 to C6, the formula in that cell automatically 
changes to update to cell references in column C. 
When you copy the formula, ensure that the cell references are correct. Cell references may 

change if they have relative references.  

https://support.microsoft.com/en-us/office/paste-options-8ea795b0-87cd-46af-9b59-ed4d8b1669ad
https://support.microsoft.com/en-us/office/fill-a-formula-down-into-adjacent-cells-041edfe2-05bc-40e6-b933-ef48c3f308c6
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What can I use in a formula to mimic calculator keys? 

Calculator key Excel method Description, example Result 

+ (Plus key) + (plus) Use in a formula to add numbers. Example: 
=4+6+2 

12 

- (Minus key) - (minus) Use in a formula to subtract numbers or to 
signify a negative number. 
Example: =18-12 
Example: =24*-5 (24 times negative 5) 

 
6 
-120 

x (Multiply key) * (asterisk; also 
called "star") 

Use in a formula to multiply numbers. Example: 
=8*3 

24 

÷ (Divide key) / (forward slash) Use in a formula to divide one number by 
another. Example: =45/5 

9 

% (Percent key) % (percent) Use in a formula with * to multiply by a 
percent. Example: =15%*20 

3 

√ (square root) SQRT (function) Use the SQRT function in a formula to find the 
square root of a number. Example: =SQRT(64) 

8 

1/x (reciprocal) =1/n Use =1/n in a formula, where n is the number 
you want to divide 1 by. 
Example: =1/8 

0.125 

Add a watermark in Excel 
You can use an image, such as a logo, to insert as a watermark that will appear on the 
spreadsheet along with the displayed data.  
Create a watermark 
1. Select Insert > Header & Footer. 
2. Tap on the header and on the Header & Footer Elements tab on the ribbon, click Picture. 
3. Select one of the available options to insert your image. In the header, you'll see & 

[Picture]. 
4. Tap anywhere outside the header to see the watermark. 

Format the watermark picture 
1. Click the header in the spreadsheet. 
2. On the Header & Footer Elements tab, click Format Picture. 
3. In the Format Picture dialog box, select Picture tab > Color > select an option. 

Merge and unmerge cells 
You can't split an individual cell, but you can make it appear as if a cell has been split by 
merging the cells above it. 
Merge cells 
1. Select the cells to merge. 
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Number formats 
To see all available number formats, select the Dialog Box Launcher next to Number on 

the Home tab in the Number group. 
Format Description 

General The default number format that Excel applies when you type a number. For the most 
part, numbers that are formatted with the General format are displayed just the way 
you type them. However, if the cell is not wide enough to show the entire number, 
the General format rounds the numbers with decimals. The General number format 
also uses scientific (exponential) notation for large numbers (12 or more digits). 

Number Used for the general display of numbers. You can specify the number of decimal 
places that you want to use, whether you want to use a thousands separator, and how 
you want to display negative numbers. 

Currency Used for general monetary values and displays the default currency symbol with 
numbers. You can specify the number of decimal places that you want to use, 
whether you want to use a thousands separator, and how you want to display 
negative numbers. 

Accounting Also used for monetary values, but it aligns the currency symbols and decimal 
points of numbers in a column. 

Date Displays date and time serial numbers as date values, according to the type and 
locale (location) that you specify. Date formats that begin with an asterisk (*) 
respond to changes in regional date and time settings that are specified in Control 
Panel. Formats without an asterisk are not affected by Control Panel settings. 

Time Displays date and time serial numbers as time values, according to the type and 
locale (location) that you specify. Time formats that begin with an asterisk (*) 
respond to changes in regional date and time settings that are specified in Control 
Panel. Formats without an asterisk are not affected by Control Panel settings. 

Percentage Multiplies the cell value by 100 and displays the result with a percent (%) symbol. 
You can specify the number of decimal places that you want to use. 

Fraction Displays a number as a fraction, according to the type of fraction that you specify. 
Scientific Displays a number in exponential notation, replacing part of the number with E+n, 

where E (which stands for Exponent) multiplies the preceding number by 10 to the 
nth power. For example, a 2-decimal Scientific format displays 12345678901 as 
1.23E+10, which is 1.23 times 10 to the 10th power. You can specify the number of 
decimal places that you want to use. 

Text Treats the content of a cell as text and displays the content exactly as you type it, 
even when you type numbers. 
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This unlocks all the cells on the worksheet when you protect the worksheet. Now, you can choose 
the cells you specifically want to lock. 

5. On the worksheet, select only the cells that you want to lock. 
6. Bring up the Format Cells popup window again (Ctrl+Shift+F). 
7. This time, on the Protection tab, check the Locked box and then select OK. 
8. On the Review tab, select Protect Sheet. 

 
9. In the Allow all users of this worksheet to list, choose the elements that you want users to 

be able to change. 
More information about worksheet elements 

Clear this check box To prevent users from 

Select locked cells 
Moving the pointer to cells for which the Locked check box is selected on 
the Protection tab of the Format Cells dialog box. By default, users are 
allowed to select locked cells. 

Select unlocked cells 

Moving the pointer to cells for which the Locked check box is cleared on 
the Protection tab of the Format Cells dialog box. By default, users can 
select unlocked cells, and they can press the TAB key to move between the 
unlocked cells on a protected worksheet. 

Format cells 

Changing any of the options in the Format Cells or Conditional 
Formatting dialog boxes. If you applied conditional formats before you 
protected the worksheet, the formatting continues to change when a user 
enters a value that satisfies a different condition. 

Format columns Using any of the column formatting commands, including changing 
column width or hiding columns (Home > Format). 

Format rows Using any of the row formatting commands, including changing row 
height or hiding rows (Home > Format). 

Insert columns Inserting columns. 
Insert rows Inserting rows. 
Insert hyperlinks Inserting new hyperlinks, even in unlocked cells. 

Delete columns 
Deleting columns. 
If Delete columns is protected and Insert columns is not also protected, a 
user can insert columns that they cannot delete. 
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One Liners: MS Excel 
1. Excel simplifies numerical calculations and data entry with features like AutoFill. 

2. Chart recommendations based on your data can be created with a single click in Excel. 

3. Trends and patterns can be easily visualized using data bars, color coding, and icons in 

Excel. 

4. A new blank workbook is created by selecting Blank workbook or pressing Ctrl+N. 

5. To enter data manually, select a cell, type, and press Enter or Tab to move to the next cell. 

6. The AutoFill series is created by entering the start of the series in two cells and dragging 

the fill handle. 

7. Excel can perform calculations using simple formulas for addition, subtraction, 

multiplication, and division. 

8. All Excel formulas must begin with an equal sign (=). 

9. The basic arithmetic operators are: plus (+) for addition, minus (-) for subtraction, asterisk 

(*) for multiplication, and forward slash (/) for division. 

10. There is no dedicated SUBTRACT function in Excel; the minus operator (-) is used 

within a formula. 

11. The SUM function can incorporate negative numbers using a minus sign, e.g., 

=SUM(12,5,-3,8,-4). 

12. The AutoSum feature automatically senses a contiguous range and inserts a SUM 

formula. 

13. AutoSum can be applied both vertically (above/below a range) and horizontally (left/right 

of a range). 

14. AutoSum does not work on non-contiguous ranges of cells. 

15. The Intellisense guide for a function appears as a floating tag and provides a hyperlink to 

its Help topic. 

16. After creating a formula, you can copy it to adjacent cells to avoid rewriting it. 

17. When a formula with relative references is copied, the cell references update automatically 

relative to their new position. 

18. To mimic a calculator's square root function, use the SQRT function, e.g., =SQRT(64). 
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Practice MCQs
1. Which keyboard shortcut is used to 

create a new blank workbook in Excel? 
a) Ctrl+B 
b) Ctrl+N 
c) Ctrl+W 
d) Ctrl+T 
Answer: b) Ctrl+N 

2. To automatically fill a series like "Jan, 
Feb, Mar..." what must you do first? 
a) Type the entire series once. 
b) Use the Fill Series dialog box. 
c) Enter the beginning of the series in 
two cells and select them. 
d) Select the cells and choose "Fill 
Series" from the Data tab. 
Answer: c) Enter the beginning of the 
series in two cells and select them. 

3. What is a fundamental requirement for 
every Excel formula? 
a) It must contain a function. 
b) It must reference another cell. 
c) It must begin with an equal sign (=). 
d) It must be enclosed in parentheses. 
Answer: c) It must begin with an 
equal sign (=). 

4. How does Excel handle subtraction 
within a formula, given there is no 
SUBTRACT function? 
a) It uses the SUM function with 
negative numbers. 
b) It uses the DIF function. 
c) It uses the minus (-) operator. 
d) Both a and c are correct. 
Answer: d) Both a and c are correct. 

5. The AutoSum feature is designed to 
work with which type of cell ranges? 
a) 3-D references 
b) Non-contiguous ranges 
c) Contiguous ranges 
d) Array ranges 
Answer: c) Contiguous ranges 

6. When you copy a formula containing a 
relative cell reference like =A1 to the 
cell one column to the right, what does it 
become? 
a) =A1 
b) =$A$1 
c) =B1 
d) =A2 
Answer: c) =B1 

7. In Excel, which function is equivalent to 
the calculator's square root (√) key? 
a) SQR 
b) ROOT 
c) SQRT 
d) POWER(...,0.5) 
Answer: c) SQRT 

8. Where is a watermark picture inserted in 
an Excel worksheet to appear behind the 
data? 
a) As a background from the Page 
Layout tab. 
b) Into the header or footer via Insert > 
Header & Footer. 
c) As an inline image on the worksheet. 
d) Using the Watermark option on the 
Design tab. 
Answer: b) Into the header or footer 
via Insert > Header & Footer. 

9. What happens to the contents of cells 
B2, C2, and D2 when they are merged 
into one cell? 
a) All contents are concatenated. 
b) Only the content of the upper-left cell 
(B2) is kept. 
c) The contents are averaged. 
d) An error message appears. 
Answer: b) Only the content of the 
upper-left cell (B2) is kept. 

10. After inserting a new row, the "Insert 
Options" button allows you to: 
a) Choose the data source for the new 
row. 
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Microsoft PowerPoint (MS PowerPoint) 
What is PowerPoint? 
Overview 
 With PowerPoint on your PC, Mac, or mobile device, you can: 
 Create presentations from scratch or a template. 
 Add text, images, art, and videos. 
 Select a professional design with PowerPoint Designer. 
 Add transitions, animations, and cinematic motion. 
 Save to OneDrive, to get to your presentations from your computer, tablet, or phone. 
 Share your work and work with others, wherever they are. 

Create a presentation in PowerPoint 
Create presentations from scratch or start with a professionally designed, fully customizable template 
from Microsoft Create. 
Tip: If you have Microsoft Copilot it can help you create a presentation, add slides or images, and more. 
To learn more see Create a new presentation with Copilot in PowerPoint. 
Create a presentation 
1. Open PowerPoint. 
2. In the left pane, select New. 
3. Select an option: 

 To create a presentation from scratch, select Blank Presentation. 
 To use a prepared design, select one of the templates. 
 To see tips for using PowerPoint, select Take a Tour, and then select Create. 

Add a slide 
1. In the thumbnails on the left pane, select the slide you want your new slide to follow. 
2. In the Home tab, in the Slides section, select New Slide. 

Chapter 11 

https://go.microsoft.com/fwlink/?linkid=2226436
https://go.microsoft.com/fwlink/?linkid=2226436
https://support.microsoft.com/en-us/office/create-a-new-presentation-with-copilot-in-powerpoint-3222ee03-f5a4-4d27-8642-9c387ab4854d
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 Browse for the picture you want, select it, and then select Insert. 
3. To add illustrations: 

 In the Illustrations section, select Shapes, Icons, 3D Models, SmartArt, or Chart. 
 In the dialog box that opens when you click one of the illustration types, select the item you 

want and follow the prompts to insert it. 

  Save in PowerPoint 
Save your presentation to OneDrive 
When you save your files to the cloud, you can share and collaborate with others, and get to your files 
from anywhere - on your computer, tablet, or phone. 
1. Select File > Save As. 
2. Select OneDrive. 

Save personal files to OneDrive - Personal, and work files to your company OneDrive. You can 
also save to another location, like your device. 

https://www.facebook.com/sharer.php?u=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fcreate-a-presentation-in-powerpoint-422250f8-5721-4cea-92cc-202fa7b89617
https://www.facebook.com/sharer.php?u=https%3A%2F%2Fsupport.microsoft.com%2Fen-us%2Foffice%2Fcreate-a-presentation-in-powerpoint-422250f8-5721-4cea-92cc-202fa7b89617
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 To move to the previous or next slide, select Previous or Next. 
 To view all the slides in your presentation, select See all slides. 

Notes 
During your presentation, the speaker notes are visible on your monitor, but aren't visible to the audience. 
 The Notes pane is a box that appears below each slide. Tap it to add notes. 

  
 If you don’t see the Notes pane or it is completely minimized, click Notes on the task bar across the 

bottom of the PowerPoint window 
Subtitles 
You can choose which language the caption/subtitle text should be shown to your audience. This feature 
requires Windows 10 and an up-to-date version of PowerPoint. 
1. Select Slide Show > Subtitle Settings. 
2. Set your Spoken Language. 
3. Select Subtitle Language to see which languages PowerPoint can display on-screen as captions or 

subtitles, and select the one you want. 
4. In the Subtitle Settings menu, set the desired position of the captions or subtitles. 
5. More appearance settings are available by selecting Subtitle Settings > More Settings (Windows). 

What is a slide master? 
When you want all your slides to contain the same fonts and images (such as logos), you can make those 
changes in one place—the Slide Master, and they'll be applied to all your slides. To open Slide Master view, 
on the View tab, select Slide Master: 
The master slide is the top slide in the thumbnail pane on the left side of the window. 
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Rotate (mirror) text in a shape or text box 
1. Insert a text box or shape in your document, and then type and format your text. 
2. Right-click the box or shape and select Format Shape. 
3. In the Format Shape pane, under Shape Options, select Effects. 

4. Under 3-D Rotation , in the X Rotation or Y Rotation box, enter 180 . 
5. (Optional) If your text box becomes filled with a color, you can remove the color in the Format 

Shape pane. Under Shape Options , click the Fill & Line tab , expand Fill , and select No fill . 

6. (Optional) To remove the text box outline, right-click the text box, click Outline in the mini toolbar 
that appears, and choose No Outline . 

Position text horizontally in a shape or text box 
 

To change the horizontal alignment of a single paragraph or line: 
1. Click in the paragraph or line of text that you want to modify. 
2. On the Home tab (or the Message tab in Outlook), click the horizontal alignment option that you 

want. 
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 To view a detail in your slide up close, select Zoom into slide, and then point to the part you want to 
see. 

 
 To point to or write on your slides as you present, select Pen and laser pointer tools. 

 
Press the Esc key when you want to turn off the pen, laser pointer, or highlighter. 

 To hide or unhide the current slide in your presentation, select Black or unblack slide show. 

 
You can use PowerPoint on your smartphone as a remote control to run your presentation and view your 
speaker notes. See Using a laser pointer on your smartphone when presenting in PowerPoint for more 
information, including a brief video. 
Swap the Presenter view and Slide view monitors 
To manually determine which screen shows your notes in Presenter view and which shows only the slides 
themselves, on the task bar at the top of Presenter view, select Display Settings, and then select Swap 
Presenter View and Slide Show. 

 

https://support.microsoft.com/en-us/office/present-a-slide-show-from-a-smartphone-and-use-a-laser-pointer-for-emphasis-485e8618-98ed-472b-84fa-443e23ea602a
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One Liners: MS Power Point 
1. PowerPoint allows you to create presentations from scratch or from professionally designed 

templates. 

2. With Microsoft Copilot, you can get assistance creating presentations, adding slides, images, and 

more. 

3. To create a new presentation, open PowerPoint, select New in the left pane, and choose Blank 

Presentation or a template. 

4. The Take a Tour option provides tips for using PowerPoint. 

5. A new slide is added by selecting a slide in the thumbnail pane, then going to Home > Slides > 

New Slide. 

6. The layout for a new slide is chosen from the Layout menu in the Slides section on 

the Home tab. 

7. Text is formatted using options like Font, Bold, Italic, Increase Font Size, and Decrease Font 

Size in the Home tab's Font section. 

8. Bulleted or numbered lists are created by selecting text and choosing Bullets or Numbering on 

the Home tab. 

9. Pictures are inserted from the Insert tab, Images section, by selecting Pictures and choosing a 

source. 

10. Illustrations such as Shapes, Icons, 3D Models, SmartArt, and Charts are inserted from 

the Illustrations section of the Insert tab. 

11. To save a presentation to the cloud for access and collaboration, use File > Save As and 

select OneDrive. 

12. Save personal files to OneDrive - Personal and work files to your company OneDrive. 

13. AutoSave is always on when you're online and saves changes as you work; pending changes sync 

when you reconnect. 

14. Themes and their Variants are applied from the Design tab. 

15. PowerPoint Designer suggests design ideas when you insert pictures, a list, or dates; it opens 

automatically. 

16. You can also open Designer by selecting a picture and then choosing Design > Designer. 
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Practice MCQs
1. What is the primary purpose of Microsoft 

Copilot in PowerPoint as mentioned in the 
chapter? 
a) To design custom animations 
b) To help create presentations, add slides 
or images, and more 
c) To automatically record narration 
d) To convert presentations to video 
Answer: b) To help create presentations, 
add slides or images, and more 

2. Where is the "Take a Tour" option located 
when creating a new presentation? 
a) On the Design tab 
b) In the New pane after selecting Blank 
Presentation 
c) Under File > Options 
d) On the Slide Show tab 
Answer: b) In the New pane after 
selecting Blank Presentation 

3. To apply a professional design suggestion 
automatically after inserting a picture, 
which feature should you use? 
a) Slide Master 
b) Transitions 
c) PowerPoint Designer 
d) Animation Painter 
Answer: c) PowerPoint Designer 

4. How do you access the Presenter 
View when running a slide show on a 
single monitor? 
a) Press F5 
b) Select Slide Show > Presenter View 
c) Click the three dots (...) on the control 
bar in Slide Show view 
d) It automatically appears if notes are 
added 
Answer: c) Click the three dots (...) on 
the control bar in Slide Show view 

5. If you want a company logo to appear on 
every slide in the same position, where 
should you place it? 
a) On the first slide only 
b) On the Slide Master 
c) As a watermark from the Design tab 
d) In the Header & Footer dialog 
Answer: b) On the Slide Master 

6. What happens when you edit a layout 
master in Slide Master view? 
a) Only new slides based on that layout will 
reflect the changes. 
b) All existing slides immediately update. 
c) Only the title slide changes. 
d) You must manually update each slide. 
Answer: a) Only new slides based on that 
layout will reflect the changes. 

7. Which of the following is NOT a standard 
method to delete a sequence of contiguous 
slides? 
a) Press Shift, select the first and last slides, 
right-click, choose Delete Slide. 
b) Press Ctrl, select each slide individually, 
right-click, choose Delete Slide. 
c) Go to Slide Sorter view, select the slides, 
and press Delete. 
d) The chapter does not mention using the 
Delete key. 
Answer: b) Press Ctrl, select each slide 
individually, right-click, choose Delete 
Slide. (This is for non-adjacent slides) 

8. When you duplicate a slide using the 
"Duplicate Slide" option, where is the copy 
placed? 
a) At the end of the presentation 
b) At the beginning of the presentation 
c) Immediately after the original slide 
d) In a new presentation file 
Answer: c) Immediately after the 
original slide 

9. To change the entire presentation from 
landscape to portrait orientation, which 
menu sequence do you follow? 
a) Design > Slide Size > Custom Slide Size 
> Portrait 
b) File > Page Setup > Portrait 
c) View > Slide Orientation > Portrait 
d) Design > Orientation > Portrait 
Answer: a) Design > Slide Size > Custom 
Slide Size > Portrait 

10. What is the primary function of Sections in 
PowerPoint? 
a) To apply different animations to groups 
of slides 
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Key-Board and Shortcut Keys 
What is KEYBOARD? 

• A panel/plate/board of keys that operates a computer or typewriters. 
• A piece of computer hardware used to input text, characters, and other commands into a 

computer or similar device 
Types of Keys Setup on Keyboard: 

Keyboard Shortcut keys: 

1. Set of one or more keys that generates a particular command to be executed. 
2. Generally executed by using Alt or Ctrl keys with some other keys 
3. A plus (+) sign between two or more keys indicates that these keys should 

pressed in combination. For example Ctrl+Shift+A means to press and hold Ctrl 
and Shift and then press A 

Chapter 10 
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Frequently used Keys: 
 

Basic Shortcut Keys 
Shortcut Keys Operation 

Alt + F File menu options on currant program 
Alt + E Edit option in current program 
Ctrl + A Select all text 
Ctrl + x Cut selected item 
Shift + Del Delete selected item 
F1 Universal help (for all programs) 
F2 Rename selected icon 
F3 Start find from desktop 
F5 Refresh contents or webpage 
Alt + F4 Close currant open program 
Ctrl + F4 Close window in program 

Key Function 

Alt Key • Key modifier that enables a different input 

Escape (esc) key 
• Cancel the current operation 

• Exit the currant window 

Space bar • Move the curser one space forward 

Tab Key 
• Move the cursor several space foreword 

• Move to next text box on a form or on a table 

Control (ctrl) Key 
• Modifer key 

• Pressed in conjuction with another key performed a specific task 

Back Space Key Move the curser one space backward 

 
Enter Key 

• Move the curser to the beginning of the next line 

• In a dialogue box enable the highlighted option 

• In some program start the next operation or 
confirm the current operation 

 
Shift Key 

In combination of another latter to type an uppercase latter 
In combination with another key to type the symbol shown on upper part 
of that key 
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Ctrl + H Open find and replace option Ctrl + Space Select entire column 

Ctrl + U Underline highlighted selection Alt + = Create formula to sum all 
above cells 

Ctrl + Y Underline highlighted text Ctrl + W Close document 

Ctrl + 5 Strike through highlighted 
selection Ctrl + ‘ Insert value of above cell into 

current cell 

Ctrl + O Open options Ctrl + Shift + ! Format numbers in comma 
format 

Ctrl + N Open new workbook/document   
Microsoft Power Point Shortcut Keys 

Tip: Basic text editing and formatting shortcut keys for MS word is same for MS Excel and MS Power 
Point. 
Outlook Shortcut Keys 

Shortcut Keys Operation 
Alt + S Send the E-mail 
Ctrl + C Copy selected text 
Ctrl + X Cut selected text 

Shortcut Keys Operation 
12 Save As. 
Alt + F4 Close PowerPoint 
Ctrl + M Insert a new slide. 
Ctrl + D Duplicate the selected slide. 
Ctrl + Shift + D Duplicate the selected slide. 
Page Up/Down Navigate to the previous/next slide 
Ctrl + G Group objects. 
Ctrl + Spacebar Reset manual character formatting 
Shift + F3 Change the case of selected text. 
Alt + Q "Tell me what you want to do". 
Ctrl + T Open the Font window. 
Ctrl + K Insert a hyperlink. 
Ctrl + Tab Switch between open presentations. 
Alt + F9 Show/hide gridlines and guides 
Alt + F10 Show/hide selection pane. 
Alt + N Access the Insert tab. 
Alt + H Access the Home tab. 
Esc End the slideshow. 
Shift + F5 Start the slideshow from the current slide. 
F5 Start the slideshow from the beginning. 
Ctrl + Move Item with Mouse Duplicate the item 
Shift + Select Item with Mouse Add to selection. 
Ctrl + Shift + G Ungroup objects. 
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Win + Tab Cycle through open programs on task bar 
Win + F Display the windows search / find feature 
Win + Ctrl + F Display the search for computers window 
Win + F1 Display the Microsoft windows help 
Win + R Open the run window 
Win + Pause/Brake Open the system properties window 
Win + U Open utility manger 

Mac Shortcut Keys: 

Shortcut Keys Operation 

Command + A Select all items. 
Command + C Copy selected items. 
Command + V Paste copied items. 
Command + X Cut selected items. 
Command + Z Undo the last action. 
Shift + Z Redo the last action. 
Command + N Open a new window or document. 
Command + P Open the print dialog box. 
Command + S: Save the current document. 
Command + Q Quit the current application. 
Command + W Close the current window 
Command + Tab Switch between open applications. 
Command + Space Open Spotlight search. 
Command + Shift + 3 Take a whole screenshot of everything on your screen. 
Command + Shift + 4 Click a snap of just a part of your screen. 
Command + F Open the find dialog box. 
Command + T Open a new tab in browsers. 
Command + L Highlight the address bar in browsers 

Famous Abbreviations: 

Abbreviation Meaning Abbreviation Meaning 

AI Artificial Indulgence  .exe Executable 
ASCII American slandered code for 

information exchange  
FAX Facsimile – Latin word 

meaning make similar 
BINAC Binary automatic computer GIF Graphic Interchange 

Format  
BIOS Basic input output system GSM Global System for 

Mobile Communication 
CD Compact Disk HTTP Hyper Text Transfer 

Protocol 
DVD Digital versatile Disk HTML Hypertext Markup 

Language 
E-Commerce Electronic commerce  JPEG Joint photographic 

Experts Group 
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One Liners: Keyboard and shortcut Keys 
1. A keyboard is a panel of keys used to operate a computer or typewriter. 

2. A keyboard is a piece of computer hardware used to input text, characters, and other commands. 

3. Keyboard shortcut keys are a set of one or more keys that generate a particular command to be 

executed. 

4. Shortcut keys are generally executed by using the Alt or Ctrl keys in combination with other keys. 

5. A plus (+) sign between keys indicates that those keys should be pressed in combination. 

6. Ctrl+Shift+A means press and hold Ctrl and Shift, then press A. 

7. The Alt key is a key modifier that enables a different input. 

8. The Escape (Esc) key cancels the current operation or exits the current window. 

9. The Spacebar moves the cursor one space forward. 

10. The Tab key moves the cursor several spaces forward or to the next text box on a form. 

11. The Control (Ctrl) key is a modifier key pressed in conjunction with another key to perform a specific 

task. 

12. The Backspace key moves the cursor one space backward. 

13. The Enter key moves the cursor to the beginning of the next line. 

14. The Enter key enables the highlighted option in a dialogue box. 

15. The Enter key can start the next operation or confirm the current operation in some programs. 

16. The Shift key, combined with another letter, types an uppercase letter. 

17. The Shift key, combined with another key, types the symbol shown on the upper part of that key. 

18. Alt + F opens the File menu options in the current program. 

19. Alt + E opens the Edit options in the current program. 

20. Ctrl + A selects all text. 

21. Ctrl + X cuts the selected item. 

22. Shift + Del deletes the selected item. 

23. F1 provides universal help for all programs. 

24. F2 renames a selected icon. 

25. F3 starts the find function from the desktop. 

26. F5 refreshes the contents or webpage. 
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Practice MCQs
1. What is the primary function of a keyboard? 

a) Display visual output 
b) Input text and commands 
c) Process data 
d) Store files 
Answer: b) Input text and commands 

2. In the shortcut notation "Ctrl+Shift+A", the 
plus sign (+) indicates: 
a) Press keys one after the other 
b) Press keys in sequence slowly 
c) Press and hold keys in combination 
d) Press the keys only once 
Answer: c) Press and hold keys in 
combination 

3. Which key is used to cancel the current 
operation or exit a window? 
a) Tab 
b) Alt 
c) Escape (Esc) 
d) Spacebar 
Answer: c) Escape (Esc) 

4. The function of the Tab key is NOT to: 
a) Move the cursor several spaces forward 
b) Move to the next text box on a form 
c) Move the cursor one space forward 
d) Navigate within a table 
Answer: c) Move the cursor one space 
forward 

5. What is the role of the Ctrl key? 
a) To type uppercase letters 
b) To move the cursor backward 
c) As a modifier key pressed with another 
key for a task 
d) To open the Start menu 
Answer: c) As a modifier key pressed with 
another key for a task 

6. Pressing Shift + F10 in Windows performs 
which action? 
a) Opens the Run dialog 
b) Saves the document 
c) Simulates a right-click 
d) Refreshes the page 
Answer: c) Simulates a right-click 

7. In Microsoft Word, which shortcut changes 
text to Heading 2? 
a) Ctrl + Alt + 1 

b) Ctrl + Alt + 2 
c) Ctrl + Alt + 3 
d) Ctrl + Alt + H 
Answer: b) Ctrl + Alt + 2 

8. In MS Word, Ctrl + Shift + < is used to: 
a) Increase font size by +1 
b) Decrease font size by -1 
c) Change text to heading 
d) Open the find window 
Answer: b) Decrease font size by -1 

9. Which function key is used for universal 
help in most programs? 
a) F2 
b) F1 
c) F3 
d) F5 
Answer: b) F1 

10. In MS Word, what does the shortcut Alt + 
Shift + T do? 
a) Inserts the current date 
b) Inserts the current time 
c) Opens the table menu 
d) Starts a new document 
Answer: b) Inserts the current time 

11. In MS Excel, which key combination enters 
the current time? 
a) Ctrl + ; 
b) Ctrl + Shift + : 
c) Alt + = 
d) Ctrl + ' 
Answer: b) Ctrl + Shift + : 

12. What is the result of pressing Alt + = in 
Microsoft Excel? 
a) Opens the formula window 
b) Creates a formula to sum all cells above 
c) Formats numbers as currency 
d) Inserts a new worksheet 
Answer: b) Creates a formula to sum all 
cells above 

13. In MS Excel, Ctrl + Shift + $ is used to: 
a) Format numbers as date 
b) Format numbers as currency 
c) Format numbers as percentage 
d) Insert a dollar sign 
Answer: b) Format numbers as currency 
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Data Communication and Computer Networking 
Introduction to Data Communication Systems 
We live in an era of an electronic global village, where computers, telephones, and wireless devices are 
interconnected worldwide. This connectivity forms the backbone of modern life, enabling everything 
from remote collaboration and e-commerce to global information sharing. At its core, this is made 
possible by data communication. 
What is Data Communication? 
Data communication is defined as the electronic exchange of digital information (data) between two or 
more devices via a transmission medium. This medium can be guided (wired/bounded), like a cable, 
or unguided (wireless/unbounded), like radio waves. 
For a system to perform this exchange, five fundamental components must be present: 

1. Sender (Source/Transmitter): The device that originates and sends the data message (e.g., a 
computer, mobile phone, or video camera). It converts the message into a signal suitable for 
transmission. 

2. Receiver (Destination/Sink): The device that accepts the transmitted message (e.g., a server, 
printer, or another computer). It converts the received signal back into a usable form. 

3. Message: The actual information or data to be communicated. This can be text, numbers, 
pictures, sound, video, or any combination thereof. 

4. Transmission Medium (Channel): The physical path through which the message travels from 
sender to receiver (e.g., twisted-pair cable, fiber optics, or the atmosphere). 

5. Protocol: A set of pre-defined rules and conventions that govern all aspects of communication. It 
represents an agreement between devices on how data is formatted, transmitted, received, and 
acknowledged. Without a common protocol, effective communication is impossible. Protocols 
handle error detection, synchronization, and signaling. 

Example: When you send an email, your laptop (Sender) uses the SMTP protocol to send the email text 
(Message) over a Wi-Fi connection (Medium) to your email provider’s server (Receiver). 
In more detailed systems, we also consider Encoder and Decoder (Codec). An encoder converts digital 
signals into a form suitable for the transmission medium (e.g., modulation), while a decoder performs the 
reverse process (demodulation) at the receiving end. 
Key Characteristics of an Effective Network 
For a network to be functional and efficient, it must strive to meet three primary goals, often encapsulated 
in the delivery requirements: 

• Delivery: The system must deliver data to the correct, intended destination. 
• Accuracy: The system must deliver data accurately, without alteration. The data received must be 

identical to the data sent. 
• Timeliness: The system must deliver data in a timely manner. For real-time applications like 

audio and video, low delay (latency) is more critical than perfect accuracy. A related concept 
is Jitter, which refers to the variation in packet delay. High jitter in a video call causes choppy 
audio and frozen video. 

Chapter 13 
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o Characteristics: Centralized management, high security, scalable. Requires expensive 
server hardware/admin. 

o Example: Corporate email, web browsing. 
• Peer-to-Peer (P2P): 

o All computers (peers) have equal status; each can act as both client and server. 
o Characteristics: Easy/inexpensive to set up, no central admin. Less secure, not scalable, 

poor under heavy load. 
o Example: Small office/home networks, BitTorrent. 

• Hybrid: Combines client-server and P2P models. 
The OSI and TCP/IP Reference Models 
The Need for Layered Models 
Before standardization, vendor-specific solutions couldn't interoperate. Layered models divide the 
complex task of network communication into simpler, manageable layers, each with a specific function. 
The OSI (Open Systems Interconnection) Model 
A 7-layer theoretical framework developed by ISO. 

Layer Name Key Function Protocols/Devices PDU 

7 Application 

Provides interface 
for user/apps to 
access network 

services. 

HTTP, FTP, SMTP, DNS, 
Telnet Data 

6 Presentation 
Translation, 
encryption, 

compression. 

SSL/TLS, JPEG, MPEG, 
ASCII/EBCDIC Data 

5 Session 
Establishes, 

manages, terminates 
sessions/dialogues. 

NetBIOS, RPC, SIP Data 

4 Transport 

End-to-end process-
to-process 

communication, 
reliability, flow 

control. 

TCP (reliable), UDP (fast) Segment/Datagram 

3 Network 
Logical addressing 
(IP), routing across 
multiple networks. 

IP, ICMP, IGMP, Routers Packet 

2 Data Link 

Node-to-node 
delivery on same 

link, framing, 
physical addressing 

(MAC). 

Ethernet, PPP, Switches, 
Bridges, NICs Frame 

1 Physical 

Transmits raw bit 
stream over physical 

medium. Defines 
electrical/mechanical 

specs. 

RS-232, 100Base-TX, Hubs, 
Repeaters, Cables Bit 
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One Liners: Data Communication & Networking 
FOUNDATIONAL CONCEPTS 

1. Data communication is the electronic exchange of digital information between two or more 
devices via a transmission medium. 

2. The five fundamental components of any data communication system are Message, Sender, 
Receiver, Transmission Medium, and Protocol. 

3. A protocol is a set of rules governing communication, handling aspects like error detection, 
synchronization, and authentication. 

4. The encoder converts digital signals into a form suitable for transmission, while 
the decoder performs the reverse process at the receiver. 

5. Delivery, Accuracy, and Timeliness are the three key properties of an effective data 
communication system. 

6. Jitter refers to the variation in packet delay and is particularly detrimental to real-time 
audio/video communication. 

7. An analog signal is characterized by continuous variation in amplitude, frequency, and phase 
over time. 

8. Frequency of an analog signal is measured in Hertz (Hz) and represents the number of cycles 
completed per second. 

9. A digital signal represents data as discrete, distinct on-off electrical pulses, typically binary 1s 
and 0s. 

10. ASCII is a 7-bit coding scheme capable of representing 128 characters, primarily for English 
text. 

11. Unicode uses 16 or more bits to represent over 65,000 symbols, including characters from nearly 
all world languages. 

12. UTF-8 is a variable-length Unicode encoding that maintains backward compatibility with ASCII. 
13. Attenuation is the loss of signal strength as it travels through a medium, measured in decibels 

(dB). 
14. Amplification is the process of strengthening an attenuated signal using devices like amplifiers 

or repeaters. 
15. Distortion occurs when different frequency components of a signal arrive at different times, 

changing the signal's shape. 
16. Noise is any unwanted external signal that mixes with and corrupts the original signal during 

transmission. 
17. Crosstalk is a specific type of noise where signals leak from one cable or channel into an 

adjacent one. 
18. In simplex mode, communication is unidirectional with one permanent sender and one permanent 

receiver. 
19. Half-duplex mode allows two-way communication but not simultaneously; devices must take 

turns. 
20. Full-duplex mode enables simultaneous two-way communication, requiring either two channels 

or channel division. 
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Practice MCQs
1. In data communication, which 

component is responsible for 
converting a message into a signal 
suitable for the transmission 
medium? 
a) Receiver 
b) Protocol 
c) Encoder 
d) Transmission Medium 
Answer: c) Encoder 

2. The property of a communication 
system that ensures data is delivered 
as it is produced, without significant 
delay or jitter, is called: 
a) Delivery 
b) Accuracy 
c) Timeliness 
d) Synchronization 
Answer: c) Timeliness 

3. Which characteristic of an analog 
signal refers to the position of the 
wave relative to a point in time? 
a) Amplitude 
b) Frequency 
c) Phase 
d) Wavelength 
Answer: c) Phase 

4. UTF-8 encoding is widely adopted on 
the web primarily because: 
a) It uses the fewest bits per character 
b) It is backward compatible with 
existing ASCII text 
c) It provides the strongest encryption 
d) It is mandated by IEEE standards 
Answer: b) It is backward compatible 
with existing ASCII text 

5. Distortion in a signal differs from 
noise in that distortion: 
a) Is always caused by external sources 
like motors 
b) Refers to unwanted addition of 

external signals 
c) Involves change in signal shape due 
to varying propagation speeds of its 
components 
d) Can be completely eliminated by 
using shielded cables 
Answer: c) Involves change in signal 
shape due to varying propagation 
speeds of its components 

6. The metallic shield in a coaxial cable 
serves the primary purpose of: 
a) Providing structural rigidity 
b) Acting as the primary data conductor 
c) Shielding the central conductor from 
electromagnetic interference 
d) Reducing the cable's weight 
Answer: c) Shielding the central 
conductor from electromagnetic 
interference 

7. In fiber optic communication, total 
internal reflection occurs because: 
a) The core has a higher refractive index 
than the cladding 
b) The cladding has a higher refractive 
index than the core 
c) Both core and cladding have identical 
refractive indices 
d) Light signals are amplified at each 
reflection point 
Answer: a) The core has a higher 
refractive index than the cladding 

8. Which wireless communication 
medium is characterized by 
omnidirectional propagation and 
ability to penetrate walls? 
a) Microwaves 
b) Satellite waves 
c) Radio waves 
d) Infrared waves 
Answer: c) Radio waves 
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Computational Thinking and Algorithms 
Introduction to Computational Thinking 
Computational Thinking (CT) is a structured, problem-solving methodology that enables individuals 
to tackle complex problems by applying techniques and processes inspired by computer science. It is a 
universal skill, not limited to programming, applicable in fields such as mathematics, science, 
engineering, business, healthcare, and everyday life tasks like planning a trip or organizing an event. CT 
involves a mental framework for logical and creative problem-solving, using specific techniques to think 
clearly, logically, and systematically. 
The primary goal is to design systematic, step-by-step solutions that can be executed by a human, a 
computer, or both. It prepares individuals to deconstruct complex challenges, identify patterns, focus on 
essentials, and design effective solutions. 

Core Components (Pillars) Of Computational Thinking 
Computational thinking is built upon four fundamental, interconnected pillars. 

Decomposition 
Definition: The process of breaking a large, complex problem into smaller, more manageable sub-
problems or tasks. 
Purpose: Makes understanding, analyzing, and solving the problem significantly easier. It simplifies 
the overall task and allows for focused work on individual parts. 
Examples: 

• Everyday: Building a birdhouse can be decomposed into: designing, gathering materials, cutting 
wood, assembling, painting, and installing. Preparing a meal involves steps like deciding the menu, 
gathering ingredients, cooking, and serving. 

• Software: Building a mobile app is decomposed into designing the user interface, coding features 
(login, navigation), and implementing data storage. 

• Robotics: Solving a maze problem for a robot can be broken down into: determining the maze size, 
defining start/end points, identifying allowed moves, and recognizing dead ends. 

Pattern Recognition 
Definition: Identifying similarities, trends, or regularities within data or across different problems. 
Purpose: Allows for the reuse and adaptation of known solutions, increasing efficiency and helping in 
predicting or generalizing solutions. 
Examples: 

• Mathematics: Observing that the area of squares (1, 4, 9, 16, 25…) follows the pattern of adding 
consecutive odd numbers (1, 1+3, 1+3+5, etc.). 

• Behavioral: Noticing you often forget homework on Mondays establishes a pattern, leading to a 
solution like setting a Sunday reminder. 

• Data Analysis: Analyzing website traffic to identify which pages users visit most frequently or 
common navigation paths they follow. 

Abstraction 
Definition: The process of filtering out irrelevant details and focusing only on the essential 
information needed to solve the problem. It involves creating a general model. 
Purpose: Reduces complexity by hiding unnecessary details, allowing one to work with a simplified 

Chapter 14 
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1 1 3 3 1 ≤ 3, no change. 

2 4 3 4 4 > 3, update max. 

... ... ... ... ... 

End – – 9 Final result returned. 

Algorithm Evaluation Parameters 
1. Correctness: Must produce the right output for all valid inputs (verified via testing). 
2. Clarity: How easily the logic can be understood (aided by descriptive names, structure, comments). 
3. Efficiency: How well it uses time (Time Complexity) and memory (Space Complexity). Measured in 

Big O notation (O(n), O(log n), O(n²)). 
o Example (Prime Check): Dividing by numbers up to √n is more efficient than up to n-1. 
4. Reliability: Ability to consistently produce correct results across multiple executions. 

Simulation and LARP 
• Simulation: Using a computer program to model a real-world process (e.g., weather forecasting, 

traffic flow) for safe, cost-effective testing. 
• LARP (Logic of Algorithms for Resolution of Problems): Educational software that provides an 

interactive environment to write, execute, and debug algorithms using simple syntax, helping visualize 
logic. 

Standard Algorithms 
Sorting Algorithms 
Process of arranging data in order (ascending/descending). 

Algorithm Key Idea & Working When to Use / Note 

Bubble 
Sort 

Repeatedly compares adjacent elements 
and swaps them if in wrong order. Largest 
element "bubbles up" per pass. 

Small datasets, educational. 
Simple but inefficient for large 
lists. 

Insertion 
Sort 

Builds sorted list one element at a time 
by inserting each new element into its 
correct position in the sorted part. 

Small or nearly sorted datasets. 
Efficient for small lists. 

Selection 
Sort 

Divides list 
into sorted and unsorted parts. 
Repeatedly finds min/max from unsorted 
part and swaps it with the first unsorted 
element. 

Small datasets, when 
minimizing swaps (memory 
writes) is a concern. 
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One Liners: Computational Thinking and Algorithm 
1. Computational Thinking is a structured problem-solving methodology inspired by computer science 

but applicable to all fields. 

2. The four fundamental pillars of Computational Thinking are Decomposition, Pattern Recognition, 

Abstraction, and Algorithmic Design. 

3. Decomposition is the process of breaking a large, complex problem into smaller, more manageable 

sub-problems. 

4. Pattern Recognition involves identifying similarities, trends, or regularities within data or across 

different problems. 

5. Abstraction is the process of filtering out irrelevant details to focus only on the essential information 

needed to solve a problem. 

6. Algorithmic Design is the creation of a finite, precise, step-by-step sequence of instructions to solve a 

specific problem. 

7. A core guiding principle of CT is Problem Understanding, the thorough analysis of a problem to define 

requirements and constraints. 

8. The Problem-Solving Process involves: Identify, Define, Analyze, Plan, Test, and Select the best 

solution. 

9. The Input-Process-Output (IPO) model is the fundamental structure for any computational solution. 

10. An IPO Chart is a simple tabular tool used to visually plan a solution based on Input, Process, and 

Output. 

11. A Simple Problem has a clear cause and straightforward solution, requiring fewer resources. 

12. A Complex Problem has multiple interconnected causes, requires significant resources, and may have 

no guaranteed solution. 

13. A Decision Problem is one where the solution is a binary "yes-or-no" (true/false) answer for a given 

input. 

14. A Search Problem involves finding a specific item, path, or configuration that satisfies given criteria 

from a set of possibilities. 
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a) Input, Program, Outcome 
b) Instruction, Process, Output 
c) Input, Process, Output 
d) Initialize, Process, Operate 
Answer: c) Input, Process, Output 

4. A problem that asks, "Is this number a 
prime?" is best categorized as a: 
a) Search Problem 
b) Counting Problem 
c) Decision Problem 
d) Optimization Problem 
Answer: c) Decision Problem 

5. If you have 5 different shirts and 4 different 
pairs of pants, and you want to find the total 
number of possible outfits (one shirt + one 
pant), you must apply the: 
a) Addition Principle 
b) Subtraction Principle 
c) Multiplication Principle 
d) Division Principle 
Answer: c) Multiplication Principle 

6. The formula nCr = n! / (r!(n-r)!) is used to 
calculate: 
a) The number of permutations of *r* items 
from *n* 
b) The number of combinations of *r* items 
from *n* 
c) The number of ways to arrange *n* items 
in a line 
d) The sum of all possible selections 
Answer: b) The number of combinations 
of *r* items from *n* 

7. The Pigeonhole Principle guarantees that if 
you have 15 students and only 12 lockers, 
then: 
a) Every locker will be used. 
b) At least one locker will be empty. 
c) At least one locker will contain more than 
one item. 
d) The number of lockers must be increased. 
Answer: c) At least one locker will contain 
more than one item. 

8. Which characteristic of a good algorithm 
explicitly requires that it must stop after a 
finite number of steps? 
a) Definiteness 
b) Finiteness 

c) Feasibility 
d) Generality 
Answer: b) Finiteness 

9. An algorithm that solves a problem by 
dividing it into independent sub-problems, 
solving each, and combining their results is 
using which approach? 
a) Brute Force 
b) Recursive 
c) Divide and Conquer 
d) Randomized 
Answer: c) Divide and Conquer 

10. In a flowchart, the symbol used to represent a 
conditional branch in the logic flow is a: 
a) Rectangle 
b) Parallelogram 
c) Diamond 
d) Oval 
Answer: c) Diamond 

11. The primary advantage of using pseudocode 
over a flowchart for algorithm design is: 
a) It provides a visual representation. 
b) It is easier to write and modify for 
complex logic. 
c) It uses standardized graphical symbols. 
d) It can be directly executed by a computer. 
Answer: b) It is easier to write and modify 
for complex logic. 

12. A manual, step-by-step execution of an 
algorithm using sample data to check for 
logical errors before coding is known as a: 
a) Simulation 
b) Dry Run 
c) Compilation 
d) Validation 
Answer: b) Dry Run 

13. Which algorithm evaluation parameter is 
concerned with how well an algorithm uses 
time and memory resources? 
a) Correctness 
b) Clarity 
c) Efficiency 
d) Reliability 
Answer: c) Efficiency 

14. The sorting algorithm that works by 
repeatedly comparing adjacent elements and 
swapping them if they are in the wrong order 
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Programming Fundamentals 
The Foundations of Computing & Programming 
Introduction to Computing & Binary 
Computers are universal machines that process information. At their most fundamental level, they 
operate on two states: ON and OFF, represented by the numbers 1 and 0. This binary foundation 
underpins all digital computing. 
Information Representation: The Binary System 
Everything a computer processes—text, images, sound, and programs—is ultimately represented as 
numbers using the binary number system, which has a base of 2 and uses only two digits: 0 and 1. 

• Bit: The smallest unit of data, short for Binary Digit. A single bit holds a value of either 0 or 1. 
• Byte: A group of 8 bits. It is the standard unit for measuring data size. 
• Larger Units: Data storage scales up using binary multiples (based on 1024, which is 2¹⁰): 
o 1 Kilobyte (KB) = 1024 Bytes 
o 1 Megabyte (MB) = 1024 KB 
o 1 Gigabyte (GB) = 1024 MB 
o 1 Terabyte (TB) = 1024 GB 

This system was formally refined by Gottfried Leibniz. Inside a computer, bits are represented by the 
state of electronic switches (open/closed) or electrical signals (off/on) in components like the CPU and 
RAM. 
Binary vs. Decimal Number Systems 

Feature Decimal System (Base-10) Binary System (Base-2) 
Base 10 2 
Digits Used 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 0, 1 
Place Value Powers of 10 (..., 1000, 100, 10, 1) Powers of 2 (..., 8, 4, 2, 1) 
Smallest Unit Digit Bit (Binary Digit) 
Example 1980 = 

(1x1000)+(9x100)+(8x10)+(0x1) 
1010₂ = (1x8)+(0x4)+(1x2)+(0x1) = 
10₁₀ 

Notation Written as 45 or 45₁₀ Written with a subscript, e.g., 110₂ 
In a binary number, the leftmost bit is the Most Significant Bit (MSB) and the rightmost bit is 
the Least Significant Bit (LSB). 
Number System Conversion 
Binary to Decimal Conversion: Use the positional notation method. Multiply each bit by 2 raised to 
the power of its position (starting from 0 on the right) and sum the results. 
Example: 101101₂ = (1x2⁵)+(0x2⁴)+(1x2³)+(1x2²)+(0x2¹)+(1x2⁰) = 32+0+8+4+0+1 = 45₁₀. 
Decimal to Binary Conversion: Use the repeated division-by-2 method. 

1. Divide the decimal number by 2. 
2. Write down the remainder (0 or 1). 
3. Use the quotient as the new number. 
4. Repeat steps 1-3 until the quotient is 0. 
5. The binary number is the sequence of remainders read from the last to the first. 

Example: Convert 172₁₀. 
172 ÷ 2 = 86 R 0 
86 ÷ 2 = 43 R 0 
43 ÷ 2 = 21 R 1 
21 ÷ 2 = 10 R 1 

Chapter 15 
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<html lang="en"> 
<head> 
    <title>Page Title</title> 
</head> 
<body> 
    <!-- Visible content --> 
</body> 
</html> 
Essential Tags: 

• Headings: <h1> to <h6>. 
• Paragraph & Line Break: <p>, <br>. 
• Text Formatting: <b>, <i>, <u>, <sup>, <sub>. 
• Grouping: <div> (block), <span> (inline). 
• Image: <img src="image.jpg" alt="Description">. 
• Lists: <ul>, <ol> with <li>. 
• Links: <a href="https://example.com">Link Text</a>. 
• Video: <video controls><source src="clip.mp4"></video>. 

HTML Forms: Collect user input using <form>. 
html 
<form action="/submit" method="POST"> 
    <label for="name">Name:</label> 
    <input type="text" id="name" name="name"><br> 
    <input type="radio" id="male" name="gender" value="male"> 
    <label for="male">Male</label><br> 
    <input type="submit" value="Submit"> 
</form> 
HTML Tables: Organize data. 
html 
<table> 
  <tr><th>Name</th><th>Class</th></tr> 
  <tr><td>Alia</td><td>9</td></tr> 
</table> 
Cascading Style Sheets (CSS) 
Controls presentation, layout, and styling, separating content from design. 
Ways to Use CSS: 

1. Inline: Within an HTML tag using style. 
2. Internal (Embedded): Within a <style> tag in the <head>. 
3. External: In a separate .css file linked via <link rel="stylesheet" href="styles.css">. 

Priority: Inline > Internal > External. 
Common Properties: 
css 
p { 
    color: blue; 
    font-size: 16px; 
    text-align: center; 
    background-color: #f2f2f2; 
    padding: 10px; 
    margin: 20px; 
    border: 1px solid black; 
} 



 

  MK PREPARATIONS  

 
 

P a g e  10 | 18 

 

  

1
5

. P
ro

g
ra

m
in

g
 F

u
n

d
a

m
e

n
ta

ls 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

One Liners: Programing Fundamentals 
1. At its core, a computer processes information using two states: ON (1) and OFF (0). 
2. The binary number system has a base of 2 and uses only the digits 0 and 1. 
3. A Bit (Binary Digit) is the smallest unit of data, holding a value of either 0 or 1. 
4. A Byte is a group of 8 bits and is the standard unit for measuring data size. 
5. Data storage scales using binary multiples: 1 Kilobyte (KB) = 1024 Bytes. 
6. In a binary number, the leftmost bit is the Most Significant Bit (MSB) and the rightmost is the Least 

Significant Bit (LSB). 
7. To convert binary to decimal, use positional notation: multiply each bit by 2 raised to its position 

power and sum the results. 
8. To convert decimal to binary, use the repeated division-by-2 method and read the remainders from 

the last to the first. 
9. ASCII is an 8-bit code representing 128 characters, where 'a' = 01100001₂ (97₁₀). 
10. Unicode is an extended system capable of representing over 65,000 characters from many world 

languages. 
11. In the RGB color model, each color component (Red, Green, Blue) is represented by an 8-bit 

number (0-255). 
12. White in RGB is represented as (255,255,255) or (11111111, 11111111, 11111111)₂. 
13. Sound is converted from analogue to digital using an Analogue-to-Digital Converter (ADC). 
14. The quality of digital sound is determined by Sample Rate (samples per second) and Bit Depth (bits 

per sample). 
15. Problem analysis involves clearly defining the problem, identifying causes, and brainstorming 

solutions. 
16. Solution planning techniques include Abstraction, Divide and Conquer, Analogy, Brainstorming, 

and Research. 
17. The best solution is evaluated based on Speed/Time Efficiency, Cost (resources, memory), and 

Complexity (number of steps). 
18. An algorithm is a well-defined, step-by-step procedure that takes input, processes it, and produces 

an output. 
19. Algorithm efficiency is measured by Time Complexity (execution speed) and Space Complexity 

(memory usage). 
20. A flowchart is a diagrammatic representation of an algorithm using standardized symbols. 
21. In a flowchart, an Oval represents the Start or End terminal. 
22. In a flowchart, a Parallelogram represents an Input or Output operation. 
23. In a flowchart, a Rectangle represents a Process or calculation step. 
24. In a flowchart, a Diamond represents a Decision point (Yes/No, True/False). 
25. Before drawing a flowchart, determine the problem's inputs, processing, decisions, and outputs. 
26. A Program is a set of ordered instructions telling a computer how to perform a specific task. 
27. The concept of a stored program in memory was pioneered by John von Neumann. 
28. Software is a collection of many programs bundled together for a larger task (e.g., Microsoft Paint). 
29. Programming is the process of designing, writing, testing, and maintaining source code. 
30. Machine Language is the computer's native language of 1s and 0s; it is machine-dependent and 

difficult for humans. 
31. Assembly Language uses simple abbreviations (mnemonics) and requires an assembler. 
32. High-Level Languages (e.g., Python, C++) use English-like syntax and require a compiler or 

interpreter. 
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Practice MCQs
1. Which of the following correctly defines the 

relationship between a bit and a byte? 
a) A bit is a group of 8 bytes. 
b) A byte is a group of 8 bits. 
c) A bit represents a decimal digit, while a 
byte represents a binary digit. 
d) A byte is always 1024 bits. 
Answer: b) A byte is a group of 8 bits. 

2. In the binary number 1101, the weight of the 
digit '1' in the leftmost position (assuming 
positions start at 0 from the right) is: 
a) 2^0 
b) 2^1 
c) 2^2 
d) 2^3 
Answer: d) 2^3 

3. Using the repeated division-by-2 method, the 
binary representation of the decimal number 
29 is: 
a) 11100 
b) 11101 
c) 11011 
d) 10111 
Answer: b) 11101 

4. In the RGB color model, the binary 
representation for the color Red (255, 0, 0) 
would be: 
a) (11111111, 00000000, 00000000) 
b) (00000000, 11111111, 00000000) 
c) (00000000, 00000000, 11111111) 
d) (11111111, 11111111, 11111111) 
Answer: a) (11111111, 00000000, 
00000000) 

5. When planning a software solution, the 
technique of creating a simplified model to 
focus on essential details is known as: 
a) Decomposition 
b) Pattern Recognition 
c) Abstraction 
d) Algorithmic Design 
Answer: c) Abstraction 

6. The primary purpose of a flowchart's 
diamond-shaped symbol is to represent a: 
a) Start or End point 
b) Input or Output operation 
c) Calculation or Process step 

d) Decision or Conditional branch 
Answer: d) Decision or Conditional 
branch 

7. The von Neumann architecture is most 
famous for introducing the concept of: 
a) Binary number system 
b) Stored-program computers 
c) Graphical user interfaces 
d) Object-oriented programming 
Answer: b) Stored-program computers 

8. A program that translates assembly language 
mnemonics into machine code is called a(n): 
a) Compiler 
b) Interpreter 
c) Assembler 
d) Linker 
Answer: c) Assembler 

9. In programming, a construct that allows a 
block of code to be executed repeatedly as 
long as a condition remains true is a: 
a) Sequence 
b) Selection 
c) Loop (Repetition) 
d) Event 
Answer: c) Loop (Repetition) 

10. In Scratch, a variable declared as "for this 
sprite only" has what kind of scope? 
a) Global scope 
b) Local scope 
c) Static scope 
d) Dynamic scope 
Answer: b) Local scope 

11. Which Python operator performs integer 
(floor) division? 
a) / 
b) // 
c) % 
d) ** 
Answer: b) // 

12. The Python code for i in range(5, 0, -1): 
print(i) will output: 
a) 0 1 2 3 4 
b) 1 2 3 4 5 
c) 5 4 3 2 1 
d) 5 4 3 2 1 0 
Answer: c) 5 4 3 2 1 
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Programming Fundamentals & Core Concepts (C /C++) 
Introduction to Computing and Binary Representation 
At the heart of all modern computing lies a simple yet profound idea: information can be represented and 
manipulated using only two states—ON and OFF, symbolized by the digits 1 and 0. This binary system is the 
fundamental language of computers. 
Key Concepts: 

• Bit (Binary Digit): The smallest unit of data. A single bit holds either a 0 or a 1. 
• Byte: A group of 8 bits. It is the standard unit for measuring data size (e.g., a single character 
often occupies one byte). 
• Data Storage Units: Memory and storage scale using binary multiples (powers of 2): 

o 1 Kilobyte (KB) = 1024 Bytes 
o 1 Megabyte (MB) = 1024 KB 
o 1 Gigabyte (GB) = 1024 MB 
o 1 Terabyte (TB) = 1024 GB 

Inside a computer, these bits are physically represented by the state of electronic components—such as 
transistors being open or closed, or capacitors being charged or discharged. This binary foundation, formalized 
by Gottfried Leibniz, enables the representation of all forms of data: numbers, text, images, and sound. 
Binary vs. Decimal Number Systems 

Feature Decimal System (Base-10) Binary System (Base-2) 
Base 10 2 
Digits Used 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 0, 1 
Place Value Powers of 10 (…, 1000, 100, 10, 1) Powers of 2 (…, 8, 4, 2, 1) 
Smallest Unit Digit Bit 

Example 1980 = (1×1000)+(9×100)+(8×10)+(0×1) 1010₂ = (1×8)+(0×4)+(1×2)+(0×1) = 
10₁₀ 

Notation Written as 45 or 45₁₀ Written with subscript, e.g., 110₂ 
In a binary number, the leftmost bit is the Most Significant Bit (MSB) (highest value), and the rightmost is 
the Least Significant Bit (LSB). 
Number System Conversion 
Binary to Decimal: 
Use the positional notation method. Multiply each bit by 2 raised to the power of its position (starting from 0 
on the right) and sum the results. 
Example: 101101₂ = (1×2⁵)+(0×2⁴)+(1×2³)+(1×2²)+(0×2¹)+(1×2⁰) = 32+0+8+4+0+1 = 45₁₀. 
Decimal to Binary: 
Use the repeated division-by-2 method. 

1. Divide the decimal number by 2. 
2. Write down the remainder (0 or 1). 
3. Use the quotient as the new number. 
4. Repeat until the quotient is 0. 
5. The binary equivalent is the sequence of remainders read from the last to the first. 
Example: Convert 172₁₀ to binary. 

172 ÷ 2 = 86 R 0 
86 ÷ 2 = 43 R 0 
43 ÷ 2 = 21 R 1 
21 ÷ 2 = 10 R 1 
10 ÷ 2 = 5 R 0 
5 ÷ 2 = 2 R 1 
2 ÷ 2 = 1 R 0 
1 ÷ 2 = 0 R 1 

Chapter 16 
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Warning: A very common error is using the assignment operator = instead of the equality operator == in 
conditions. if (x = 5) assigns 5 to x and is always true (since 5 is non-zero), while if (x == 5) correctly 
checks for equality. 
Logical Operators 
Used to combine or modify relational expressions (conditions). They operate on Boolean values (true/non-
zero or false/zero). 

Operator Name Description Example (T=1, 
F=0) Result 

&& Logical 
AND True only if both conditions are true. (5<10) && 

(2>1) 
1 && 1 = 

1 

|| Logical OR True if at least one condition is true. (5>10) || 
(2>1) 0 || 1 = 1 

! Logical 
NOT 

Reverses the truth value (true becomes 
false). !(5>10) !0 = 1 

Short-Circuit Evaluation: In expr1 && expr2, if expr1 is false, expr2 is not evaluated (the result is 
already false). In expr1 || expr2, if expr1 is true, expr2 is not evaluated. This can be used for efficiency 
and safety (e.g., (ptr != NULL) && (ptr->data > 0)). 
Assignment Operator (=) 
Stores the value of the right-hand expression into the variable on the left. 

• Syntax: variable = expression; 
• Example: area = length * width; 
• The assignment operator returns the value assigned. This allows chained assignment: a = b 
= c = 5; (all get the value 5). 

Increment (++) and Decrement (--) Operators 
Unary operators that increase or decrease the value of a variable by 1. They can be used 
in prefix or postfix form, which affects when the increment/decrement happens relative to the value being 
used in an expression. 

• Prefix (e.g., ++x, --y): The increment/decrement happens first, and then the new value is 
used in the expression. 
• Postfix (e.g., x++, y--): The current value is used in the expression first, and then the 
variable is incremented/decremented. 

Operation Expression Value of i After Value of j After 
j = ++i Prefix i increments, then assigned to j. j gets the new value of i. 
j = i++ Postfix i assigned to j, then increments. j gets the old value of i. 

Example: If i = 5 initially: 
• j = ++i; → i becomes 6, j becomes 6. 
• j = i++; → j is assigned 5, then i becomes 6. 

Important: Avoid using the same variable multiple times in an expression with increment/decrement 
operators (e.g., x = x++ + ++x;). The behavior is undefined in C because the order of evaluation of side 
effects is not specified. 
Compound Assignment Operators 
Combine an arithmetic or bitwise operation with assignment. 

Operator Example Equivalent To 
+= a += 5; a = a + 5; 
-= a -= 3; a = a - 3; 
*= a *= 2; a = a * 2; 
/= a /= 4; a = a / 4; 
%= a %= 3; a = a % 3; 

These operators are concise and can sometimes lead to more efficient machine code. 
Conditional (Ternary) Operator (? :) 
A shorthand for a simple if-else statement. It is the only ternary operator in C (takes three operands). 
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• for (i = 1; ; i++) // Infinite loop if no break inside. 
• for (;;) // Infinite loop. 

Example: Sum of first N natural numbers. 
c 
int n, sum = 0; 
printf("Enter a positive integer: "); 
scanf("%d", &n); 
 
for (int i = 1; i <= n; ++i) { 
    sum += i; 
} 
printf("Sum = %d\n", sum); 
Nested Loops 
A loop placed inside the body of another loop. The inner loop completes all its iterations for each single 
iteration of the outer loop. 
Use Cases: Printing patterns (triangles, rectangles), working with 2D arrays/matrices, simulations (e.g., 
generating combinations). 
Example: Printing a right-angled triangle of stars. 
c 
for (int row = 1; row <= 5; row++) {       // Outer loop (controls rows) 
    for (int col = 1; col <= row; col++) { // Inner loop (controls stars per row) 
        printf("*"); 
    } 
    printf("\n"); // New line after each row 
} 
/* Output: 
* 
** 
*** 
**** 
***** 
*/ 
Example: Multiplication Table (1 to 5). 
c 
for (int i = 1; i <= 5; i++) { 
    for (int j = 1; j <= 10; j++) { 
        printf("%d x %d = %d\n", i, j, i * j); 
    } 
    printf("\n"); // Blank line between tables 
} 
Sentinel-Controlled Loops 
Used when the number of data items is unknown. A special sentinel value (an end marker that is not valid 
data) signals the termination of input. 
General Pattern (using while): 
c 
get the first data item; 
while (data item is not the sentinel value) { 
    process the data item; 
    get the next data item; 
} 
*Example: Calculating average marks. Sentinel = -1.* 
c 
int marks, sum = 0, count = 0; 
printf("Enter marks (-1 to stop): "); 
scanf("%d", &marks); 
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c 
#include <stdio.h> 
#include <string.h> 
 
int main() { 
    char name[50]; 
     
    // Unsafe method (doesn't limit input) 
    printf("Enter your name: "); 
    scanf("%s", name); // Stops at whitespace 
     
    // Safer method 
    printf("Enter your full name: "); 
    fgets(name, sizeof(name), stdin); // Reads entire line including spaces 
     
    // Output 
    printf("Hello, %s\n", name); 
     
    return 0; 
} 
Common String Functions (string.h): 
c 
#include <string.h> 
 
char str1[20] = "Hello"; 
char str2[20] = "World"; 
char str3[40]; 
char str4[] = "Hello, World!"; 
 
// strlen(): Get string length (excluding '\0') 
int len = strlen(str1); // len = 5 
 
// strcpy(): Copy string 
strcpy(str3, str1); // str3 = "Hello" 
 
// strcat(): Concatenate strings 
strcat(str1, " ");    // str1 = "Hello " 
strcat(str1, str2);   // str1 = "Hello World" 
 
// strcmp(): Compare strings 
int result = strcmp("apple", "banana"); // Negative (apple < banana) 
result = strcmp("apple", "apple");      // 0 (equal) 
result = strcmp("banana", "apple");     // Positive (banana > apple) 
 
// strncpy(), strncat(), strncmp(): Safer versions with length limit 
char dest[10]; 
strncpy(dest, "Hello, World!", 9); 
dest[9] = '\0'; // Ensure null-termination 
 
// strstr(): Find substring 
char *ptr = strstr(str4, "World"); // Returns pointer to "World" in str4 
if (ptr != NULL) { 
    printf("Found at position: %ld\n", ptr - str4); 
} 
 
// strchr(): Find first occurrence of character 
char *ch_ptr = strchr(str4, 'W'); // Returns pointer to 'W' 
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One Liners: Programing Fundamentals & Coe Concepts 
Programming Fundamentals & Binary System 
1. The binary number system uses only two digits: 0 and 1, representing the OFF and ON states of a 

computer. 
2. A bit (Binary Digit) is the smallest unit of data, storing either 0 or 1. 
3. Eight bits form one byte, which is the standard unit for measuring data size. 
4. Memory scales using binary multiples: 1 KB = 1024 bytes, 1 MB = 1024 KB, 1 GB = 1024 MB. 
5. The leftmost bit in a binary number is the Most Significant Bit (MSB), and the rightmost is the Least 

Significant Bit (LSB). 
6. Binary to decimal conversion uses positional notation: each bit is multiplied by 2 raised to its position 

power. 
7. Decimal to binary conversion uses the repeated division-by-2 method, reading remainders from last to 

first. 
8. ASCII is an 8-bit character encoding standard representing 128 characters, with 'A' = 65 and 'a' = 97. 
9. Unicode extends ASCII to support over 65,000 characters from multiple writing systems worldwide. 
10. In the RGB color model, each color component (Red, Green, Blue) is represented by an 8-bit value 

from 0 to 255. 
11. White in RGB is (255,255,255) or binary 11111111 for each component. 
12. Digital sound conversion uses an Analogue-to-Digital Converter (ADC), with quality determined by 

sample rate and bit depth. 
13. Problem analysis involves defining the problem clearly, identifying causes, and brainstorming 

solutions. 
14. Abstraction in problem-solving means creating a simplified model focusing only on essential details. 
15. Divide and conquer breaks complex problems into smaller, more manageable sub-problems. 
16. An algorithm is a finite, step-by-step procedure that takes input, processes it, and produces output. 
17. Algorithm efficiency is measured by time complexity (execution speed) and space complexity 

(memory usage). 
18. A flowchart's diamond shape represents a decision point with yes/no or true/false branches. 
19. The parallelogram in a flowchart denotes input/output operations. 
20. John von Neumann pioneered the stored-program concept where both instructions and data reside in 

memory. 
21. Software is a collection of multiple programs bundled together for a comprehensive task. 
22. Machine language (1GL) consists of binary code (0s and 1s) executed directly by the CPU. 
23. Assembly language (2GL) uses mnemonics like ADD and MOV, requiring an assembler for 

translation. 
24. High-level languages (3GL) like C and Python use English-like syntax and are machine-independent. 
25. Procedural languages design programs as sequences of procedures operating on data. 
26. Object-oriented languages model programs as collections of interacting objects. 
27. A compiler translates the entire source program into machine code in one go. 
28. An interpreter translates and executes code line by line, stopping at errors. 
29. The five fundamental programming constructs are sequence, selection, repetition, events, and 

variables/constants. 
30. Syntax errors violate language grammar rules and prevent program execution. 
31. Logical errors allow programs to run but produce incorrect results due to flawed logic. 
32. In Scratch, variables can be "for this sprite only" (local) or "for all sprites" (global). 
33. Scratch's forever block creates an infinite loop, while repeat [n] executes a block n times. 
34. Python uses dynamic typing where variable types are inferred from assigned values. 
35. Python's input() function reads strings, requiring explicit conversion (e.g., int()) for numeric input. 
36. The // operator in Python performs floor division, returning the integer quotient. 
37. Python lists are ordered, mutable collections accessed via zero-based indexing. 
38. The append() method adds an element to the end of a Python list. 
39. A webpage is a single HTML document, while a website is a collection of related webpages. 
40. A web server hosts websites and serves requested pages to client browsers. 
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Practice MCQs
 

1. In the binary number 110101, what is 
the decimal value of the most significant bit? 
a) 1 
b) 16 
c) 32 
d) 64 
Answer: c) 32 
2. When converting decimal 45 to binary 
using repeated division-by-2, what is the 
sequence of remainders read from last to 
first? 
a) 101101 
b) 1011011 
c) 1011010 
d) 101101 
Answer: a) 101101 
3. Which statement about ASCII encoding 
is INCORRECT? 
a) It uses 8 bits per character 
b) It represents 256 different characters 
c) 'a' has decimal value 97 
d) Uppercase letters come before lowercase in 
value 
Answer: b) It represents 256 different 
characters 
4. In the RGB color model, what is the 
binary representation for pure green? 
a) 00000000 11111111 00000000 
b) 11111111 00000000 00000000 
c) 00000000 00000000 11111111 
d) 11111111 11111111 00000000 
Answer: a) 00000000 11111111 00000000 
5. Which problem-solving technique 
involves ignoring unnecessary details to 
focus on the core model? 
a) Decomposition 
b) Pattern Recognition 
c) Abstraction 
d) Algorithmic Design 
Answer: c) Abstraction 
6. What is the primary purpose of a 
flowchart's diamond-shaped symbol? 
a) Start/End point 
b) Input/Output operation 
c) Process/Calculation step 
d) Decision/Conditional branch 
Answer: d) Decision/Conditional branch 
7. The von Neumann architecture is 
revolutionary because it introduced: 
a) Binary number system 
b) Stored-program concept 

c) Graphical user interface 
d) Object-oriented programming 
Answer: b) Stored-program concept 
8. Which translator executes source code 
line by line and stops at the first error 
encountered? 
a) Compiler 
b) Assembler 
c) Interpreter 
d) Linker 
Answer: c) Interpreter 
9. A program runs but produces incorrect 
output. This is most likely a: 
a) Syntax error 
b) Semantic error 
c) Logical error 
d) Runtime error 
Answer: c) Logical error 
10. In Scratch, a variable declared as "for 
this sprite only" has: 
a) Global scope 
b) Local scope 
c) Static scope 
d) Dynamic scope 
Answer: b) Local scope 
11. What will be the output of Python code: 
print(7 // 2)? 
a) 3.5 
b) 3 
c) 4 
d) 3.0 
Answer: b) 3 
12. The Python range(5, 0, -2) generates: 
a) 5, 3, 1 
b) 5, 4, 3, 2, 1 
c) 0, 1, 2, 3, 4 
d) 5, 4, 3, 2, 1, 0 
Answer: a) 5, 3, 1 
13. Which Python method correctly adds 
'cherry' to the end of a list named fruits? 
a) fruits.add('cherry') 
b) fruits.append('cherry') 
c) fruits.insert('cherry') 
d) fruits.push('cherry') 
Answer: b) fruits.append('cherry') 
14. A website that changes content based on 
user input without reloading the page is best 
described as: 
a) A static website 
b) A responsive website 
c) A dynamic website 



  MK PREPARATIONS  

 

P a g e  1 | 29 

 

  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

1
7

. W
e

b
 D

e
v

e
lo

p
m

e
n

t &
 W

e
b

 P
ro

g
ra

m
in

g
 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Web Development & Web Programming 
Introduction to the World Wide Web and Web Development 
The World Wide Web (WWW) 
The World Wide Web (WWW, W3, or Web) is a graphical information system introduced to the 

public on August 6, 1991, by Tim Berners-Lee. It is built on the Internet and allows documents to be 
connected via hypertext links, enabling users to navigate between them seamlessly. It is essential to 
distinguish the Web from the Internet: 

• Internet: The global network of interconnected computers and devices. 
• Web: A collection of interconnected documents (web pages) accessed via web browsers. 

The Web operates on a client-server model, where browsers (clients) request resources from web 
servers, which respond with the requested content, typically in HTML format. 

What is Web Development? 
Web Development is the process of creating websites and web applications. It involves designing, 

building, and maintaining sites using a combination of programming languages, frameworks, and tools. Web 
development is broadly categorized into: 

1. Front-End Development: Concerned with what users see and interact with (user interface). 
2. Back-End Development: Deals with server-side logic, databases, and application functionality. 
3. Full-Stack Development: Combines both front-end and back-end expertise. 

1.3 Why Learn Web Development? 
• Digital Literacy: Understanding how websites are built and how the Internet works. 
• Career Opportunities: Opens roles such as Web Developer, UI/UX Designer, Front-End/Back-End 

Engineer, and Full-Stack Developer. 
• Problem-Solving Skills: Enhances logical thinking and debugging abilities. 
• Creativity: Allows the design of visually appealing and interactive interfaces. 
• Entrepreneurship: Enables the creation of online businesses, services, or digital products. 

Core Web Terminology 
Fundamental Concepts 

• Web Page: A document written in HTML and viewed in a browser, identified by a unique URL. It 
may contain text, images, audio, video, and hyperlinks. 

• Website: A collection of related web pages hosted on a web server and accessible via a unique 
address (URL). 

• Web Browser: Software used to retrieve, interpret, and display web content (e.g., Chrome, Firefox, 
Edge). 

• Web Server: A computer that stores, processes, and delivers web pages to clients 
using HTTP/HTTPS. Any computer can act as a server by installing server software (e.g., Apache, 
Nginx). 

• URL (Uniform Resource Locator): The unique address of a resource on the Internet. 
Format: protocol://hostname/path. Example: https://www.example.com/about. 

• Search Engine: A website that helps users find information by searching keywords (e.g., Google, 
Bing). 

• Home Page: The main or index page of a website, usually the first page accessed. 
• Web Hosting: A service that stores website files on a server connected to the Internet, making them 

accessible worldwide. 
Types of Websites 

1. Web Portals: Comprehensive sites offering multiple services (email, news, search) often requiring 
login (e.g., university portals). 

2. News Websites: Provide latest news, updates, videos, and archives (e.g., BBC, Tribune). 
3. Informational Websites: Offer detailed information on various topics (e.g., Wikipedia). 

Chapter 17 
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php 
<!DOCTYPE html> 
<html> 
<body> 
    <h1>My PHP Page</h1> 
    <?php 
        $name = "Ali"; 
        echo "<p>Hello, $name!</p>"; 
    ?> 
</body> 
</html> 
PHP Database Connection (MySQLi) 
php 
<?php 
$servername = "localhost"; 
$username = "root"; 
$password = ""; 
$dbname = "myDB"; 
 
$conn = mysqli_connect($servername, $username, $password, $dbname); 
 
if (!$conn) { 
    die("Connection failed: " . mysqli_connect_error()); 
} 
 
$sql = "SELECT id, name FROM users"; 
$result = mysqli_query($conn, $sql); 
 
while($row = mysqli_fetch_assoc($result)) { 
    echo "ID: " . $row["id"] . " - Name: " . $row["name"] . "<br>"; 
} 
 
mysqli_close($conn); 
?> 
Security Note: Always use prepared statements to prevent SQL injection. 
HTTP Protocol and Request-Response Cycle 
HTTP is a stateless application-layer protocol. 

• HTTP Request: Sent from browser to server. Contains method (GET, POST), headers, and optional 
body. 

• HTTP Response: Sent from server to browser. Contains status code (200 OK, 404 Not Found), 
headers, and body (HTML, JSON, etc.). 
 Advanced Web Concepts 
AJAX (Asynchronous JavaScript and XML) 
AJAX allows web pages to communicate with a server asynchronously without reloading. 
Example using fetch(): 
javascript 
fetch('get_data.php') 
    .then(response => response.json()) 
    .then(data => { 
        console.log(data); 
        // Update DOM with data 
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One Liners: We Development & Web Programing 
Web Fundamentals & Terminology (1-25) 

1. Tim Berners-Lee introduced the World Wide Web to the public on August 6, 1991. 
2. The Internet is the global network connecting computers, while the Web is the collection of 

interconnected documents accessed via browsers. 
3. A web page is an HTML document viewed in a browser and identified by a unique URL. 
4. A web server stores, processes, and delivers web pages using HTTP protocol. 
5. Any computer can become a web server by installing server software like Apache or Nginx. 
6. URL stands for Uniform Resource Locator and follows the format: 

protocol://hostname/other_information. 
7. The home page is the main or index page of a website that opens first when the site is accessed. 
8. Web hosting is the service of storing website content on a server connected to the Internet. 
9. Search engines like Google help users find information by searching keywords across the Web. 
10. Web portals are comprehensive websites offering multiple services like email and news, often 

requiring login. 
11. Front-end development focuses on what users see and interact with, using HTML, CSS, and 

JavaScript. 
12. Back-end development manages behind-the-scenes functionality like servers, databases, and 

application logic. 
13. Full-stack development involves both front-end and back-end aspects of web application 

development. 
14. Digital literacy through web development helps understand how websites are built and how the 

Internet works. 
15. Career opportunities in web development include roles like web developer, designer, and other IT 

industry positions. 
16. Web development enhances problem-solving skills through logical thinking and troubleshooting. 
17. Web development allows creativity by enabling the creation of visually appealing and interactive 

websites. 
18. Entrepreneurship skills are supported by web development through starting online businesses or web 

services. 
19. A web browser is software used to retrieve and display information from websites. 
20. HTTP (Hypertext Transfer Protocol) is used by web servers to deliver web pages to users' browsers. 
21. News websites provide the latest news, updates, and often include videos and archives. 
22. Informational websites like Wikipedia provide detailed information on various topics. 
23. Educational websites are created for learning, offering tutorials, courses, and organized educational 

content. 
24. Personal websites are created by individuals for expression, portfolio, or social networking. 
25. Business websites facilitate business activities like e-commerce, banking, and reservations. 

HTML Fundamentals (26-75) 
26. HTML (HyperText Markup Language) is the standard markup language for creating web pages. 
27. HTML 1.0 was the first, simple version released in 1991. 
28. HTML 2.0 introduced more tags for complex pages in 1995. 
29. HTML 3.2 added tags for tables, scripts, and applets in 1997. 
30. HTML 4.0/4.01 brought major improvements with support for multimedia in 1997/1999. 
31. HTML5 is the latest version with new elements for better multimedia, graphics, and interactivity, 

released in 2014. 
32. HTML files are saved with a .html extension, such as index.html. 
33. The basic structure of an HTML5 document starts with <!DOCTYPE html> declaration. 
34. The <html> tag is the root element of an HTML page. 
35. The <head> section contains meta-information like the page title and links to CSS/JavaScript. 
36. The <title> tag sets the title shown in the browser tab. 
37. The <body> tag contains the visible page content like headings, paragraphs, and images. 
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Practice MCQs
1. Which of the following correctly distinguishes 
between the Internet and the World Wide Web? 
A) The Internet is for emails, while the Web is for 
browsing 
B) The Internet is the global network of 
computers, while the Web is the collection of 
interconnected documents 
C) The Internet uses HTTP, while the Web uses 
FTP 
D) They are identical terms and can be used 
interchangeably 
Answer: B 
2. A web server's primary function is to: 
A) Write HTML and CSS code for websites 
B) Store, process, and deliver web pages using 
HTTP 
C) Design user interfaces for web applications 
D) Execute JavaScript code in the user's browser 
Answer: B 
3. What is the significance of August 6, 1991, in 
the context of web development? 
A) The day JavaScript was created by Brendan 
Eich 
B) The day the first web browser was released 
C) The day Tim Berners-Lee introduced the World 
Wide Web to the public 
D) The day HTML5 specification was finalized 
Answer: C 
4. Which type of website typically requires user 
login and offers multiple integrated services like 
email and news? 
A) News Website 
B) Web Portal 
C) Personal Website 
D) Entertainment Website 
Answer: B 
5. In the URL 
"https://www.example.com:443/path/page.html
", what does "443" represent? 
A) The page number in the website 
B) The version of HTTP being used 
C) The default port number for HTTPS 
D) An error code for secure connections 
Answer: C 
6. What is the primary purpose of web hosting? 
A) To write code for websites 
B) To design visual layouts 
C) To store website content on a server connected 
to the Internet 
D) To test websites across different browsers 
Answer: C 

7. Which HTML version first introduced 
support for tables and scripts? 
A) HTML 1.0 
B) HTML 2.0 
C) HTML 3.2 
D) HTML5 
Answer: C 
8. The <!DOCTYPE html> declaration at the 
beginning of an HTML document: 
A) Is optional in modern browsers 
B) Declares the document as HTML5 
C) Links an external CSS file 
D) Embeds JavaScript code 
Answer: B 
9. Which HTML tag pair is correctly used to 
define the title that appears in the browser tab? 
A) <header> ... </header> 
B) <title> ... </title> 
C) <h1> ... </h1> 
D) <caption> ... </caption> 
Answer: B 
10. What is the key difference between paired 
tags and unpaired tags in HTML? 
A) Paired tags have semantic meaning, while 
unpaired tags don't 
B) Paired tags require closing tags, while unpaired 
tags are self-closing 
C) Paired tags are for content, while unpaired tags 
are for styling 
D) Paired tags are HTML5 only, while unpaired 
tags are older HTML 
Answer: B 
11. Which heading tag represents the most 
important heading on a page? 
A) <h1> 
B) <h3> 
C) <h6> 
D) <header> 
Answer: A 
12. What is the purpose of the alt attribute in 
an <img> tag? 
A) To set the image alignment 
B) To provide alternative text for accessibility 
C) To define the image source URL 
D) To set the image border width 
Answer: B 
13. Which HTML entity would you use to insert 
a non-breaking space? 
A) &space; 
B)   
C) &break; 

https://www.example.com/path/page.html
https://www.example.com/path/page.html
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Data Base and Data Management (DBMS) 
Data and Database Fundamentals 
Data, Information, and Knowledge 
Data consists of raw facts and figures, such as numbers, words, measurements, observations, images, or 
sounds (e.g., daily temperature readings, list of student names and marks). Information is processed, 
organized, or structured data presented in a meaningful context (e.g., a weather forecast, student 
percentage and grade). Information is derived from data and is useful for decision-making. Knowledge is 
the actionable insight gained from understanding patterns in information. Data becomes information 
through processing, and information becomes knowledge through analysis and interpretation. 

Aspect Data Information 

Nature Raw, unprocessed facts Processed, organized, meaningful 
data 

Role in System Input to a computer system Output of data processing 

Usefulness May not be meaningful on its own Useful, valuable, supports 
decisions 

Reproducibility Difficult to reproduce if lost Easier to reproduce (e.g., 
recalculated) 

Dependence An independent entity Depends on data 
The Need for Databases: Evolution from File Systems 
Before databases, File Management Systems (FMS) were used. Data was stored in independent files, 
each a collection of records made up of fields. This approach led to significant problems: 

• Data Redundancy: The same data duplicated across multiple files. 
• Data Inconsistency: Changes in one file may not update others, leading to conflicting information. 
• Data-Program Dependence: Changes in data structure required changes to all related programs. 
• Data Isolation: Data scattered in various formats made retrieval difficult. 
• Integrity Problems: Ensuring data accuracy (e.g., account balance > 0) had to be programmed 

manually. 
• Atomicity Problems: Difficulty ensuring transactions (e.g., a funds transfer) completed as a whole. 
• Poor Data Security: No centralized security control; files were vulnerable. 
• Intensive Coding & Difficult Data Access: Separate programs were needed for each task, and 

retrieving information required extensive programming. 
What is a Database? 
A database is a shared, integrated, and logically related collection of data, along with a description of 
that data (metadata). It is designed to meet the information needs of multiple users in an organization. A 
key principle is that data in a database is independent of the application programs that use it. 
Database Management System (DBMS) 
A DBMS is a set of software programs that enables users to create, maintain, manipulate, and 
access a database. Manipulation includes adding, deleting, and changing data. Popular examples 
include Microsoft Access, Oracle, MySQL, Microsoft SQL Server, and IBM DB2. 
Advantages of DBMS over FMS: 

1. Controlled Data Redundancy: Data is stored logically only once. 
2. Data Consistency: Minimal redundancy ensures uniform data. 
3. Data Sharing: A centralized resource accessible by authorized users. 
4. Enforcement of Standards: Centralized control enforces naming, format, and structure standards. 
5. Enhanced Security: Permissions and access controls are centralized. 
6. Reduced Program Maintenance: DBMS tools simplify development. 

Chapter 18 
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93. Transitive Dependency is a functional dependency between two or more non-key attributes (e.g., 
CUSTNO → SALESMAN and SALESMAN → REGION). 

94. An Insertion Anomaly is the inability to add data without other, unrelated data. 
95. A Deletion Anomaly is the unintended loss of data when deleting a record. 
96. An Update Anomaly is inconsistency from updating some, but not all, copies of redundant data. 
97. Database personnel include End-Users, Data Administrators (DA), and Database Administrators 

(DBA). 
98. A Data Administrator (DA) is responsible for the organization's overall data resources, including 

planning and logical design. 
99. A Database Administrator (DBA) is the technical expert responsible for physical design, 

implementation, security, and maintenance. 
100. SQL (Structured Query Language) is the standard language for relational databases. 
101. Data Definition Language (DDL) commands (CREATE, ALTER, DROP) define database 

structure. 
102. Data Manipulation Language (DML) commands (SELECT, INSERT, UPDATE, DELETE) access 

and manipulate data. 
103. Data Control Language (DCL) commands (GRANT, REVOKE) control access. 
104. Views are virtual tables created using SQL (CREATE VIEW) that provide a customized, secure 

subset of data. 
105. Data Analytics examines raw data to draw conclusions, answer specific questions, and identify 

trends. 
106. Data Science is a broader, interdisciplinary field using mathematics, statistics, ML, and 

programming to extract knowledge from data. 
107. Qualitative (Categorical) Data includes Nominal (no inherent order) and Ordinal (meaningful order) 

data. 
108. Quantitative (Numerical) Data includes Discrete (countable) and Continuous (measurable within a 

range) data. 
109. Continuous data can be Interval (differences meaningful, no true zero) or Ratio (differences 

meaningful, has a true zero). 
110. Primary Data is collected firsthand (surveys, experiments, sensors). 
111. Secondary Data is collected by others (published sources, online databases). 
112. Relational (SQL) databases (e.g., MySQL, MS Access) are used for structured data. 
113. Non-Relational (NoSQL) databases (e.g., MongoDB) are used for semi/unstructured data. 
114. Artificial Intelligence (AI) refers to machines mimicking human intelligence (problem-solving, 

language understanding). 
115. Machine Learning (ML) is a subset of AI where systems learn from data without explicit 

programming. 
116. Supervised Learning uses labeled datasets (input-output pairs) for tasks like classification and 

regression. 
117. Unsupervised Learning finds patterns in unlabeled datasets for tasks like clustering and association. 
118. Reinforcement Learning involves an agent learning by interacting with an environment, receiving 

rewards/penalties. 
119. Feature Engineering is the process of selecting and transforming relevant data attributes for ML 

models. 
120. Training Data is used to teach an ML model; Test Data is used to evaluate it. 
121. Overfitting occurs when a model learns training data too well, including noise, and performs poorly 

on new data. 
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Practice MCQs
1. What is the primary difference between 
data and information? 
A) Data is processed; information is raw 
B) Data is meaningful on its own; information 
requires context 
C) Data is raw facts; information is processed 
data in context 
D) Data is output; information is input 
Answer: C) Data is raw facts; information 
is processed data in context 
2. Which of the following was a major 
problem with File Management Systems 
(FMS)? 
A) Program-Data Independence 
B) Controlled Data Redundancy 
C) Data Inconsistency 
D) Enhanced Security 
Answer: C) Data Inconsistency 
3. What is the key principle that data in a 
database is independent of the application 
programs called? 
A) Data Redundancy 
B) Program-Data Dependence 
C) Data Isolation 
D) Program-Data Independence 
Answer: D) Program-Data Independence 
4. Which database model allows a child 
record to have more than one parent? 
A) Hierarchical Model 
B) Network Model 
C) Relational Model 
D) Object-Oriented Model 
Answer: B) Network Model 
5. In the relational model, what is a two-
dimensional structure of rows and columns 
called? 
A) Attribute 
B) Tuple 
C) Relation/Table 
D) Key 
Answer: C) Relation/Table 
6. Which property of a relation states that 
each row must be unique? 
A) Column Atomicity 
B) Order Insignificance 
C) No Duplicate Rows 

D) NULL Allowed 
Answer: C) No Duplicate Rows 
7. What is a set of one or more attributes 
that can uniquely identify all other 
attributes in a relation called? 
A) Candidate Key 
B) Super Key 
C) Primary Key 
D) Foreign Key 
Answer: B) Super Key 
8. Which key must be unique and cannot 
contain NULL values? 
A) Foreign Key 
B) Alternate Key 
C) Secondary Key 
D) Primary Key 
Answer: D) Primary Key 
9. What does a Foreign Key (FK) enforce 
between tables? 
A) Entity Integrity 
B) Referential Integrity 
C) Column Atomicity 
D) Data Redundancy 
Answer: B) Referential Integrity 
10. In an ER diagram, what does a diamond 
represent? 
A) Entity 
B) Attribute 
C) Relationship 
D) Key 
Answer: C) Relationship 
11. What is the degree of a relationship 
called when it exists within the same entity? 
A) Binary 
B) Ternary 
C) Unary/Recursive 
D) Quaternary 
Answer: C) Unary/Recursive 
12. In a relationship, what does cardinality 
define? 
A) Minimum number of instances 
B) Maximum number of instances 
C) Type of attributes 
D) Number of entities 
Answer: B) Maximum number of instances 



  MK PREPARATIONS  

 

P a g e  1 | 39 

 

  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

1
9

. V
isu

a
l B

a
sic fo

r A
p

p
lica

tio
n

s &
 .N

E
T

 F
ra

m
e

w
o

rk
 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

Visual Basic for Applications (VBA) & .NET 
Framework 

Introduction to Visual Basic 
What is Visual Basic? 
Definition and Conceptual Overview 

Visual Basic (VB) is a high-level, third-generation programming language created by Microsoft. It was 
designed to simplify Windows application development by combining a visual, drag-and-drop interface 
builder with an intuitive programming language based on the original BASIC syntax. The name itself is 
descriptive: “Visual” refers to the visual method of designing user interfaces, and “Basic” stands 
for Beginner’s All-purpose Symbolic Instruction Code. 

Visual Basic follows the event-driven programming paradigm, meaning programs are structured 
around user actions such as mouse clicks, key presses, or system events. It also supports Rapid Application 
Development (RAD), allowing developers to quickly prototype and build applications using pre-built, 
reusable components. 

Detailed Characteristics 
1. High-Level Language 

VB uses English-like syntax, abstracting away low-level hardware details. This makes it accessible to 
beginners while remaining powerful enough for complex applications. 

2. Event-Driven Programming Model 
Programs are composed of event handlers—blocks of code that execute in response to specific user or 
system events. 

3. RAD Environment 
Developers can drag controls from a toolbox onto forms, set properties in a visual designer, and write 
code only for the events they need to handle. 

4. Hybrid Execution Model 
VB6 used a P-code interpreter, while VB.NET compiles to Microsoft Intermediate Language 
(MSIL), which is then Just-In-Time (JIT) compiled to native code. 
Historical Evolution and Context 
Visual Basic has evolved significantly since its introduction: 

• VB 1.0 (1991) 
Introduced the revolutionary drag-and-drop interface builder, eliminating the need for complex 
Windows API calls to create user interfaces. 

• VB 3.0 (1993) 
Added built-in database access via the Jet Engine, transforming VB into a serious tool for business 
application development. 

• VB 6.0 (1998) 
Became the most popular version, with enhanced web capabilities and widespread adoption in 
enterprise environments. It remains in use in many legacy systems. 

• VB.NET (2002) 
A complete rewrite for the .NET Framework, marking a shift from the COM-based architecture to the 
managed, object-oriented .NET platform. 
VB6 vs VB.NET: The Fundamental Shift 
Definition of the Shift 

VB6 was the final version based on the Component Object Model (COM), while VB.NET is the first .NET-
based version, built from the ground up to leverage the .NET Framework’s capabilities. 

Why the Shift Was Necessary 
1. Full Object-Oriented Support 

VB6 offered limited OOP features; VB.NET provides full inheritance, polymorphism, and 
encapsulation. 

Chapter 19 

https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
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Select Case Statement 
An efficient alternative to long If-ElseIf chains when testing a single variable against multiple discrete 
values. 

vb 
Select Case dayNumber 
    Case 1 : dayName = "Monday" 
    Case 2 : dayName = "Tuesday" 
    Case 3, 4, 5 : dayName = "Weekday" 
    Case 6 To 7 : dayName = "Weekend" 
    Case Is < 1, Is > 7 : dayName = "Invalid" 
    Case Else : dayName = "Unknown" 
End Select 
Looping Structures 
For Loop (Counter-Controlled) 
vb 
For i As Integer = 1 To 10 
    Console.WriteLine(i) 
Next 
 
' With step 
For i As Integer = 10 To 1 Step -1 
    Console.WriteLine(i)   ' Counts down 
Next 
 
' Nested For loops 
For row = 1 To 3 
    For col = 1 To 3 
        Console.Write($"[{row},{col}] ") 
    Next 
    Console.WriteLine() 
Next 
For Each Loop (Collection Iteration) 
vb 
Dim fruits() As String = {"Apple", "Banana", "Cherry"} 
For Each fruit As String In fruits 
    Console.WriteLine(fruit) 
Next 
Limitation: Cannot modify the collection during iteration. 
While Loop (Pre-Test) 
vb 
Dim count As Integer = 1 
While count <= 5 
    Console.WriteLine(count) 
    count += 1 
End While 
Do Loop (Flexible Structures) 
vb 
' Pre-test (0 or more executions) 
Do While x < 10 
    x += 1 
Loop 
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One Liners: Visual Basic for Applications & .NET Framework 
1. Visual Basic is a third-generation, high-level programming language that follows the event-driven 

paradigm and supports Rapid Application Development (RAD). 
2. The "Visual" in Visual Basic refers to the visual method of creating user interfaces through drag-and-

drop controls. 
3. The "Basic" in Visual Basic stands for Beginner's All-purpose Symbolic Instruction Code, indicating 

its roots in the BASIC language. 
4. Event-driven programming means programs respond to user actions like clicks, key presses, or system 

events rather than following a linear execution path. 
5. Rapid Application Development (RAD) in VB enables quick prototyping through reusable 

components and visual design tools. 
6. VB6 used P-code interpretation, while VB.NET uses full compilation to Microsoft Intermediate 

Language (MSIL). 
7. VB 1.0 (1991) revolutionized Windows programming by eliminating complex Windows API calls for 

UI creation through drag-and-drop interface building. 
8. VB 3.0 (1993) became a serious business application development tool after adding database access 

through the Jet Engine. 
9. VB 6.0 (1998) remains in use in legacy systems and represents the peak of COM-based Visual Basic 

development. 
10. VB.NET (2002) was a complete rewrite for the .NET Framework, shifting from COM to managed 

.NET architecture. 
11. The fundamental shift from VB6 to VB.NET was necessary because VB6 lacked full object-oriented 

programming support. 
12. .NET Framework offers cross-language compatibility, allowing VB.NET to interoperate seamlessly 

with C#, F#, and other .NET languages. 
13. .NET provides code access security, a significant improvement over VB6's limited security model. 
14. Automatic garbage collection in .NET eliminates manual memory management and prevents memory 

leaks common in VB6. 
15. VB6 uses Variant data type by default, allowing implicit type conversions that can cause runtime 

errors. 
16. VB.NET with Option Strict On requires explicit type conversions, preventing type-related bugs at 

compile time. 
17. VB6 uses unstructured error handling with On Error GoTo, which creates spaghetti code and makes 

program flow difficult to follow. 
18. VB.NET uses structured exception handling with Try-Catch-Finally blocks, providing readable error 

handling with specific exception types. 
19. The Finally block in VB.NET executes cleanup code regardless of whether an exception occurs or 

not. 
20. .NET Framework is a software development platform that provides a controlled programming 

environment for VB.NET applications. 
21. The four-layer .NET architecture consists of: VB Application, VB Language, Common Language 

Runtime (CLR), and Base Class Library (BCL). 
22. Common Language Runtime (CLR) is the execution engine that manages running .NET applications 

through services like JIT compilation and garbage collection. 
23. Just-In-Time (JIT) compilation converts MSIL to native machine code at runtime for optimal 

performance. 
24. Base Class Library (BCL) provides pre-built classes for common functionality like file operations 

(System.IO) and database access (System.Data). 
25. The complete flow in .NET is: VB Code → MSIL → CLR loading → JIT compilation → Native code 

execution. 
26. Integrated Development Environment (IDE) provides comprehensive facilities including code editor, 

debugger, and design tools in a single application. 

https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://system.io/
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Practice MCQs

1. What fundamentally 
distinguishes VB.NET from VB6 in 
terms of architecture? 
A) VB.NET uses P-code interpretation 
while VB6 uses full compilation 
B) VB.NET is COM-based while VB6 is 
.NET-based 
C) VB.NET is .NET-based while VB6 is 
COM-based 
D) VB.NET is interpreted while VB6 is 
compiled 
Answer: C (The architectural shift from 
COM to .NET is the fundamental 
difference) 

2. Why was the shift from VB6 
to VB.NET considered necessary despite 
VB6's popularity? 
A) VB6 lacked graphical interface 
capabilities 
B) VB6 was incompatible with Windows 
operating systems 
C) VB6 lacked full object-oriented 
programming support 
D) VB6 couldn't connect to databases 
Answer: C (Limited OOP was a key 
driver for the architectural rewrite) 

3. Which feature introduced in VB 3.0 
transformed it into a serious business 
application development tool? 
A) Web capabilities through ActiveX 
B) Database access via Jet Engine 
C) Drag-and-drop interface creation 
D) Full OOP support 
Answer: B (Jet Engine database access 
made VB viable for business applications) 

4. What does the "Visual" in Visual Basic 
specifically refer to? 
A) The language's visual syntax 
highlighting 
B) The ability to create 3D graphics 
C) The visual method of creating user 
interfaces through drag-and-drop 
D) The visual representation of program 
flow 
Answer: C (The visual designer for UI 
creation is the key "Visual" aspect) 

5. How does RAD (Rapid Application 
Development) manifest in Visual Basic? 
A) Through automatic code optimization 
B) Through reusable components and 

visual design tools 
C) Through built-in artificial intelligence 
D) Through automatic documentation 
generation 
Answer: B (Reusable controls and visual 
design enable rapid prototyping) 

6. What execution model did VB6 use that 
differed from VB.NET's approach? 
A) VB6 used native compilation 
while VB.NET uses interpretation 
B) VB6 used P-code interpretation 
while VB.NET compiles to MSIL 
C) VB6 used JIT compilation 
while VB.NET uses ahead-of-time 
compilation 
D) Both used identical execution models 
Answer: B (P-code vs MSIL/JIT 
compilation distinguishes the execution 
models) 

7. Which version of VB is still commonly 
found in legacy enterprise systems? 
A) VB 1.0 
B) VB 3.0 
C) VB 6.0 
D) VB.NET 2002 
Answer: C (VB6 remains in many legacy 
systems despite being obsolete) 

8. What was the revolutionary aspect of 
VB 1.0 that changed Windows 
programming? 
A) It introduced object-oriented 
programming to Windows 
B) It eliminated complex Windows API 
calls for UI creation 
C) It was the first interpreted language for 
Windows 
D) It introduced database programming to 
the masses 
Answer: B (Drag-and-drop UI building 
replaced complex API programming) 

9. Which .NET feature directly addresses 
memory management issues common in 
VB6? 
A) JIT compilation 
B) Automatic garbage collection 
C) Type safety enforcement 
D) Cross-language interoperability 
Answer: B (Garbage collection eliminates 
manual memory management and leaks) 

https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
https://vb.net/
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Oracle Database & PL/SQL 
Introduction to Oracle Database 
What is Oracle Database? 
Oracle Database is a multi-model database management system (DBMS) developed by Oracle 

Corporation. It is a Relational Database Management System (RDBMS) that stores data in structured tables 
consisting of rows and columns. Oracle is widely adopted in enterprise environments due to its robustness, 
scalability, and comprehensive feature set. 

Key Characteristics: 
• Follows ACID properties (Atomicity, Consistency, Isolation, Durability) 
• Uses SQL (Structured Query Language) for data manipulation and definition 
• Provides data integrity through constraints (primary key, foreign key, unique, check) 
• Supports concurrent access with locking mechanisms 
• Includes built-in backup, recovery, and security features 
• Implements client-server architecture 

Why Oracle is Preferred in Enterprises: 
1. Scalability – Handles terabytes of data and thousands of concurrent users. 
2. Reliability – High availability with failover and redundancy mechanisms. 
3. Security – Advanced user authentication, authorization, auditing, and encryption. 
4. Performance – Query optimization, indexing, caching, and partitioning. 
5. Enterprise Features – Data warehousing, replication, partitioning, and advanced analytics. 

Real-World Example – Banking System: 
Consider a bank’s database with a customers table storing account details. When a customer withdraws 
money: 

1. System checks balance (SELECT query) 
2. Deducts amount (UPDATE query) 
3. Logs transaction (INSERT into transactions table) 
4. All three steps succeed or fail together as a transaction – ensuring data consistency. 

Technical Illustration: 
sql 
CREATE TABLE customers ( 
    customer_id NUMBER PRIMARY KEY, 
    name VARCHAR2(50), 
    account_number VARCHAR2(20) UNIQUE, 
    balance NUMBER(10,2) CHECK(balance >= 0) 
); 
 
INSERT INTO customers VALUES (101, 'Ali Khan', 'ACC001', 50000); 

Oracle Architecture 
Oracle’s architecture is divided into two main components: the instance (memory and processes) and 

the database (physical files). This separation allows efficient management of memory, processes, and storage. 
Instance Components 
An Oracle instance consists of memory structures (SGA) and background processes. 
A. System Global Area (SGA) – Shared memory region: 

• Database Buffer Cache: Caches data blocks read from datafiles. 
• Redo Log Buffer: Stores changes before they are written to redo log files. 
• Shared Pool: Caches SQL statements (library cache) and data dictionary information (row cache). 
• Large Pool & Java Pool: Optional memory areas for specific operations. 

B. Background Processes: 
• PMON (Process Monitor): Cleans up failed user processes and releases resources. 
• SMON (System Monitor): Performs crash recovery, cleans temporary segments. 

Chapter 20 
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BEGIN 
    SELECT * INTO v_employee FROM employees WHERE employee_id = 9999; 
     
    v_salary := v_employee.salary / 0; 
     
    IF v_employee.department_id = 99 THEN 
        RAISE v_invalid_dept; 
    END IF; 
EXCEPTION 
    WHEN NO_DATA_FOUND THEN 
        DBMS_OUTPUT.PUT_LINE('Employee not found'); 
    WHEN ZERO_DIVIDE THEN 
        DBMS_OUTPUT.PUT_LINE('Cannot divide by zero'); 
        v_salary := 0; 
    WHEN v_invalid_dept THEN 
        DBMS_OUTPUT.PUT_LINE('Invalid department ID'); 
    WHEN OTHERS THEN 
        DBMS_OUTPUT.PUT_LINE('Error: ' || SQLCODE || ' - ' || SQLERRM); 
        RAISE;  -- Re-raise to calling program 
END; 
RAISE_APPLICATION_ERROR Procedure: 
sql 
BEGIN 
    IF some_condition THEN 
        RAISE_APPLICATION_ERROR(-20001, 'Custom error message'); 
    END IF; 
END; 
Exception Propagation: 
sql 
DECLARE 
    v_value NUMBER; 
BEGIN 
    BEGIN  -- Inner block 
        v_value := 100 / 0;  -- Raises ZERO_DIVIDE 
    EXCEPTION 
        WHEN NO_DATA_FOUND THEN 
            DBMS_OUTPUT.PUT_LINE('Inner: NO_DATA_FOUND'); 
        -- No handler for ZERO_DIVIDE 
    END; 
     
    DBMS_OUTPUT.PUT_LINE('This line never executes'); 
EXCEPTION 
    WHEN ZERO_DIVIDE THEN 
        DBMS_OUTPUT.PUT_LINE('Outer: ZERO_DIVIDE caught'); 
END; 

ADVANCED FEATURES & ADMINISTRATION 
1. Triggers 
A trigger is a stored PL/SQL block that automatically executes when a specified database event 

occurs. 
Trigger Fundamentals 
Trigger Characteristics: 
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One Liners: System analysis & Design 
Volume I: Oracle Database Fundamentals 

1. Oracle Database is a multi-model DBMS and a relational database management system (RDBMS). 
2. ACID properties in Oracle ensure transaction reliability: Atomicity, Consistency, Isolation, Durability. 
3. Oracle uses SQL for data manipulation and supports data integrity through constraints. 
4. Oracle’s client-server architecture enables concurrent access with locking mechanisms. 
5. Scalability in Oracle allows handling terabytes of data and thousands of concurrent users. 
6. High availability in Oracle is achieved through failover and redundancy mechanisms. 
7. Oracle provides advanced security via authentication, authorization, auditing, and encryption. 
8. Performance features in Oracle include query optimization, indexing, caching, and partitioning. 
9. Oracle supports enterprise features like data warehousing, replication, and advanced analytics. 
10. A transaction in Oracle ensures all steps succeed or fail together, maintaining data consistency. 
11. Oracle architecture comprises two main components: the instance (memory and processes) and the 

database (physical files). 
12. The System Global Area (SGA) is a shared memory region containing the buffer cache, redo log 

buffer, and shared pool. 
13. The Database Buffer Cache stores data blocks read from datafiles. 
14. The Redo Log Buffer holds changes before they are written to redo log files. 
15. The Shared Pool caches SQL statements and data dictionary information. 
16. Background processes in Oracle include PMON, SMON, DBWn, LGWR, and CKPT. 
17. PMON (Process Monitor) cleans up failed user processes and releases resources. 
18. SMON (System Monitor) performs crash recovery and cleans temporary segments. 
19. DBWn (Database Writer) writes modified buffers from the buffer cache to datafiles. 
20. LGWR (Log Writer) writes redo log buffer entries to redo log files. 
21. CKPT (Checkpoint Process) updates control files and datafile headers with checkpoint information. 
22. Physical files in Oracle include datafiles, control files, redo log files, and parameter files. 
23. The flow of a SELECT query involves the shared pool check, buffer cache check, and possible disk 

I/O. 
24. Logical storage hierarchy in Oracle: Database → Tablespace → Segment → Extent → Block. 
25. Physical storage hierarchy: Database → Datafile → OS Block → Disk Sector. 
26. A tablespace is a logical storage unit containing segments like tables and indexes. 
27. An extent is a contiguous set of database blocks allocated to a segment. 
28. The smallest unit of I/O in Oracle is a database block (default 8KB). 
29. CHAR(n) is fixed-length and padded with spaces; VARCHAR2(n) is variable-length with no padding. 
30. NCHAR and NVARCHAR2 support Unicode for multilingual data. 
31. NUMBER(p,s) stores numeric data with precision p and scale s. 
32. DATE stores date and time to the second; TIMESTAMP includes fractional seconds. 
33. LOB types include CLOB for text, BLOB for binary data, and BFILE for external files. 
34. DDL commands (CREATE, ALTER, DROP, TRUNCATE, RENAME) auto-commit transactions. 
35. DML commands (SELECT, INSERT, UPDATE, DELETE, MERGE) require explicit commit. 
36. DCL commands (GRANT, REVOKE) manage privileges and roles. 
37. TCL commands (COMMIT, ROLLBACK, SAVEPOINT) manage transaction boundaries. 
38. Analytic functions perform calculations across a set of rows related to the current row. 
39. Hierarchical queries retrieve tree-structured data using CONNECT BY and START WITH. 
40. Flashback queries retrieve data as it existed at a previous point in time. 
41. The MERGE statement performs conditional insert or update (UPSERT). 
42. PIVOT transforms row data into columnar format; UNPIVOT does the reverse. 
43. Oracle’s advanced SQL features support complex business scenarios like monthly comparisons and 

ETL processes. 
Volume II: PL/SQL Programming 

44. PL/SQL is Oracle’s procedural extension to SQL, enabling complex logic within the database. 
45. PL/SQL reduces network traffic by executing multiple SQL statements in a single block. 
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Practice MCQs
1. Which of the following best describes 

Oracle Database? 
a) A file-based storage system 
b) A multi-model DBMS and RDBMS 
c) A NoSQL database only 
d) A programming language 
Answer: b) A multi-model DBMS and 
RDBMS 

2. ACID properties in Oracle ensure: 
a) High availability and redundancy 
b) Atomicity, Consistency, Isolation, 
Durability 
c) Fast backup and recovery 
d) Data encryption and compression 
Answer: b) Atomicity, Consistency, 
Isolation, Durability 

3. Oracle’s client-server architecture 
enables: 
a) Single-user access only 
b) Concurrent access with locking 
mechanisms 
c) Only read operations 
d) No network connectivity 
Answer: b) Concurrent access with 
locking mechanisms 

4. Which feature allows Oracle to handle 
terabytes of data? 
a) Scalability 
b) Encryption 
c) Auditing 
d) Graphical interface 
Answer: a) Scalability 

5. High availability in Oracle is achieved 
through: 
a) Failover and redundancy mechanisms 
b) Only backup files 
c) Single server setup 
d) Manual intervention 
Answer: a) Failover and redundancy 
mechanisms 

6. The SGA component that caches data 
blocks is: 
a) Shared Pool 
b) Redo Log Buffer 
c) Database Buffer Cache 
d) Large Pool 
Answer: c) Database Buffer Cache 

7. PMON (Process Monitor) is responsible 
for: 
a) Writing redo logs 
b) Cleaning up failed user processes 

c) Performing checkpoints 
d) Writing datafiles 
Answer: b) Cleaning up failed user 
processes 

8. LGWR writes from _____ to _____. 
a) Buffer cache, datafiles 
b) Redo log buffer, redo log files 
c) Shared pool, buffer cache 
d) Datafiles, control files 
Answer: b) Redo log buffer, redo log 
files 

9. The physical file that contains database 
structure metadata is: 
a) Datafile 
b) Control file 
c) Redo log file 
d) Parameter file 
Answer: b) Control file 

10. During a SELECT query, if parsed SQL 
is found in the shared pool, it results in: 
a) Hard parsing 
b) Soft parsing 
c) No parsing 
d) Recompilation 
Answer: b) Soft parsing 

11. The logical storage unit containing 
segments is called: 
a) Database 
b) Tablespace 
c) Extent 
d) Block 
Answer: b) Tablespace 

12. The smallest unit of I/O in Oracle is: 
a) Extent 
b) Segment 
c) Block 
d) Tablespace 
Answer: c) Block 

13. Which data type is fixed-length and 
space-padded? 
a) VARCHAR2 
b) CHAR 
c) NCHAR 
d) CLOB 
Answer: b) CHAR 

14. NUMBER(10,2) can store up to: 
a) 10 digits with 2 decimal places 
b) 12 digits total 
c) 8 digits with 2 decimals 
d) Only integers 
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System Development, Troubleshooting and 
Maintenance 

Introduction 
Systems are created to solve problems. Modern systems are often large and complex, requiring 
collaboration between teams of architects, analysts, programmers, testers, and users to produce the 
software that drives organizations. To manage this complexity and ensure structured, high-quality 
outcomes, a systematic process is essential. This process is known as the System Development Life 
Cycle (SDLC). This unit focuses on the SDLC, explaining its importance, objectives, key participants 
(stakeholders), and the logical phases followed to develop a software product from conception to 
maintenance. 
What is a System? 
The term "system" originates from the Greek word "systema," meaning to "place together." A system 
can be defined as a set of interrelated components with a clearly defined boundary that work together to 
achieve a common set of objectives. When these components are methods, procedures, and routines 
applied in a proper sequence to build software, it is called a software system. 
System Development Life Cycle (SDLC) and Its Importance 
The System Development Life Cycle (SDLC) is a conceptual model and a structured, stepwise 
process used in project management to guide the development of an information system. It 
encompasses all stages from an initial feasibility study through to the maintenance of the completed 
application. It is also known as information system development or application development. 
Importance of SDLC: 

1. Phased Development: It breaks down the complex software development lifecycle into manageable 
phases, making it easier for team members to evaluate each part. 

2. Concurrent Work: It enables programmers and other specialists to work concurrently on different 
phases, improving efficiency. 

3. Time Estimation: It provides a framework for estimating when the software will be available for use. 
4. Quality Assurance: It ensures the delivery of quality software that meets or exceeds customer 

expectations by providing a structured framework. 
5. Project Management: It helps project managers establish a clear management structure to be 

followed strictly during development. 
6. Role Definition: It clearly defines and assigns the roles and responsibilities of all involved parties. 
7. Requirement Clarity: It ensures that the requirements for the software system are well-defined and 

subsequently satisfied. 
Objectives of SDLC 
The primary objectives of the SDLC are to: 

• Deliver high-quality software that meets customer expectations. 
• Deliver cost-effective and easily maintainable software. 
• Maximize productivity in terms of software systems delivered. 
• Establish an appropriate level of management authority to direct, coordinate, control, review, and 

approve the project. 
• Ensure project management accountability. 
• Facilitate proper documentation of all development requirements. 
• Ensure projects are developed within the current and planned IT infrastructure. 
• Identify potential project risks in advance to allow for proper mitigation planning. 

Chapter 21 



 

  MK PREPARATIONS  

 
 

P a g e  11 | 22 

 
MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

  

2
1

. Sy
ste

m
 D

e
v

e
lo

p
m

e
n

t T
ro

u
b

le
sh

o
o

tin
g

 M
a

in
te

n
a

n
ce

 
 

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

One Liners: System Development Troubleshooting and 
Maintenance 

1. System troubleshooting is a systematic process to identify problems and find quick solutions to 
prevent costly downtime and system damage. 

2. The primary goal of troubleshooting is to maintain system reliability, security, and efficiency 
without always relying on professional help. 

3. The first step in the systematic troubleshooting process is to identify and clearly define what is not 
working as expected. 

4. After identifying the problem, the troubleshooter must establish a theory of probable cause based 
on the observed symptoms. 

5. Testing the theory to determine the cause involves performing specific checks to confirm or rule 
out the suspected issue. 

6. Once the cause is confirmed, the next step is to establish a detailed plan of action to resolve the 
problem. 

7. The implementation phase involves carrying out the planned actions to fix the identified issue. 
8. After implementing the solution, it is critical to verify full system functionality to ensure the 

problem is resolved. 
9. Documenting findings, actions, and outcomes creates a valuable knowledge base for future 

reference. 
10. Troubleshooting is crucial for preventing downtime, which can lead to lost productivity and 

revenue for businesses. 
11. Ensuring data integrity is a key reason for troubleshooting, as it helps identify and fix problems 

that could corrupt information. 
12. Effective troubleshooting can reveal security vulnerabilities and breaches, allowing for swift 

protective action. 
13. Troubleshooting enhances system performance by identifying causes of slowdowns, such as 

insufficient RAM or software conflicts. 
14. Regular troubleshooting and fixing small issues early can extend equipment life by preventing 

major failures. 
15. Mastering troubleshooting saves costs by reducing the need for expensive emergency repairs and 

prolonged downtime. 
16. A reliable, well-performing system resulting from good troubleshooting enhances the overall user 

experience. 
17. For an application freezing, a common solution is to use Task Manager (Ctrl+Alt+Delete) to end 

the unresponsive task. 
18. If an application freezing persists, reinstalling the application or checking for updates is 

recommended. 
19. For unresponsive peripherals, the first steps are to check physical connections and unplug/replug 

the device. 
20. Updating device drivers is a standard solution for resolving issues with unresponsive peripherals. 
21. Restarting a computer clears memory and stops conflicting processes, fixing a significant 

percentage of software issues. 
22. As a last resort for an unresponsive system, pressing and holding the power button forces a 

shutdown but should be used cautiously to avoid data loss. 
23. Loose or disconnected cables are a common hardware culprit, and securing all connections is a 

primary solution. 
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Practice MCQs
1. What is the primary goal of system 

troubleshooting? 
a) To increase software licensing costs 
b) To maintain system reliability, security, 
and efficiency 
c) To replace all hardware components 
periodically 
d) To reduce the need for user training 
Answer: b) To maintain system reliability, 
security, and efficiency 

2. Which of the following is the FIRST step 
in the systematic troubleshooting process? 
a) Test the theory 
b) Establish a plan of action 
c) Identify the problem 
d) Document findings 
Answer: c) Identify the problem 

3. A laptop does not turn on. According to 
troubleshooting steps, what should you do 
immediately after identifying this 
problem? 
a) Replace the motherboard 
b) Establish a theory of probable cause (e.g., 
dead battery) 
c) Immediately document the failure 
d) Reinstall the operating system 
Answer: b) Establish a theory of probable 
cause (e.g., dead battery) 

4. Why is documenting the troubleshooting 
process considered important? 
a) It increases the complexity of the solution 
b) It creates a bill for the client 
c) It creates a valuable knowledge base for 
future reference 
d) It is only required for auditing purposes 
Answer: c) It creates a valuable knowledge 
base for future reference 

5. Which troubleshooting benefit directly 
relates to minimizing financial loss for a 
business? 
a) Extending equipment life 
b) Preventing downtime 
c) Enhancing user experience 
d) Improving security 
Answer: b) Preventing downtime 

6. An application becomes unresponsive. 
What is the most common immediate 
software-based solution? 
a) Reformat the hard drive 
b) Use Task Manager to end the task 
c) Restart the web server 
d) Update the BIOS 
Answer: b) Use Task Manager to end the 
task 

7. For an unresponsive external mouse, 
which sequence of actions is most 
appropriate initially? 
a) Update the OS, then replace the mouse 
b) Check physical connections, then unplug 
and replug 
c) Reinstall all device drivers, then restart 
d) Scan for viruses, then check the power 
supply 
Answer: b) Check physical connections, 
then unplug and replug 

8. What is the primary technical reason 
restarting a computer often resolves 
software issues? 
a) It upgrades the hardware firmware 
b) It clears memory and stops conflicting 
processes 
c) It redefines the system requirements 
d) It performs a full disk defragmentation 
Answer: b) It clears memory and stops 
conflicting processes 

9. What is the most common cause of 
hardware connectivity issues? 
a) Outdated antivirus software 
b) Lack of cloud storage 
c) Loose or disconnected cables 
d) Insufficient pseudo code 
Answer: c) Loose or disconnected cables 

10. System slowdowns and unexpected 
shutdowns can be symptoms of what 
hardware-related problem? 
a) Incorrect flowchart design 
b) Overheating 
c) Lack of stakeholder feedback 
d) Unvalidated requirements 
Answer: b) Overheating 
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System Analysis and Design 
Foundations of System Analysis & Design 
Introduction to Systems 
What is a System?  
Basic Idea: A system is a set of interconnected components that work together to achieve a common goal. 
Concept: In computing, a system refers to an organized collection of hardware, software, data, people, 
procedures, and networks that process information and support organizational functions. 
Explanation: 

• A system has boundaries separating it from its environment. 
• It accepts inputs from outside, processes them through defined procedures, and 

produces outputs. 
• It operates within an environment and interacts with it. 

Example: A university admission system. 
• Inputs: Student applications, marks, fees. 
• Processing: Eligibility checks, merit calculation, seat allocation. 
• Outputs: Admission lists, fee receipts, roll numbers. 
• Environment: Educational policy, competition, technological infrastructure. 

Summary: A system is a goal-oriented collection of interrelated components working together. 
Characteristics of a System 

1. Organization: Structured arrangement of components. 
2. Interaction: Components depend on and communicate with each other. 
3. Interdependence: Parts cannot function in isolation. 
4. Integration: Components unified to achieve objective. 
5. Central Objective: Primary goal drives system existence. 

Example: A car as a system. 
• Engine, wheels, brakes are organized. 
• Brakes interact with wheels. 
• Engine depends on fuel system. 
• All integrated for transportation. 
• Central objective: Mobility. 

Types of Systems 
Type Description Example 

Physical Tangible, material components Computer hardware 
Abstract Conceptual, non-physical Mathematical model 
Open Interacts with environment Business organization 
Closed Isolated, minimal interaction Thermostat (theoretical) 
Natural Occur in nature Solar system 
Manufactured Human-made Railway reservation system 
Adaptive Changes with environment AI-based recommendation system 
Non-adaptive Static, fixed behavior Basic calculator 

Chapter 22 
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One Liners: System Analysis and Design 
1. System: A set of interrelated components working toward a common objective. 
2. Information System: A formal system to collect, process, store, and distribute information. 
3. SDLC: Framework of phases to develop systems systematically. 
4. Waterfall Model: Linear, sequential, non-iterative SDLC model. 
5. Prototyping: Building a working model to clarify requirements. 
6. Feasibility Study: Determines if project is technically, economically, operationally viable. 
7. Technical Feasibility: Can the system be built with available technology? 
8. Economic Feasibility: Cost-benefit analysis; ROI, payback period. 
9. Operational Feasibility: Will the system be used effectively? 
10. Functional Requirements: What the system must do. 
11. Non-functional Requirements: How well the system performs (speed, security). 
12. JAD: Joint Application Development – intensive workshop for requirements. 
13. DFD: Data Flow Diagram – shows movement of data through processes. 
14. Context Diagram: Highest-level DFD with single process. 
15. Entity: A person, place, thing, or event about which data is stored. 
16. Cardinality: Number of instances one entity can associate with another. 
17. Normalization: Process of organizing data to minimize redundancy. 
18. 1NF: Eliminate repeating groups; atomic values. 
19. 2NF: In 1NF + no partial dependency (all non-key attributes depend on full primary key). 
20. 3NF: In 2NF + no transitive dependency. 
21. Cohesion: Measure of how closely operations in a module are related. 
22. Coupling: Degree of interdependence between modules (low coupling desired). 
23. Black-box Testing: Tests functionality without knowing internal logic. 
24. White-box Testing: Tests internal structures or workings. 
25. Alpha Testing: By development team within organization. 
26. Beta Testing: By actual users in real environment. 
27. Regression Testing: Re-testing after modifications to ensure no new bugs. 
28. System Maintenance: Modifying system after deployment. 
29. Corrective Maintenance: Fixing defects. 
30. Adaptive Maintenance: Adapting to new environment (OS, hardware). 
31. Perfective Maintenance: Improving performance, adding minor features. 
32. Preventive Maintenance: Preventing future problems. 
33. Agile: Iterative, incremental, flexible development methodology. 
34. Scrum: Agile framework with sprints, product owner, scrum master. 
35. UML: Unified Modeling Language – standard for OO modeling. 
36. Use Case Diagram: Shows actors and use cases (functionality). 
37. Class Diagram: Static structure – classes, attributes, methods, relationships. 
38. Sequence Diagram: Shows object interactions over time. 
39. CASE Tools: Computer-Aided Software Engineering – automate SDLC activities. 
40. Data Dictionary: Repository of data about data (metadata). 
41. Gantt Chart: Bar chart for project scheduling. 
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Practice MCQs
1. Which model is also known as linear-

sequential model? 
a) Prototyping 
b) Waterfall 
c) Spiral 
d) Agile 
Answer: b 

2. In DFD, a process is represented by: 
a) Rectangle 
b) Circle 
c) Rounded rectangle 
d) Diamond 
Answer: c 

3. Which feasibility deals with "Can the 
system be built with available 
technology?" 
a) Economic 
b) Technical 
c) Operational 
d) Legal 
Answer: b 

4. A many-to-many relationship in ERD 
is represented as: 
a) 1:1 
b) 1:M 
c) M:1 
d) M:N 
Answer: d 

5. Which testing is conducted by 
developers? 
a) Alpha 
b) Beta 
c) Acceptance 
d) Regression 
Answer: a 

6. Modifying system to work in a new 
environment is: 
a) Corrective maintenance 
b) Adaptive maintenance 
c) Perfective maintenance 

d) Preventive maintenance 
Answer: b 

7. Which is NOT a UML diagram? 
a) Class diagram 
b) Flowchart 
c) Sequence diagram 
d) Use case diagram 
Answer: b 

8. Process of removing partial 
dependency is part of: 
a) 1NF 
b) 2NF 
c) 3NF 
d) BCNF 
Answer: b 

9. In PERT, the most likely time is 
weight multiplied by: 
a) 1 
b) 4 
c) 6 
d) 2 
Answer: b (Formula: Expected time = 
(O+4M+P)/6) 

10. Which is a characteristic of good 
system design? 
a) High coupling 
b) Low cohesion 
c) High cohesion 
d) Complex interfaces 
Answer: c 

11. Which architectural style has all 
components tightly integrated? 
a) Microservices 
b) Client-Server 
c) Monolithic 
d) SOA 
Answer: c 

12. In structured design, the ideal 
coupling is: 
a) Content coupling 
b) Common coupling 
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Emerging and Contemporary Technologies 
Introduction to Emerging Technologies 

Definition and Characteristics 
An Emerging Technology is a new technology or a significant advancement in an existing one, capable 
of bringing about profound technical, institutional, and social changes. These technologies are poised to 
replace current systems in the near future and will be integrated into every field, from education and IT 
to medicine, transportation, and communication. They are distinguished by key characteristics: 

• Innovation: Introduces novel ideas and methods. 
• Fast Growth: Develops and scales rapidly. 
• Consistency: Provides reliable and repeatable performance. 
• Prominent Impact: Creates significant changes in how tasks are performed and problems are solved. 
• Interdisciplinary Nature: Combines knowledge and methods from multiple fields like computer 

science, engineering, and biology. 
• Convergence: Merges different technologies to create new, synergistic capabilities. 

Detailed Exploration of Emerging Technologies 
Artificial Intelligence (AI) and Machine Learning (ML) 
Artificial Intelligence (AI) is a broad field of computer science focused on building intelligent machines 
and software capable of performing tasks that typically require human-like intelligence, such as 
reasoning, learning, problem-solving, and decision-making. The term was coined by John McCarthy in 
1956. Key subfields include: 

• Machine Learning (ML): A subset of AI that gives computers the ability to learn from data and 
experience without being explicitly programmed. ML algorithms build models by identifying patterns in 
large datasets. 

o Supervised Learning: The algorithm learns from a labeled dataset where the correct output is known, 
used for making predictions on new data (e.g., predicting prices). 

o Unsupervised Learning: The algorithm finds hidden patterns or intrinsic structures in unlabeled data, 
often through clustering (e.g., grouping customers). 

• Deep Learning (DL): A specialized subset of ML that uses Neural Networks with many hidden layers 
("deep" networks). Inspired by the human brain, a neural network consists of layers of interconnected 
nodes (neurons): 

o Input Layer: Receives raw data. 
o Hidden Layers: Process data through weighted connections and activation functions. 
o Output Layer: Produces the final prediction or classification. 

Key concepts include Weights (connection importance), Biases (threshold adjusters), Activation 
Functions, and Loss Functions. Training involves Feedforward 
Propagation and Backpropagation to minimize error. DL excels at autonomously extracting complex 
patterns from vast amounts of unstructured data like images and text. 
The hierarchical relationship is: AI ⊃ ML ⊃ Neural Networks ⊃ Deep Learning. 
Key Areas and Applications of AI 

• Natural Language Processing (NLP): Enables computers to understand, interpret, and generate 
human language. Applications include language translation (Google Translate), spam filtering, 
sentiment analysis, chatbots, and voice assistants. 

• Speech & Voice Recognition: 
o Speech Recognition: Converts spoken words into text or commands (e.g., dictation software, Siri, 

Alexa). 

Chapter 23 
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One Liners: Emerging and Contemporary Technologies 
1. An Emerging Technology is a new technology or a significant advancement in an existing one, 

capable of bringing profound technical, institutional, and social changes. 
2. Emerging technologies are poised to replace current systems in the near future and will be integrated 

into every field. 
3. Key characteristics of emerging technologies include Innovation, Fast Growth, Consistency, 

Prominent Impact, Interdisciplinary Nature, and Convergence. 
4. The Interdisciplinary Nature of emerging technologies combines knowledge from fields like 

computer science, engineering, and biology. 
5. Convergence refers to the merging of different technologies to create new, synergistic capabilities. 
6. Artificial Intelligence (AI) is a broad field of computer science focused on building intelligent 

machines capable of human-like tasks such as reasoning, learning, and decision-making. 
7. The term "Artificial Intelligence" was coined by John McCarthy in 1956. 
8. Machine Learning (ML) is a subset of AI that gives computers the ability to learn from data and 

experience without being explicitly programmed. 
9. Supervised Learning involves algorithms learning from labeled datasets where the correct output is 

known, used for making predictions. 
10. Unsupervised Learning involves algorithms finding hidden patterns in unlabeled data, often through 

clustering. 
11. Deep Learning (DL) is a specialized subset of ML that uses Neural Networks with many hidden 

layers. 
12. A Neural Network is inspired by the human brain and consists of interconnected nodes (neurons). 
13. The layers of a Neural Network are Input Layer, Hidden Layers, and Output Layer. 
14. Weights in a neural network represent the importance of connections between neurons. 
15. Biases are threshold adjusters in neural networks that help the model fit the data better. 
16. Activation Functions in neural networks determine whether a neuron should be activated. 
17. Loss Functions measure the difference between the predicted output and the actual target. 
18. Training a neural network involves Feedforward Propagation and Backpropagation to minimize error. 
19. Deep Learning excels at autonomously extracting complex patterns from vast amounts of 

unstructured data like images and text. 
20. The hierarchical relationship is: AI ⊃ ML ⊃ Neural Networks ⊃ Deep Learning. 
21. Natural Language Processing (NLP) enables computers to understand, interpret, and generate human 

language. 
22. NLP applications include language translation, spam filtering, sentiment analysis, chatbots, and voice 

assistants. 
23. Speech Recognition converts spoken words into text or commands (e.g., dictation software, Siri). 
24. Voice Recognition is a biometric technology that identifies a person based on unique vocal 

characteristics for security. 
25. Computer Vision enables computers to derive meaningful information from digital images and 

videos. 
26. Applications of Computer Vision include facial recognition, security surveillance, self-driving cars, 

and medical image analysis. 
27. Expert Systems are interactive AI programs that mimic human expert reasoning to solve complex 

problems in a specific domain. 
28. Expert Systems use a knowledge base and are applied in medical diagnosis, loan analysis, and 

cybersecurity. 
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C) Interdisciplinary nature 
D) Prominent impact 
Answer: B) Slow and steady growth 
2. Who coined the term "Artificial 
Intelligence"? 
A) Alan Turing 
B) John McCarthy 
C) Marvin Minsky 
D) Claude Shannon 
Answer: B) John McCarthy 
3. Which subset of AI gives computers the 
ability to learn from data without explicit 
programming? 
A) Natural Language Processing 
B) Machine Learning 
C) Computer Vision 
D) Expert Systems 
Answer: B) Machine Learning 
4. In machine learning, which type involves 
algorithms learning from labeled datasets? 
A) Unsupervised Learning 
B) Reinforcement Learning 
C) Supervised Learning 
D) Deep Learning 
Answer: C) Supervised Learning 
5. What is the hierarchical relationship 
between AI, ML, Neural Networks, and 
Deep Learning? 
A) AI ⊃ Neural Networks ⊃ ML ⊃ Deep 
Learning 
B) AI ⊃ ML ⊃ Neural Networks ⊃ Deep 
Learning 
C) ML ⊃ AI ⊃ Deep Learning ⊃ Neural 
Networks 
D) Deep Learning ⊃ Neural Networks ⊃ ML 
⊃ AI 
Answer: B) AI ⊃ ML ⊃ Neural Networks ⊃ 
Deep Learning 
6. Which AI subfield enables computers to 
understand, interpret, and generate human 
language? 
A) Computer Vision 
B) Robotics 
C) Natural Language Processing 
D) Speech Recognition 
Answer: C) Natural Language Processing 

7. What is the key difference between 
speech recognition and voice recognition? 
A) Speech recognition identifies a person; 
voice recognition converts speech to text. 
B) Speech recognition converts speech to text; 
voice recognition identifies a person. 
C) Both are the same. 
D) Speech recognition is for commands; voice 
recognition is for transcription. 
Answer: B) Speech recognition converts 
speech to text; voice recognition identifies a 
person. 
8. Which technology creates a fully 
immersive, artificial three-dimensional 
environment? 
A) Augmented Reality 
B) Virtual Reality 
C) Holographic Imaging 
D) 3D Printing 
Answer: B) Virtual Reality 
9. What does AR stand for, and what does it 
do? 
A) Augmented Reality; overlays digital 
content onto the real world 
B) Artificial Reality; creates a completely 
virtual world 
C) Advanced Rendering; enhances image 
quality 
D) Audio Recognition; identifies sounds 
Answer: A) Augmented Reality; overlays 
digital content onto the real world 
10. Which technology creates a true three-
dimensional, free-standing image viewable 
without special glasses? 
A) 3D Imaging 
B) Holographic Imaging 
C) Virtual Reality 
D) Augmented Reality 
Answer: B) Holographic Imaging 
11. What is another name for 3D printing? 
A) Subtractive Manufacturing 
B) Additive Manufacturing 
C) Injection Molding 
D) CNC Machining 
Answer: B) Additive Manufacturing 
12. Blockchain is best described as: 
A) A type of computer virus 
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Digital Citizenship, Literacy and Ethics 
Introduction: Navigating the Modern Digital World 
The digital landscape is the cornerstone of modern society, transforming how we communicate, learn, 
work, and access entertainment. This evolution from traditional methods to a connected, technology-
driven world brings immense power and convenience, but also introduces significant responsibilities, 
risks, and ethical dilemmas. This Master Chapter provides a complete, unified, and self-contained guide 
to becoming a competent, safe, responsible, and ethical participant in the digital world. It integrates 
foundational skills, security practices, ethical frameworks, societal impacts, and entrepreneurial 
thinking into a seamless professional textbook. 

The Digital Foundation – Hardware, Software, and Systems 
Understanding Software 
A computer consists of hardware—the physical components—and software, the set of instructions, 
data, and programs that operate the computer to perform specific tasks. 

Types of Software 
1. System Software: The essential set of programs that acts as the primary interface between hardware 

and the user. Its purpose is to simplify hardware use, control operations, and optimize performance. 
o Examples: Operating Systems (OS), Device Drivers, Utility Programs, Language Translators. 
2. Application Software: Programs written to carry out specific tasks for the user. 
o Examples: Word Processors (Microsoft Word), Spreadsheets (Excel), Presentation Software 

(PowerPoint), Web Browsers (Chrome), Email Clients (Gmail), Image Editors (Paint). 

System Software Deep Dive 
The Operating System (OS) 
The OS is the most critical system software that controls and manages all computer operations. A 
computer cannot function without it. 
 
Main Functions: 

• Booting: Loading itself into main memory upon startup. 
• Security Management: Managing user accounts and access. 
• Application Management: Enabling installation and execution of application programs. 
• Memory Management: Organizing memory and processing time between users and programs. 
• File Management: Enabling users to save, load, delete, rename, print, and copy files. 
• Device Management: Controlling peripherals (disk drives, printers). 
• User Interface: Providing a bridge between the user and the computer's hardware/software. 
• Common OS Examples: Microsoft Windows (10, 11), macOS, Linux, Android, iOS. 

Other Essential System Software 
• Device Drivers: Specialized programs that enable hardware components (printers, sound cards) to 

communicate with the OS. 
• Utility Programs: Applications that perform management and maintenance tasks (e.g., Antivirus 

software, disk cleanup, backup utilities, file management tools). 
• Language Translators: Software that converts human-readable programming code (source code) 

into machine-understandable code. Includes Assemblers, Compilers, and Interpreters. 

Chapter 24 
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Common Cybercrime Techniques & Prevention 
Technique Description Preventive Measures 

Phishing / Email 

Spoofing 

Fake emails from trusted 

sources to steal credentials. 

Inspect sender's address. Don't 

click suspicious links. Use Two-

Factor Authentication (2FA). 

Spamming 
Unsolicited bulk emails, often 

with malware/scams. 

Use spam filters. Don't 

reply/forward/click. Preview 

messages. 

Email Account 

Hacking 

Unauthorized access to an 

email account. 

Use strong, unique passwords. 

Enable 2FA. Update software. 

Social Engineering 

Manipulating people into 

divulging confidential info 

(e.g., fake bank calls). 

Be skeptical of unsolicited 

requests. Verify the source 

independently. 

Cyber 

Bullying/Trolling 

Using digital platforms to 

harass, intimidate, or demean. 

Report and block bullies. 

Maintain privacy settings. Don't 

engage; seek help. 

Online Transaction 

Fraud 

Illegal transfer using stolen 

bank/credit card details. 

Use secure (HTTPS) websites. 

Never share PIN, OTP, CVV. 

Avoid public Wi-Fi for 

transactions. Review statements. 

Cybersecurity Fundamentals and Advanced Methods 
Cybersecurity is the practice of protecting systems, networks, and data from digital attacks. Core 
goals: 

• Confidentiality: Data accessible only to authorized parties (via encryption). 
• Integrity: Safeguarding data accuracy/completeness (via hashing, digital signatures). 
• Availability: Ensuring reliable access for authorized users. 

Advanced Security Methods: 
1. Two-Factor/Multi-Factor Authentication (2FA/MFA): Requires two or more verification factors 

(something you know, have, are). 
2. Biometric Verification: Uses unique traits (fingerprint, facial recognition, iris scan). Convenient and 

secure but raises privacy concerns. 
3. Cryptography: Securing information by converting plaintext into ciphertext. 
o Symmetric Cryptography: Single secret key for encryption/decryption (fast, but key distribution is a 

challenge). Example: AES. 
o Asymmetric Cryptography: Uses a public key (encrypt) and a private key (decrypt). Enables secure 

communication without pre-shared secrets. Example: RSA. 
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One Liners: Digital Citizenship, Ethics and Literacy 
1. The digital landscape is the cornerstone of modern society, transforming communication, learning, 

work, and entertainment. 
2. A computer consists of hardware (physical components) and software (instructions, data, and 

programs). 
3. System software acts as the primary interface between hardware and the user, simplifying 

hardware use, controlling operations, and optimizing performance. 
4. Application software carries out specific tasks for the user (e.g., word processors, spreadsheets). 
5. The Operating System (OS) is the most critical system software that controls and manages all 

computer operations; a computer cannot function without it. 
6. OS functions include Booting, Security Management, Application Management, Memory 

Management, File Management, Device Management, and providing a User Interface. 
7. Common OS examples are Microsoft Windows, macOS, Linux, Android, and iOS. 
8. Device Drivers are specialized programs enabling hardware components to communicate with the 

OS. 
9. Utility Programs perform management and maintenance tasks (e.g., antivirus, disk cleanup). 
10. Language Translators convert human-readable programming code into machine-understandable 

code (Assemblers, Compilers, Interpreters). 
11. The desktop is the main screen after startup, containing icons, taskbar, Start button/menu, 

notification area, and background/wallpaper. 
12. A File is a common storage unit holding information; a Folder is a virtual container used to 

organize files. 
13. A Shortcut is a link providing quick access to a file, folder, or program without moving the 

original item. 
14. Essential file operations include Create, Rename, Cut/Copy/Paste, Delete & Restore, and Drag and 

Drop. 
15. Deleted files are sent to the Recycle Bin, from which they can be restored. 
16. A word processor is an application used to create, edit, format, save, and print text-based 

documents. 
17. Key word processor interface elements include the Quick Access Toolbar, Title Bar, Ribbon, and 

Document Workspace. 
18. Character formatting in a word processor includes changing Font Style, Size, Color, and applying 

Bold, Italic, Underline, and Text Alignment. 
19. Page Layout adjustments involve margins, orientation (Portrait/Landscape), and size. 
20. Lists can be bulleted (unordered) or numbered (sequential). 
21. Headers and Footers are areas at the top and bottom of every page for titles, page numbers, and 

dates. 
22. Spell & Grammar Check (F7) and Thesaurus are tools for error checking and finding synonyms. 
23. Save (Ctrl+S) updates an existing file; Save As (F12) saves a new copy with a different 

name/location/format. 
24. A multimedia presentation combines text, images, video, and audio (e.g., PowerPoint). 
25. Slides can be added with various layouts; objects like text boxes, pictures, videos, audio, and 

shapes can be inserted. 
26. Speaker Notes are private notes for the presenter, accessible via the Notes pane. 
27. Press F5 to start a slideshow; Slide Timings can be set for automatic advancement. 
28. Email is a method of exchanging digital messages across computer networks. 
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Practice MCQs
1. What are the two main components of 
a computer system? 
A) CPU and RAM 
B) Hardware and Software 
C) Input and Output 
D) Operating System and Applications 
Answer: B) Hardware and Software 
2. Which type of software acts as the 
primary interface between hardware and 
the user? 
A) Application Software 
B) System Software 
C) Utility Software 
D) Programming Software 
Answer: B) System Software 
3. Which of the following is NOT a 
function of an Operating System? 
A) Booting 
B) Memory Management 
C) Word Processing 
D) File Management 
Answer: C) Word Processing 
4. What is the purpose of a Device 
Driver? 
A) To perform disk cleanup 
B) To enable hardware components to 
communicate with the OS 
C) To compile programming code 
D) To create documents 
Answer: B) To enable hardware 
components to communicate with the OS 
5. Where are deleted files typically stored 
before permanent deletion? 
A) Downloads folder 
B) Recycle Bin 
C) Temp folder 
D) Desktop 
Answer: B) Recycle Bin 
6. Which keyboard shortcut is used to 
copy selected text or files? 
A) Ctrl+X 
B) Ctrl+C 
C) Ctrl+V 
D) Ctrl+A 
Answer: B) Ctrl+C 

7. In a word processor, which tab is used 
to adjust page margins and orientation? 
A) Home 
B) Insert 
C) Layout 
D) Review 
Answer: C) Layout 
8. What does Bcc stand for in an email? 
A) Basic Carbon Copy 
B) Blind Carbon Copy 
C) Broad Copy Control 
D) Binary Copy Code 
Answer: B) Blind Carbon Copy 
9. Which email protocol downloads 
emails from the server to a single device 
and typically removes them from the 
server? 
A) SMTP 
B) IMAP 
C) POP 
D) HTTP 
Answer: C) POP 
10. What is the ability to effectively find, 
create, evaluate, communicate, and share 
content in a digital environment called? 
A) Digital Citizenship 
B) Digital Literacy 
C) Digital Ethics 
D) Digital Security 
Answer: B) Digital Literacy 
11. Which of the following is a primary 
source of information? 
A) A textbook summarizing historical 
events 
B) A documentary film about World War II 
C) A soldier's original diary from World 
War II 
D) An encyclopedia entry 
Answer: C) A soldier's original diary 
from World War II 
12. What does the 'A' in the CRAAP test 
for evaluating sources stand for? 
A) Authenticity 
B) Authority 
C) Accuracy 
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Entrepreneurship in the Digital Age 
Introduction 
Entrepreneurship is the dynamic process of identifying a market opportunity, conceptualizing a solution, 
and undertaking the risk of launching and managing a new business venture to bring new products, 
services, or processes to life. It is the engine of innovation, job creation, and economic growth. In the 
contemporary world, this traditional process has been fundamentally transformed by digital 
technologies. The fusion of classic business acumen with tools like the internet, social media, cloud 
computing, and data analytics has created unprecedented opportunities while reshaping the 
entrepreneurial landscape. This Master Chapter provides a comprehensive, unified guide to 
understanding the complete journey of entrepreneurship—from its core principles and initial idea 
validation to building, launching, and scaling a venture in the digital era. It is designed to be a self-
contained, professional resource for students and aspiring entrepreneurs. 

The Foundation of Entrepreneurship 
Definition and Core Concepts 

• Entrepreneur: An individual who organizes, manages, and assumes the financial risks of a new 
business venture. An entrepreneur is commonly seen as an innovator, a source of new ideas, goods, 
services, and business procedures. The term originates from the French word meaning "to undertake." 

• Entrepreneurship: The process of designing, launching, and running this new business venture. It 
involves identifying a market need, taking calculated risks under conditions of uncertainty, and making 
strategic decisions to achieve business objectives and create value. 

Significance and Impact 
Entrepreneurship is a vital catalyst for any economy due to its multi-faceted role: 

• Economic Growth: Creates new jobs and introduces new products and services, stimulating economic 
activity. 

• Innovation and Progress: Drives groundbreaking ideas that transform lifestyles and industries (e.g., 
smartphones, digital platforms). 

• Job Creation: Generates employment opportunities directly and indirectly. 
• Competition and Improvement: Introduces fresh ideas and competition into the market, leading to 

better products, services, and prices for consumers. 
• Social and Environmental Solutions: Through social entrepreneurship, it addresses pressing societal 

and environmental challenges. 

Characteristics of a Successful Entrepreneur 
Successful entrepreneurs typically exhibit a composite set of the following attributes and skills: 

• Innovation & Creativity: The ability to create something new or significantly improve existing 
solutions through creative thinking. 

• Calculated Risk-Taking: A willingness to undertake financial and personal risks, with an 
understanding that failure is possible but great rewards can follow. They are moderate risk-takers, not 
gamblers. 

• Persistence and Resilience: The determination and self-reliance to overcome inevitable challenges 
and setbacks. 

• Future Orientation & Opportunity Seeking: Constantly looking ahead for new opportunities and 
focused on long-term potential. 

Chapter 25 
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2. Scalable Startup 

Founded on the belief the company can 

revolutionize an industry. Heavily reliant on 

venture capital, specialized employees, and 

targets rapid expansion & big profits. 

Facebook, 

Instagram, Uber. 

3. Large Company / 

Intrapreneurship 

Involves creating new services/products within 

an established corporation to meet evolving 

consumer demand and sustain innovation. 

Microsoft, Google, 

Disney (internal 

innovation 

divisions). 

4. Social 

Entrepreneurship 

Aims to solve social problems and create 

positive change. The primary goal is social 

good, not maximizing profits. Often structured 

as non-profits or hybrid models. 

Non-profit 

organizations, 

companies 

dedicated to social 

impact. 

5. Innovative 

Entrepreneurship 

Driven by the continuous generation of new 

ideas and inventions turned into ventures, 

aiming to change lives and industries. 

Steve Jobs (Apple), 

Bill Gates 

(Microsoft). 

6. Hustler 

Entrepreneurship 

Relies on hard work, consistent effort, and self-

developed skills rather than large capital. Starts 

small and is highly motivated by aspirations. 

A salesperson 

making extensive 

cold calls to build a 

client base. 

7. Imitator 

Entrepreneurship 

Improves upon existing business ideas of 

others. Combines traits of an innovator and a 

hustler, learning from others' mistakes to create 

a better version. 

Businesses that 

refine and enhance 

existing 

products/services. 

8. Researcher 

Entrepreneurship 

Believes success comes from complete 

knowledge and preparation. Relies on facts, 

data, and detailed business plans, minimizing 

risk through extensive research. 

Tech or science-

based startups with 

lengthy R&D 

phases. 

9. Buyer 

Entrepreneurship 

Uses personal wealth to acquire and grow 

existing, promising businesses. Involves less 

risk as companies are already established. 

Investors or 

acquirers of 

businesses (e.g., 

private equity). 
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7. Financial Projections: Provide realistic forecasts for revenue, expenses, and profitability. 
8. The Team: Introduce key members and highlight their relevant expertise and passion. 
9. The Ask: State clearly what you need (e.g., amount of investment, specific partnership). 

The Elevator Pitch: A 30-60 second compelling summary. 
• Hook: Engaging opening. 
• Introduction: "We are [Company], and we..." 
• USP: "Unlike [alternative], we [unique benefit]..." 
• Call to Action (CTA): "I'd love to schedule a brief meeting to show you our demo." 

Business Plan vs. Pitch Document: 

Feature Business Plan Pitch Document/Deck 

Purpose 
Comprehensive internal roadmap and 

detailed funding proposal. 

Concise, persuasive presentation to 

spark interest and secure a meeting. 

Format 
Long (20-40 pages), detailed written 

document. 

Short (10-15 slides), highly visual, 

minimal text. 

Detail 

Level 

In-depth market research, financial 

models, operational plans. 

High-level overview focusing on 

problem, solution, opportunity, team, 

and ask. 

Audience 
Investors for due diligence, banks, 

internal management. 

Potential investors, partners, 

competition judges for first impression. 

Developing a Comprehensive Business Plan 
A business plan is a formal written document describing the business's goals, strategies, market, and 
financial forecasts. 
Key Sections: 

1. Executive Summary: A one-page snapshot of the entire plan (written last). 
2. Company Description: Vision, mission, legal structure, and company history (if any). 
3. Market Analysis: Industry overview, target market profile, competitor analysis (SWOT: Strengths, 

Weaknesses, Opportunities, Threats), and trends. 
4. Organization & Management: Company structure, biographies of key team members. 
5. Products/Services Line: Detailed description of what you sell and its lifecycle. 
6. Marketing & Sales Strategy: How you will reach customers and your sales process. 
7. Funding Request (if applicable): How much capital is needed and how it will be used. 
8. Financial Projections: The critical section including: 
o Income Statement (Profit & Loss) 
o Cash Flow Statement 
o Balance Sheet 
o Break-Even Analysis 
o Assumptions behind the projections. 

Financial Calculations & Pricing 
A sound financial foundation starts with understanding costs and setting prices. 
Steps to Calculate Selling Price & Profit: 
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One Liners: Entrepreneurship in Digital Age 
1. Entrepreneurship is the dynamic process of identifying a market opportunity and undertaking the 

risk of launching a new business venture. 

2. An entrepreneur is an individual who organizes, manages, and assumes the financial risks of a new 

business venture. 

3. The term "entrepreneur" originates from the French word meaning "to undertake." 

4. Entrepreneurship is commonly seen as a source of innovation, introducing new ideas, goods, 

services, and business procedures. 

5. The process of entrepreneurship involves identifying a market need, taking calculated risks, and 

making strategic decisions to create value. 

6. Entrepreneurship acts as a vital catalyst for economic growth by creating new jobs. 

7. It drives economic growth by introducing new products and services that stimulate economic 

activity. 

8. Entrepreneurship is a primary driver of groundbreaking innovation that transforms lifestyles and 

industries. 

9. A major impact of entrepreneurship is job creation, generating employment opportunities both 

directly and indirectly. 

10. By introducing fresh ideas and competition, entrepreneurship leads to better products, services, and 

prices for consumers. 

11. Social entrepreneurship specifically addresses pressing societal and environmental challenges. 

12. A key characteristic of successful entrepreneurs is innovation and creativity. 

13. Entrepreneurs exhibit calculated risk-taking, understanding that failure is possible but great rewards 

can follow. 

14. Successful entrepreneurs are moderate risk-takers, not gamblers. 

15. Persistence and resilience are essential attributes for overcoming inevitable challenges and setbacks. 

16. Entrepreneurs are future-oriented and constantly seek new opportunities with long-term potential. 

17. A deep desire for responsibility and control over the venture's outcomes is a common entrepreneurial 

trait. 
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215. Potential career paths from entrepreneurship skills include Founder, Product Manager, and Business 

Analyst. 

216. Other paths include UX/UI Designer, Digital Marketing Manager, and Project Manager. 

217. Innovation Consultant and Software Developer are also potential career paths. 

218. Neuro-Mat is a Pakistani e-health startup addressing continuous patient monitoring. 

219. Neuro-Mat identified the problem that nurses cannot monitor every patient continuously, leading to 

risks like falls. 

220. Their solution is a multi-sensory mat that monitors movement and alerts staff if a patient attempts to 

leave the bed. 

221. Neuro-Mat began with simple, low-fidelity prototypes like buzzer and switch circuits. 

222. They iterated towards complex systems integrating pressure sensors and microcontrollers. 

223. Their market validation Smoke Test showed double the preference over alternatives like baby 

monitors. 

224. Key learning from feedback was that customers strongly preferred an outright purchase model over 

rental. 

225. Customers also valued cash-on-delivery payment options. 

Practice MCQs
1. What is the core definition of an 

entrepreneur? 
a) An employee who follows company 
procedures 
b) An individual who organizes, manages, 
and assumes the financial risks of a new 
business venture 
c) A government official who regulates 
markets 
d) A consumer who buys innovative products 
Answer: b) An individual who organizes, 
manages, and assumes the financial risks 
of a new business venture 

2. The term "entrepreneur" originates from 
which language? 
a) Latin 
b) Greek 
c) French 

d) German 
Answer: c) French 

3. Which of the following is NOT a primary 
impact of entrepreneurship on an 
economy? 
a) Job Creation 
b) Economic Stagnation 
c) Innovation and Progress 
d) Increased Competition 
Answer: b) Economic Stagnation 

4. A successful entrepreneur who takes 
financial risks with an understanding of 
potential failure, but not recklessly, is best 
described as a: 
a) Gambler 
b) Calculated risk-taker 
c) Avoider of all risk 
d) Follower of trends 
Answer: b) Calculated risk-taker 
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Miscellaneous Information: Quick Revision Notes 
1. Most Common Keyboard Shortcuts 
Windows 

• Ctrl + C → Copy selected item → Used to copy text/files. 
• Ctrl + X → Cut selected item → Removes and copies text/files. 
• Ctrl + V → Paste copied/cut item → Inserts clipboard content. 
• Ctrl + Z → Undo last action → Reverses previous operation. 
• Ctrl + Y / Ctrl + Shift + Z → Redo action → Reapplies undone action. 
• Ctrl + A → Select all items → Highlights all content in a window. 
• Ctrl + S → Save current document → Saves file in active application. 
• Ctrl + F → Open find/search box → Searches for text on a page. 
• Ctrl + P → Print current page/document → Opens print dialog. 
• Ctrl + N → Open new window/document → Creates new instance. 
• Ctrl + W → Close current window/tab → Shuts active tab/window. 
• Ctrl + T → Open new browser tab → Creates tab in browsers. 
• Ctrl + Shift + T → Reopen closed tab → Restores recently closed tab. 
• Alt + Tab → Switch between open apps → Toggles running applications. 
• Alt + F4 → Close active application → Quits current program. 
• Windows Key + D → Show/hide desktop → Minimizes all windows. 
• Windows Key + E → Open File Explorer → Launches file manager. 
• Windows Key + L → Lock computer → Locks screen quickly. 
• Windows Key + R → Open Run dialog → Executes commands. 
• Windows Key + V → Open clipboard history → Shows copied items. 
• Windows Key + . (period) → Open emoji panel → Inserts emojis. 
• Windows Key + Shift + S → Open Snipping Tool → Takes screenshot. 
• Ctrl + Shift + Esc → Open Task Manager → Directly opens task manager. 
• F2 → Rename selected item → Renames file/folder. 
• F5 → Refresh active window → Reloads page/file explorer. 
• Alt + Enter → Open properties → Displays selected item's properties. 

macOS 
• Cmd + C → Copy selected item → Equivalent to Ctrl+C. 
• Cmd + X → Cut selected item → Cuts selected content. 
• Cmd + V → Paste copied/cut item → Pastes clipboard content. 
• Cmd + Z → Undo last action → Reverses last change. 
• Cmd + Shift + Z → Redo action → Reapplies undone change. 
• Cmd + A → Select all items → Selects all content. 
• Cmd + S → Save current document → Saves active file. 
• Cmd + F → Find items in document → Opens find bar. 
• Cmd + P → Print document → Opens print dialog. 
• Cmd + N → Open new window/document → New window. 
• Cmd + W → Close current window → Closes active window. 
• Cmd + Q → Quit application → Exits program completely. 
• Cmd + T → Open new browser tab → New tab in browser. 

Chapter 26 
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• Cmd + Shift + T → Reopen closed tab → Restores closed tab. 
• Cmd + Tab → Switch between applications → App switcher. 
• Cmd + Space → Open Spotlight search → System-wide search. 
• Cmd + Shift + 4 → Take screenshot (area) → Screenshot selection. 
• Cmd + Shift + 3 → Take screenshot (full screen) → Captures entire screen. 
• Cmd + , (comma) → Open preferences → Opens app preferences. 
• Cmd + Option + Esc → Force quit applications → Opens force quit window. 
• Cmd + H → Hide current window → Hides active app window. 
• Cmd + Option + H → Hide other windows → Hides all but active window. 
• Ctrl + Cmd + Q → Lock screen → Immediately locks Mac. 

Linux (General/GNOME) 
• Ctrl + C → Copy / Send SIGINT → Copies text or interrupts process. 
• Ctrl + X → Cut selected text → Cuts selected content. 
• Ctrl + V → Paste copied text → Pastes clipboard content. 
• Ctrl + Z → Undo / Suspend process → Undoes or sends SIGTSTP. 
• Ctrl + Shift + Z → Redo action → Redoes undone action. 
• Ctrl + A → Select all → Selects all text/items. 
• Ctrl + S → Save document → Saves current file. 
• Ctrl + Q → Quit application → Exits program. 
• Ctrl + F → Find → Opens search box. 
• Ctrl + Alt + T → Open terminal → Launches terminal emulator. 
• Alt + Tab → Switch between windows → Window switcher. 
• Alt + F2 → Run command dialog → Opens run command box. 
• Super Key (Windows Key) → Open activities overview → Shows activities. 
• Ctrl + Alt + L → Lock screen → Locks the session. 
• Ctrl + Alt + Delete → Open logout dialog → Shows logout options. 
• Ctrl + Alt + Arrow Keys → Switch workspaces → Moves between workspaces. 
• Ctrl + Shift + N → New folder in file manager → Creates folder. 
• Ctrl + H → Show hidden files → Toggles hidden files visibility. 
• Ctrl + Alt + F1/F7 → Switch to terminal/GUI → Toggles TTY and GUI. 

2. Popular E-Commerce Platforms 
• Amazon 
o Founder: Jeff Bezos 
o Country of Origin: USA 
o Headquarters: Seattle, Washington, USA 
o Current CEO: Andy Jassy 
o Major Services: Online retail, AWS cloud, Prime Video, Kindle, Alexa. 
o Launch Year: 1994 
o Key Fact: World's largest online retailer and cloud service provider (AWS). 
• eBay 
o Founder: Pierre Omidyar 
o Country of Origin: USA 
o Headquarters: San Jose, California, USA 
o Current CEO: Jamie Iannone 
o Major Services: Consumer-to-consumer & business-to-consumer sales, auctions. 
o Launch Year: 1995 
o Key Fact: Pioneer of online auctions and consumer-to-consumer (C2C) e-commerce. 
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• Primary Key: Unique identifier for a record in a database table. 
• Foreign Key: Field in a table that links to the primary key of another table. 
• Normalization: Process of organizing data to reduce redundancy and improve integrity. 
• Indexing: Database optimization technique to speed up data retrieval. 
• Networking: Practice of connecting computers to share resources and information. 
• IP Address: Numerical label assigned to each device on a network using IP. 
• MAC Address: Unique hardware identifier assigned to a network interface controller. 
• Protocol: Set of rules governing data communication between devices. 
• Router: Networking device that forwards data packets between computer networks. 
• Switch: Device that connects devices on a LAN and uses MAC addresses to forward data. 
• Firewall: Security system that monitors and controls network traffic based on rules. 
• Cloud Computing: Delivery of computing services over the internet ("the cloud"). 
• IaaS: Infrastructure as a Service – provides virtualized computing resources. 
• PaaS: Platform as a Service – provides platform for developing and deploying apps. 
• SaaS: Software as a Service – delivers software applications over the internet. 
• Virtualization: Creating a virtual version of something (server, OS, storage, network). 
• Hypervisor: Software that creates and runs virtual machines. 
• Artificial Intelligence (AI): Simulation of human intelligence in machines. 
• Machine Learning (ML): Subset of AI where machines learn from data without explicit 

programming. 
• Deep Learning (DL): Subset of ML using neural networks with many layers. 
• Neural Network: Computing system inspired by biological neural networks. 
• Supervised Learning: ML training using labeled data. 
• Unsupervised Learning: ML training using unlabeled data to find patterns. 
• Reinforcement Learning: ML where an agent learns by receiving rewards/punishments. 
• Algorithm: Step-by-step procedure for solving a problem or performing a computation. 
• Data Structure: Particular way of organizing data for efficient access and modification. 
• Array: Collection of items stored at contiguous memory locations. 
• Linked List: Linear data structure where elements are linked using pointers. 
• Stack: LIFO (Last In, First Out) linear data structure. 
• Queue: FIFO (First In, First Out) linear data structure. 
• Tree: Hierarchical data structure with a root value and subtrees of children. 
• Graph: Non-linear data structure of nodes (vertices) connected by edges. 
• Hash Table: Data structure that maps keys to values using a hash function. 
• Time Complexity: Amount of time an algorithm takes relative to input size. 
• Space Complexity: Amount of memory an algorithm uses relative to input size. 
• Big O Notation: Mathematical notation describing algorithm complexity's upper bound. 
• Compiler: Program that translates source code from a high-level language to machine code. 
• Interpreter: Program that directly executes instructions written in a programming language. 
• Syntax: Set of rules defining the combinations of symbols in a programming language. 
• Semantics: Meaning of the syntactically valid statements in a programming language. 
• Object-Oriented Programming (OOP): Paradigm based on objects containing data and methods. 
• Class: Blueprint for creating objects in OOP. 
• Object: Instance of a class. 
• Inheritance: Mechanism where a class derives properties from another class. 
• Polymorphism: Ability of an object to take on many forms, often through method 

overriding/overloading. 
• Encapsulation: Bundling of data with methods operating on that data, hiding internal state. 
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Past Papers Questions
1. How many rows in MS Excel Sheet? 
A) 86340 
B) 1048576 
C) 86400 
D) None of these 
Answer: B) 1048576 
2. Which Pane is not available in 
PowerPoint? 
A) WordArt 
B) Insert 
C) Animation 
D) None of these 
Answer: A) WordArt 
3. Deleted Items in file directly go to the: 
A) Recycle Bin 
B) Desktop 
C) Windows Folder 
D) None of these 
Answer: A) Recycle Bin 
4. Crop function is used to crop: 
A) Videos 
B) Images 
C) Files 
D) None of these 
Answer: B) Images 
5. Which key is used to move the cursor to 
end of the line? 
A) End 
B) Home 
C) Shift+ tab 
D) None of these 
Answer: A) End 
6. In MS-DOS, DOS stands for: 
A) Disk Operating System 
B) Device Operating System 
C) Driver Operating System 
D) None of these 
Answer: A) Disk Operating System 
7. HTML stands for hypertext markup 
language is used for creating: 
A) Web pages 
B) Web server 
C) Client server 
D) None of these 
Answer: A) Web pages 

8. Gmail, Hotmail and Yahoo are: 
A) Email Server 
B) Client Server 
C) Email Programmer 
D) None of these 
Answer: D) None of these 
9. Windows 9 and Windows 10 are known as: 
A) Operating system 
B) System software 
C) Application software 
D) None of these 
Answer: A) Operating system 
10. In PowerPoint the header and footer 
button can be found on the: 
A) Home tab 
B) Insert tab 
C) Draw tab 
D) None of these 
Answer: B) Insert tab 
11. Which of the following are word 
processing software? 
A) Browser 
B) PowerPoint 
C) MS Word 
D) None of these 
Answer: C) MS Word 
12. The first computers were programmed 
using: 
A) Assembly language 
B) Machine language 
C) Object code 
D) None of these 
Answer: B) Machine language 
13. The computer cannot boot if it cannot 
load the: 
A) Loader 
B) Operating system 
C) Assembler 
D) None of these 
Answer: B) Operating system 
14. BIOS stands for: 
A) Basic Input Output System 
B) Binary Input Output System 
C) Broad Input Output System 
D) None of these 
Answer: A) Basic Input Output System 



 

  MK PREPARATIONS  

 

P a g e  2 | 21 

 

  

P
a

st P
a

p
e

rs Q
u

e
stio

n
s 

  

M 
K 
 

P 
R 
E 
P 
A 
R 
A 
T 
I 
O 
N 
S 

MK PREPARATIONS: Let’s Make It Happen 
+92 333 2605045, +92 342 4470091 
 

15. LCD stands for: 
A) Light Clear Display 
B) Liquid Crystal Display 
C) Light Crystal Display 
D) None of these 
Answer: B) Liquid Crystal Display 
16. Which function in Excel returns the 
remainder of division? 
A) Divide 
B) MOD 
C) ACOT 
D) None of these 
Answer: B) MOD 
17. Which template provides design concept, 
fonts and color scheme? 
A) Design template 
B) Color template 
C) Animation template 
D) None of these 
Answer: A) Design template 
18. Which key is used to minimize an Excel 
Worksheet? 
A) CTRL+F5 
B) CTRL+F9 
C) CTRL+F11 
D) None of these 
Answer: B) CTRL+F9 
19. Videos, documents and files can be shown 
in: 
A) WhatsApp 
B) YouTube 
C) Skype 
D) None of these 
Answer: D) None of these 
20. The extension of a PowerPoint file is: 
A) XLS 
B) PPT 
C) TXT 
D) All of these 
Answer: B) PPT 
21. In MS Word, Header and Footer are 
inserted in: 
A) Front page 
B) Last page 
C) On every page 
D) None of these 
Answer: C) On every page 

22. Which button do you click to add up a 
series of numbers? 
A) Auto sum 
B) Formula button 
C) Total Button 
D) None of these 
Answer: A) Auto sum 
23. When you insert an Excel file into a Word 
document, the data are: 
A) Embedded 
B) Linked 
C) Hyperlink placed in word table 
D) None of these 
Answer: B) Linked 
24. A user interface that is easy to use is 
considered to be: 
A) User happy 
B) User friendly 
C) User simple 
D) None of these 
Answer: B) User friendly 
25. CAD stands for: 
A) Computer aided design 
B) Computer algorithm design 
C) Computer application design 
D) None of these 
Answer: A) Computer aided design 
26. When you open a new presentation, a 
slide with the default layout appears? 
A) Blank 
B) Home 
C) Title 
D) None of these 
Answer: C) Title 
27. The capacity of a floppy disk is: 
A) 1.22 MB 
B) 1.33 MB 
C) 1.44 MB 
D) None of these 
Answer: C) 1.44 MB 
28. Which key is used to insert text in a cell? 
A) Enter 
B) Space 
C) Tab 
D) None of these 
Answer: B) Space 
29. What is the smallest width of a column in 
Excel? 
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